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Product Certifications

UL, cUL, TÜV, NOM-NYCE, CE, C-Tick, meets or exceeds FCC Class B 
requirements
Laser: CDRH on internal laser product 

Laser Safety

This unit employs a laser. Do not remove the cover or attempt to service this 
device when connected due to the possibility of eye damage.

Laser-Sicherheit

In das Gerät ist ein Laser eingebaut. Nehmen Sie die Abdeckung nicht ab und 
versuchen Sie nicht, das Gerät zu reparieren, solange es angeschlossen ist. Es 
besteht die Gefahr einer Augenverletzung.

CAUTION

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous laser radiation exposure.

WARNUNG

Die Vornahme von Regelungen oder Einstellungen oder die Durchführung von 
Verfahren, die nicht in diesem Dokument angegeben sind, kann eine gefährliche 
Einwirkung von Laserstrahlung zur Folge haben.

Contains: Class 1 Laser Product
Innehåller: Klass 1 Laserapparat
Sisältää: Luokan 1 Laserlaite
Enhält: Klasse 1 Laser-Produkt

CAUTION: Invisible laser radiation when open. Avoid exposure to beam.

VARNING: Osynlig laserstrålning när denna del är öppnad. Betrakta ej strålen.

VARO! Avattaessa olet alttiina näkymättömälle lasersäteilylle. Alä katso säteeseen.

VORSICHT: Unsichtbare Laserstrahlung wenn Abdeckung geöffnet. Nicht dem 
Strahl aussetzen.

Laser

Type: Semiconductor laser GaAlAs

Wave length: 775~795 nm (at 25°C)

Output power: 2.5 mW (read), 35 mW (write)

Beam divergence: 60 degrees
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FCC Declaration of Conformity

According to 47CFR, Parts 2 and 15, Class B Computer Peripherals: 
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference 
(2) this device must accept any interference received including interference that 
may cause undesired operations. This applies to all product options.

Hewlett-Packard Company
Colorado Memory Systems Division
800 S. Taft Ave., Loveland, Colorado 80537, USA 
Telephone 970-635-1500

February 1, 1998
Richard M. Spangler, Quality Manager

DECLARATION OF CONFORMITY
according to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name:

Manufacturer’s Address:

declares that the product:
   Product Name:
   Product Number:
   Product Options:

Hewlett-Packard Company
Colorado Memory Systems Division

800 S. Taft Ave.
Loveland, Colorado 80537

HP SureStore CD-Writer Plus 7200e
C4381A
All

conforms to the following Product Specifications:

Safety:

EMC:

Supplementary Information

EN60950: A3:1995
EN60825-1: 1994

CISPR 22: 1993/EN 55022:1994 Class B
EN 50082-1:1992
   IEC 801-2:1991 - 4kV CD, 8kV AD
   IEC 801-3:1984 - 3V/m
   IEC 801-4:1988 
       1kV Power Lines
        0.5kV Signal Lines
ENV 50140:1993 - 3V/m
EN 61000-3-2: 1995 Class D
FCC Part 15 Class B
AS/NZS 3548: 1995

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and 
the EMC Directive 89/336/EEC and carries the “CE” mark accordingly.

February 01, 1998 Richard Spangler, Quality Manager

European contact: Your local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, 
Department HQ-TRE, Herrenberger Straβe 130, D-71034 Böblingen (FAX: +49-7031-143143).
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Federal Communications Commission R.F. Interference 
Statement

WARNING: This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications to this equipment not expressly approved by 
Hewlett-Packard could result in violation of Part 15 of the FCC rules.

To maintain compliance with FCC rules and regulations, use properly shielded 
cables with this device.

Notice for Canada 

This digital apparatus does not exceed the Class B limits for radio noise emissions 
from digital apparatus as set out in the radio interference regulations of the 
Canadian Department of Communications.

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les 
limites applicables aux appareils numériques de Classe B prescrites dans le 
règlement sur le brouillage radioélectrique édicté par le Ministère des 
Communications du Canada.

Notice

Europe: This drive shall be installed only with an EN60950 (IEC950) approved 
Power supply.

USA/Canada: This drive is for use only with IBM compatible UL listed personal 
computers, weighing less than 18 kg.
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User’s manual statement for VCCI class B product

Translation for VCCI class B product

This equipment is in the Class B category information technology equipment 
based on the rules of Voluntary Control Council For Interference by Information 
Technology Equipment (VCCI). Although aimed for residential area operation, 
radio interference may be caused when used near a radio or TV receiver.

Read the instructions for correct operation.

Korean RRL Statement

Copyright notice for Denmark:

VIGTIGT! 

Copyright ved brug af CD-Writer 7100i/e enheder solgt i 
Danmark

I henhold til gældende dansk lov om ophavsret er det forbudt at foretage digital 
kopiering af et digitalt værk. CD-RW brænderen må derfor IKKE anvendes til at 
kopiere en musik-CD. CD-RW brænderen må desuden kun benyttes til at kopiere 
et digitalt EDB-program, når en sådan kopiering tjener til at fremstille et 
sikkerhedseksemplar af programmet eller hvor kopiering er nødvendig, for at 
programmet kan anvendes efter dets formål. Hvis De selv har ophavsretten til 
værket, har De også retten til at foretage digital kopiering med CD-RW brænderen.
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Hewlett-Packard Limited Warranty Statement

HP SureStore CD-Writer Plus Drive
DURATION OF LIMITED WARRANTY           Hardware - 1 year      Software - 90 days

1.   HP warrants to you, the end-user customer, that HP hardware, accessories and 
supplies will be free from defects in  materials and workmanship after the date of 
purchase, for the period specified above.  If HP receives notice of such defects 
during the warranty period, HP will, at its option, either repair or replace products 
which prove to be defective. Replacement products may be either new or like-new.

2.   HP warrants to you that HP software will not fail to execute its programming 
instructions after the date of  purchase, for the period specified above, due to 
defects in material and  workmanship when properly installed and used. If HP 
receives notice of such defects during the warranty period, HP will replace 
software media which does not execute its programming instructions due to such 
defects.

3.   HP does not warrant that the operation of HP products will be uninterrupted 
or error free.  If HP is unable, within a reasonable time, to repair or replace any 
product to a condition as warranted, you will be entitled to a refund of the 
purchase price upon prompt return of the product.

4.   HP products may contain remanufactured parts equivalent to new in 
performance or may have been subject to incidental use.

5.   Warranty does not apply to defects resulting from (a) improper or inadequate 
maintenance or calibration,  (b) software, interfacing, parts or supplies not 
supplied by HP, (c) unauthorized modification or misuse, (d) operation outside of 
the published environmental specifications for  the product, or (e) improper site 
preparation or maintenance.

6.   HP MAKES NO OTHER EXPRESS WARRANTY OR CONDITION WHETHER 
WRITTEN OR ORAL. TO THE EXTENT ALLOWED BY LOCAL LAW, ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY, SATISFACTORY QUALITY, 
OR FITNESS FOR A  PARTICULAR PURPOSE IS LIMITED TO THE DURATION OF 
THE EXPRESS WARRANTY SET FORTH ABOVE. Some countries, states or provinces 
do not allow limitations on the duration of an implied warranty, so the above 
limitation or exclusion might not apply to you. This warranty gives you specific 
legal rights and you might also have other rights that vary from country to 
country, state to state, or province to province.

7.   TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS 
WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE REMEDIES.  EXCEPT 
AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE 
FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL 
(INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED 
IN CONTRACT, TORT, OR OTHERWISE.  Some countries, States or provinces do 
not allow the exclusion or limitation of incidental or consequential damages, so 
the above limitation or exclusion may not apply to you.

FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND: THE 
WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT 
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN 
ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE 
SALE OF THIS PRODUCT TO YOU.
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HP Software License Agreement

ATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP SOFTWARE 
LICENSE TERMS SET FORTH BELOW. USING THE SOFTWARE INDICATES YOUR 
ACCEPTANCE OF THESE LICENSE TERMS. IF YOU DO NOT ACCEPT THESE 
LICENSE TERMS, YOU MAY RETURN THE SOFTWARE FOR A FULL REFUND. IF 
THE SOFTWARE IS BUNDLED WITH ANOTHER PRODUCT, YOU MAY RETURN 
THE ENTIRE UNUSED PRODUCT FOR A FULL REFUND. 

HP SOFTWARE LICENSE TERMS

License Grant. HP grants you a license to Use three (3) copies of the Software but 
only for Use in conjunction with the HP hardware product that accompanied the 
Software. “Use” means storing, loading, installing, executing or displaying the 
Software. You may not modify the Software or disable any licensing or control 
features of the Software.

Ownership. The Software is owned and copyrighted by HP or its third party 
suppliers. Your license confers no title or ownership in the Software and is not a 
sale of any rights in the Software. HP's third party suppliers may protect their 
rights in the event of any violation of these License Terms.

Copies and Adaptations. You may only make copies or adaptations of the 
Software for archival purposes or when copying or adaptation is an essential step 
in the authorized Use of the Software. You must reproduce all copyright notices in 
the original Software on all copies or adaptations. You may not copy the Software 
onto any bulletin board or similar system.

No Disassembly or Decryption. You may not disassemble or decompile the 
Software unless HP's prior written consent is obtained. In some jurisdictions, HP's 
consent may not be required for limited disassembly or decompilation. Upon 
request, you will provide HP with reasonably detailed information regarding any 
disassembly or decompilation. You may not decrypt the Software unless 
decryption is a necessary part of the operation of the Software.

Transfer. Your license will automatically terminate upon any transfer of the 
Software. Upon transfer, you must deliver the Software, including any copies and 
related documentation, to the transferee. The transferee must accept these License 
Terms as a condition to the transfer. 

Termination. HP may terminate your license upon notice for failure to comply 
with any of these License Terms. Upon termination, you must immediately 
destroy the Software, together with all copies, adaptations and merged portions in 
any form.

Export Requirements. You may not export or re-export the Software or any copy 
or adaptation in violation of any applicable laws or regulations.

U.S. Government Restricted Rights. The Software and any accompanying 
documentation have been developed entirely at private expense. They are 
delivered and licensed as “commercial computer software” as defined in DFARS 
252.227-7013 (Oct 1988), DFARS 252.211-7015 (May 1991) or DFARS 252.227-
7014 (Jun 1995), as a “commercial item” as defined in FAR 2.101(a), or as 
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Chapter 1:
Connecting CD-Writer 
Plus and Installing the 
Software

What’s in Your Package
Make sure you have the items shown below. (Keep the packaging in case 
you need to transport the CD-Writer Plus drive.)

User’s 

Blank 

Data cable

Power

Power

Audio
cable

Driver
installation diskette

HP SureStore CD-Writer Plus

Guide

cord

 supply

ReWritable
CD  

 

Software installation CDs

drive



1-2 Connecting CD-Writer

Connecting CD-Writer
CAUTION: The CD-Writer Plus drive contains sensitive, high-precision optical 
equipment. Dropping or shaking the CD-Writer Plus drive may cause damage 
to these sensitive components. Please be careful when handling your drive.

NOTE: Refer to the manual that came with your computer if you need more 
information than what is provided here.

WARNING: DO NOT, under any circumstances, open the external CD-Writer 
Plus drive’s case. If you suspect problems with your drive, service must be 
performed by a certified HP technician. See ”Appendix B:  Customer Support”.

1. Shutdown Windows and turn OFF your computer.

NOTE: The CD-Writer Plus drive can be used with laptops, desktops, and 
towers that meet “Minimum System Requirements” on page A-1.

2. Connect one end of the power cord into the power supply and the other 
end to a wall outlet or power strip. (The power plug and outlet may look 
different in your country.)

Power supply

To CD-Writer Plus drive

Power cord

Green light
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3. Connect the power supply to the power connector on the back of the 
CD-Writer Plus drive, with the arrow on the cable facing up.

Check that you have power to the CD-Writer Plus drive by opening and 
closing the CD tray by pressing the eject button. 

NOTE:  There is no power switch on the CD-Writer Plus drive or power supply. 
The energy-efficient power supply automatically switches into power-saving 
mode when the drive is not in use, and may be safely left plugged in at all 
times. However, you may safely unplug the power supply without causing 
damage to the CD-Writer Plus drive.

(arrow up)

Power connector

To power supply



1-4 Connecting CD-Writer

4. Locate the parallel port (printer port) connector on your computer. 

If you are having trouble finding the parallel port connector, your printer 
may already be attached to it. The CD-Writer Plus drive can share the 
parallel port with your printer.

If the CD-Writer Plus drive and your printer will share the parallel port, 
go to the next step. 

If the CD-Writer Plus drive will not share the parallel port with your 
printer, proceed to step 6.

Select an available parallel port. 

TIP: Your CD-Writer Plus drive can share 
a parallel port with a printer.

Parallel ports 
have receptacles 
for 25 pins.
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5. If you have a printer cable attached to the computer’s parallel port, 
disconnect it from the computer and plug it into the CD-Writer Plus 
drive’s connector that is closest to the power cord connector.

CAUTION: Do not plug any device other than a printer into the CD-Writer Plus 
drive’s printer connector.

NOTE: If your printer is attached to the CD-Writer Plus drive, printing 
documents while using the rewritable CD drive (for example, playing audio 
CDs, writing to disc) will yield unpredictable results and is not a supported 
function. This is because the printer and CD-Writer Plus drive are sharing the 
same data cable.

Secure the connector 
by tightening the 
retaining screws.

Printer’s data cable
(If a printer is sharing the 
parallel port with the CD-
Writer drive.)

Power cord connector

Printer connector
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6. Attach the CD-Writer Plus drive’s  data cable to your computer’s 25-pin 
parallel port connector and hand tighten the retaining screws.

Attach the data cable’s remaining connector to the rewritable drive and 
secure it by tightening the retaining screws.      

CD-Writer Plus drive’s data cable

Attach this end to the CD-
Writer Plus drive.

Attach this end to the 
computer’s parallel port.
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7. Connecting the audio cable is OPTIONAL. If you do not wish to use it, go 
to step 10.

The audio cable is used only for hearing music CDs through your 
computer’s sound system. If you do not have a sound board in your 
computer, you can still hear music CDs through speakers or earphones 
attached to the front of the CD-Writer Plus drive.

NOTE: When the CD-Writer Plus drive records music or data, it uses the data 
cable, not the audio cable.

8. If you have a sound board, connect the audio cable to a LINE IN audio 
connector on the back of your computer. (Your sound board may be 
labeled differently.)

9. Connect the other end of the audio cable to the audio connector on the 
back of the CD-Writer Plus drive.

10. Plug in and turn ON your computer.

11. You are now ready to install the parallel port drivers and the application 
software. (See “Installing the Software for Windows 95 or Windows NT 
4.0” on page 1-8.)

Audio cable

Audio connector

(optional)

LINE IN connector on
sound board (Your sound
board may be labeled
differently.)
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If You Have Problems
After connecting your CD-Writer Plus drive and turning on your 
computer, the computer should start (boot) as it normally does. If it does 
not, check the following items: 

■ Is the computer power plugged in? 

■ Is each device plugged in and turned on? 

■ Are all cables properly plugged into the back of your computer and 
the CD-Writer Plus drive? 

■ Try turning off your computer. Wait at least 20 seconds before turning 
it back on.

Installing the Software for Windows 95 or 
Windows NT 4.0

After the CD-Writer Plus drive is attached to your computer, you are 
ready to install the application software.

NOTE:  You must run the installation program. The installation program 
converts the files from the CD into a usable format.

If your computer DOES NOT have a CD-ROM drive:

1. To get your CD-Writer Plus started right away, insert the diskette labeled 
Driver Installation into your floppy drive.

2. Click the Start button on the task bar, select Run.

3. Type A:\SETUP (where A: is your floppy drive’s letter), and press ENTER. 
The parallel port driver files are installed. This may take several minutes 
and your mouse cursor will not move.

4. Windows NT only:  Reboot your computer before continuing.

5. Insert the CD labeled “Software Disc 1” into your new CD-Writer Plus 
drive and proceed with step 2 in the next procedure.

NOTE:  For information about inserting a CD into the CD-Writer Plus drive, 
see “Inserting a CD” on page 2-1.
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If your computer DOES have a CD-ROM drive:

1. Insert the CD labeled “Software Disc 1” into your CD-ROM drive (not the 
CD-Writer Plus drive), if you have not already done so. The main menu 
appears:

If the main menu does not appear automatically, click on the Start 
button on the task bar, select Run, type D:\SETUP (where D: is your CD 
drive’s letter), then click on OK. 

2. Click on the Install CD-Writer Plus icon. Follow the instructions on the 
screen.

If You Have Problems

Things to Try First

■ Make sure the computer and each device is plugged in and turned on.

■ Does your computer meet the minimum system requirements listed 
in “Minimum System Requirements” on page A-1?

Click the 
Install CD-
Writer Plus 
icon
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■ Turn off the computer’s power, wait 20 seconds, then turn it on again. 
Unplug the CD-Writer Plus drive and plug it in again. (This is called 
cycling power.)

■ Disconnect all the cables, look for and straighten any pins, and then 
reconnect the cables. Sometimes just reconnecting a cable aligns it 
correctly or adjusts the pin connections, fixing a faulty connection.

■ Check the list of known compatibility problems (on page 3-7) and in 
the Readme file.

■ Make sure that there is no switch box anywhere in the CD-Writer Plus 
drive’s cabling configuration.

■ If you have a printer connected to the CD-Writer Plus drive, check to 
see if your computer can detect the CD-Writer Plus drive when the 
printer is disconnected.

■ Check to make sure that your parallel port is truly configured as either 
EPP or ECP. Check the manual that came with your computer to find 
out how.

Check for a conflict with the parallel port (some other device 
using the same IRQ or I/O as the parallel port).

In Windows 95, to find out if there is a conflict:
- Right-click on the My Computer icon
- Select Properties 
- Select the Device Manager tab:
  Under the heading SCSI Controllers, find Shuttle EPAT
  External ATAPI Adapter, and select Properties
    AND
  Under the heading Ports,  find Printer Port, and select
  Properties

  If you see a yellow exclamation mark to the left of this line,
  you do have a conflict. Determine which other device is
  using the same settings as your parallel port and change
  the settings on the other device.

If you discover you do have a conflict, to find out which device is in 
conflict:

■ In Windows 95, right-click on the My Computer icon, select 
Properties, select the Device Manager tab, double-click on the 
computer icon to see a list of which device is using each resource 
setting on your computer.
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■ In Windows NT (while signed on as Administrator), from the Start 
menu on the task bar, select Programs/Administrative Tools 
(Common)/Windows NT diagnostics.  Select the Resources tab to 
view the list of which resources are being used by which device. 

Error message when I double-click on the CD-Writer Plus 
drive’s icon

■ There is no CD in the CD-Writer Plus drive; insert a CD and try again.

■ After inserting a CD, you need to wait a moment to let the CD-Writer 
Plus drive read the disc information (wait until the light on the front 
of the drive stops flashing and stays green), then click on the CD-
Writer Plus drive’s icon again.

■ The CD may be in the tray upside-down or a little off-center; try 
reinserting the CD. The label should be facing up.

■ You are trying to read from a blank recordable CD. Try again after 
copying some information to the CD.

In Windows Explorer, unable to see the CD label or all the 
sessions/files on the CD 

Refresh the screen. Select the My Computer icon in Windows Explorer 
and press F5.

Printer no longer works after connecting the CD-Writer Plus 
drive 

Problems printing a file

■ See “Check for a conflict with the parallel port (some other device using the 
same IRQ or I/O as the parallel port).” on page 1-10. For example, a 
sound board or fax/modem board may be using the same IRQ. If you 
discover conflicts, change the IRQ setting on the other device. Refer 
to the manuals that came with your computer and other devices for 
instructions.

■ If your printer is attached to the CD-Writer Plus drive, printing 
documents while using the rewritable CD drive (for example, playing 
audio CDs, writing to disc) will yield unpredictable results and is not 
a supported function. This is because the printer and CD-Writer Plus 
drive are sharing the same data cable.
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System does not recognize the CD-Writer Plus drive

■ In Windows 95, simply click on the Connect or Disconnect external 
drive icon on your desktop. 

Select Shuttle EPAT External ATAPI Adapter, then click Disconnect.

Restart your computer, or shut it down and then turn it on again. 
Watch for the green light on the front of the CD-Writer Plus drive to 
blink as the computer boots up

Select Shuttle EPAT External ATAPI Adapter, then click Connect.

■ Make sure the CD-Writer Plus drive’s cables are connected properly.

■ See “Check for a conflict with the parallel port (some other device using the 
same IRQ or I/O as the parallel port).” on page 1-10. For example, a 
sound board or fax/modem board may be using the same IRQ. If you 
discover a conflict(s), change the setting on the other device. Refer to 
the manuals that came with your computer and other devices for 
instructions.

■ The power supply should have a steady green light when connected 
at both ends. If it is flashing, try a different power outlet. If it is still 
flashing the power supply could be damaged.

Uninstalling the Software Programs
You can remove all of CD-Writer Plus’s programs or individual programs.

CAUTION:  If you want to reinstall the CD-Writer Plus drive’s software, first be 
sure to uninstall the original software. 

1. Click the Start button.

■ Point to Programs.

■ Point to HP CD-Writer Plus.

■ Point to Tools & Information.

■ Point to Utilities.

■ Click Uninstall.
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2. Select the CD-Writer Plus drive’s program(s) that you wish to remove.

3. Click the Finish button.

The software is removed, including all related entries in your system 
registry.

Moving CD-Writer Plus to Another 
Computer

CAUTION:  The CD-Writer Plus contains sensitive, high-precision optical 
equipment. Dropping or shaking the CD-Writer Plus may cause damage to 
these sensitive components. Please be careful when handling your drive.

You can disconnect the CD-Writer Plus drive and move it to another 
computer, as long as the other computer meets the “Minimum System 
Requirements” on page A-1.

The CD-Writer Plus drive can be used by only one computer at a time. Do 
not try to use the CD-Writer Plus drive on more than one machine by 
attaching it to a switch box.

To disconnect the CD-Writer Plus drive:

1. In Windows NT, go to step 2.

In Windows 95, click on the Connect or Disconnect external drive icon 
on the desktop.  

Select Shuttle EPAT External ATAPI Adapter, then click Disconnect.
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2. Unplug the CD-Writer Plus’s power supply from the outlet or power strip. 
(The power plug and outlet may look different in your country.)

NOTE:  There is no power switch on the CD-Writer Plus drive or power supply. 
You may safely unplug the power supply without damage to the CD-Writer Plus 
drive.

3. Disconnect the CD-Writer Plus data cable and audio cable (if any) from 
the back of the computer.

Power supply

Data cable
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4. Disconnect the printer cable (if any) 
from your CD-Writer Plus drive and 
reconnect it to the printer port on the 
back of your computer (other cables 
not shown but still attached).

5. You are ready to connect the CD-
Writer Plus drive to another computer. 

To connect the CD-Writer Plus drive to another computer:

1. Follow the directions for “Connecting CD-Writer” on page 1-2.

2. The first time you attach the CD-Writer Plus drive to this computer, 
follow the directions in “Installing the Software for Windows 95 or 
Windows NT 4.0” on page 1-8.

Each additional time, after connecting all the cables:

■ In Windows NT, reboot your computer.

■ In Windows 95, simply click on the Connect or Disconnect external 
drive icon on your desktop.  

Select Shuttle EPAT External ATAPI Adapter, then click Connect.
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Chapter 2:
Using Your CD-Writer 
Plus

This chapter describes how to use and purchase CDs, how to take care of 
your drive, and how to find out its drive letter.

Using CDs

Inserting a CD

1. Press the eject button on the CD-Writer front panel.

2. Set the CD in the tray with the labeled side up.

3. Press the eject button again or push gently on the front of the tray to 
shut the tray.

Eject button
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When you access the CD-Writer Plus drive from within a program, you 
should be able to read the files on the inserted CD. If you have problems: 

■ The CD may be in the tray upside-down or a little off-center; try 
reinserting the CD. The label should be facing up. 

■ After inserting a CD, you need to wait a moment to let the CD-Writer 
Plus drive read the disc information (wait until the light on the front 
of the drive stops flashing and stays green), then click on the CD-
Writer Plus drive’s icon again.

■ Are you trying to read from a blank recordable CD? Try again after 
copying some information to the CD.

Removing a CD

1. Press the eject button on the HP CD-Writer drive front panel.

2. Remove the CD from the tray.

3. Press the eject button again or push gently on the front of the tray to 
shut the front panel.

Choosing CDs for Your CD-Writer

For best results, use Hewlett-Packard CD-RW (ReWritable) or CD-R 
(Recordable or write-once) media, available from your local vendor.

Ideas for using CD-RW (ReWritable) discs which can only be used in CD-
ReWritable drives or newer MultiRead CD-ROMs:

■ Use as if it were a large-capacity floppy disk

■ Copy your important files each week

■ Free up disk space on your hard drive

■ Transport files to and from work/home

■ Hold large complex files as you develop them

■ Share presentations in editable form

■ Create personalized presentations
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Ideas for using CD-R (Recordable or write-once) discs which can be read 
in most CD-ROM or CD-Recordable drive:

■ Permanently save large project files

■ Share non-editable presentations

■ Permanently store home records

■ Share memories with family and friends

■ Copy your music onto CD for personal use

■ Make copies of music you created for record company demos

■ Permanently archive files

Purchase HP CD-RW (ReWritable) media

Available from your local vendor, these CDs can only be used with CD-
ReWritable drives or read from newer MultiRead CD-ROMs:

■ 12 cm (650 MB, 74-minute) 1 pack (C4431A)

■ 12 cm (650 MB, 74-minute) 3 pack (C4431C)

■ 12 cm (650 MB, 74-minute) 25 pack (C4431D)

NOTE: Do not mix audio and data files on the same CD since they require 
different formats.

Purchase HP CD-R (Recordable or write-once) media

Available from your local vendor, these CDs can be read by most CD-
ROM, CD-Recordable, and CD-ReWritable drives (use this type of media 
if you want to listen to your music CDs in a stereo):

■ 12 cm (650 MB, 74-minute) 1 pack (C4432A)

■ 12 cm (650 MB, 74-minute) 3 pack (C4432C)

■ 12 cm (650 MB, 74-minute) 25 pack (C4432D)

NOTE: Do not mix audio and data files on the same CD since they require 
different formats.
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Maintenance
The CD-Writer Plus drive requires no maintenance or cleaning. If you 
simply keep your CDs clean, you will prevent most problems. 

CAUTION: Do NOT use the CD-ROM cleaning discs that rely on a small brush 
to sweep dirt off the laser. Do NOT use high-pressure air to clean the inside of 
the drive. These cleaning techniques will damage the CD-Writer Plus drive.

Identifying CD-Writer Plus’s Drive Letter
Not sure which drive letter was assigned to the CD-Writer Plus 
drive?

The CD-Writer Plus drive will have a drive icon just like a CD-ROM drive 
icon. You can determine which icon is your CD-ROM drive and which 
icon is your CD-Writer Plus drive by double-clicking on the My 
Computer icon, right-clicking on the CD drive icon, and selecting Eject. 
The tray of the selected drive will open.
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Chapter 3:
Problem Solving

If you are having difficulties with a software application check that 
application’s chapter and on-line help for troubleshooting information. 
If you need further assistance, the table on page B-1 will help you find 
the phone numbers for the appropriate customer support service.

Read this section if you run into trouble with your CD-Writer Plus drive. 
If after reviewing the section you need further assistance, call the phone 
numbers listed in “Appendix B:  Customer Support”

Gather the information on page B-2 before calling for help. Having this 
information ready will greatly facilitate your call.

Things to Try First
■ Does your computer meet the minimum system requirements 

(see“Minimum System Requirements” on page A-1 )?

■ Make sure your computer and CD-Writer Plus drive are plugged in 
and that each device attached to your computer is turned on.

■ Turn off the computer’s power, unplug the CD-Writer Plus drive, and 
wait 20 seconds.  Then plug in the CD-Writer Plus drive and turn on 
your computer. (This is called cycling power.)

■ Disconnect all the cables and then reconnect them. Sometimes just 
reconnecting a cable aligns it correctly or adjusts the pin connections, 
fixing a faulty connection. (Check for bent pins on the connectors 
and straighten them.)

■ Make sure that you are using the right type of CD. See “Choosing CDs 
for Your CD-Writer” on page 2-2.

■ Try the operation with a different CD.
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■ Check the list of known compatibility problems (page 3-7) and in the 
Readme file.

■ If your computer has a power-management feature, disable it (see the 
manual that came with your computer).

■ If your system is running printer status monitor software, disable it 
(page 3-7).

■ Make sure that you are not attaching a parallel port switch box 
anywhere in the CD-Writer Plus drive’s cabling configuration.

Common Symptoms and Solutions
■ Not sure which drive letter was assigned to the CD-Writer Plus drive? 

(See “Identifying CD-Writer Plus’s Drive Letter” on page 2-4.)

■ Error message when I double-click on the CD-Writer Plus drive’s icon 
(see page 1-11)

■ In Windows Explorer, unable to see the CD label or all the sessions/
files on the CD (see page 1-11)

■ Printer no longer works after connecting the CD-Writer Plus drive (see 
page 1-11)

■ Problems printing a file (see page 1-11)

■ System does not recognize the CD-Writer Plus drive (see page 1-12)

■ Copying directly from one CD to another doesn’t work. (see page 3-3)

■ Audio sounds poor (see page 3-3)

■ Video is choppy (see page 3-4)

■ Buffer underrun error messages (see page 3-4)

■ Unable to read a second session reading from a CD-ROM drive (see 
page 3-5)

■ Applications cannot find your CD in the CD-Writer Plus drive (see 
page 3-5)

■ Lost power to your computer or had to press CTRL-ALT-DEL while 
writing to the CD! (see page 3-6)

■ Hard Drive Compression Software (see page 3-6)
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■ Achieving optimal performance (see page 3-6)

■ Printer Status Monitor Software (see page 3-7)

■ Known Compatibility Problems (see page 3-7)

■ Finding the CD-Writer Plus driver files. (see page 3-8)

Copying directly from one CD to another doesn’t work.

WARNING: Only reproduce material for which you own the copyright or have 
obtained permission to copy from the copyright owner.  Unless you own the 
copyright or have permission to copy from the copyright owner, you may be 
violating copyright law and be subject to payment of damages and other 
remedies.  If you are uncertain about your rights, contact your legal advisor.

■ Some CD-ROMs will not allow direct copying to the CD-Writer Plus 
drive or are not capable of digital audio extraction.

■ You must have either a SCSI 2 CD-ROM drive (see the drive’s guide for 
information) or a supported ATAPI CD-ROM drive as your source.

■ Some CDs have a copy prevention feature or other features that do 
not allow a CD-to-CD copy.

Audio sounds poor

■ If your printer is attached to the CD-Writer Plus drive, printing 
documents while playing audio CDs will yield unpredictable results 
and is not a supported CD-Writer Plus drive function. This is because 
the printer and CD-Writer Plus drive are sharing the same data cable.

■ Make sure the audio connectors are completely plugged in to the back 
of the CD-Writer Plus drive and the LINE IN connector of the sound 
card on the back of the computer. (Your sound board may be labeled 
differently.) 

■ Verify that you do not have a sound-muting feature turned on, by 
way of the monitor or software.

■ Check the sound coming from the CD-Writer Plus drive by plugging 
earphones or speakers to the audio connector on the front of the CD-
Writer Plus drive. If the sound quality is good, the problem is 
probably with the sound board, speakers, or audio cable. Refer to the 
documentation that came with your sound board and speakers for 
help.
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■ Try listening to the wave files on your hard drive to see if they 
sounded poor before copying them to CD.  (You can use the Media 
Player program found under Multimedia in Windows’ Accessories.)

Video is choppy

This can be caused by the same situations that cause buffer underruns. 
This can also happen if your video card is slow. Try the following:

■ Try the solutions for buffer underruns (page 3-4).

■ Upgrade your video card.

■ Reduce the size of the video window and close any other programs 
that are running.

Buffer underrun error messages

When using Easy-CD Audio or Disc Copier:

■ Make sure your system meets the minimum system requirements 
(page A-1).

■ Buffer underrun may be caused by hard drive compression software 
(page 3-6). 

■ NEVER write to the recordable CD while other applications are 
running that could interrupt the writing-to-CD process. Log off any 
networks, disable any fax modem, email, screen saver, or other 
programs (such as TSRs, terminate-and-stay-resident programs) that 
may automatically send messages to your computer while writing 
data to the CD. If the interruption is long enough, you could ruin a 
write-once CD to which you are writing.

■ Exit any other programs while writing data to the CD.

■ If your computer has a power-management feature, disable it (see the 
manual that came with your computer).

■ Run SCANDISK.EXE and DEFRAG.EXE periodically on your hard 
drive (see your Windows manual for more information). These 
programs improve access times to the hard drive, which will help 
improve system performance while writing to and reading from the 
CD-Writer Plus drive.

Buffer underruns could also be caused by an unsupported parallel port 
(standard mode SPP).  See “Minimum System Requirements” on page A-
1. Try the following:
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■ Change the parallel port settings to EPP or ECP in CMOS, if your 
computer can support the change. See the manual that came with 
your computer to find out how.

■ Install a new EPP or ECP parallel port card.

■ Write data to the CD at 1x speed if you are given the choice within 
the software.

■ Disable any printer status monitor software (page 3-7).

Unable to read a second session reading from a CD-ROM drive

■ Eject the CD and reinsert it.

■ Refresh the screen. Select the My Computer icon in Windows 
Explorer and press F5.

■ CD-RW (ReWritable) discs can only be used in CD-ReWritable drives 
or newer MultiRead CD-ROMs.

■ If you are trying to read your CD from Windows 3.x: Multi-session CDs 
created with Direct CD cannot be read in DOS or Windows 3.x. If 
your multi-session CD was created using some other program, verify 
that you are using version 2.23 of the MSCDEX.EXE file. First, restart 
your computer and when you see “Starting MS-DOS...” appear on 
your monitor, press F8. Each line in your CONFIG.SYS and 
AUTOEXEC.BAT file will load one at a time. Press “Y” until you see a 
line containing “MSCDEX.EXE”. Then press “Y” and the version 
number of your MSCDEX file will display. The number must be 2.23 
or greater. Call Microsoft for an updated file if you need it.

■ See if the CD-Writer Plus drive or other CD-ROM drives can read the 
CD. If so, the problem is probably with the CD-ROM drive. Contact 
the manufacturer of this drive for updated drivers. 

Applications cannot find your CD in the CD-Writer Plus drive

Some programs (CD-ROM games, etc.) look only for the first logical drive 
letter assigned to a CD-ROM drive or CD-Writer Plus drive. For example, 
if your CD-ROM drive is assigned drive D:\ and the CD-Writer Plus drive 
is assigned drive E:\, the program is looking for the CD only in drive D:\ 
and will not see the CD in drive E:\. If you want to use the CD-Writer 
Plus drive for these types of programs, reassign the drive letters, making 
the CD-Writer Plus drive come before the CD-ROM drive, as follows:

■ In Windows 95, display the Device Manager and  double-click on 
CDROM. Double-click on the CD-ROM drive, and then click on the 
Settings tab. Under Reserved drive letters, select the drive letter after 
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the existing letter (for both start and end drive letter) and click on 
OK. Then double-click on the CD-Writer Plus drive, and then click on 
the Settings tab. Under Reserved drive letters, select the drive letter 
before the current one and click on OK.

■ In Windows NT, click on Start/Programs/Administrative 
Tools(common). Choose Disk Administrator. Right-click on the 
drive letter you wish to change. Select Assign Drive Letter. Change 
the drive letter.

Lost power to your computer or had to press CTRL-ALT-DEL 
while writing to the CD!

If you lose power while writing to your CD (the CD-Writer Plus drive's 
red light is on) OR If you exit an application or press CTRL-ALT-DEL 
while writing to CD...

You may be able to salvage your CD, but ONLY if you: 

1. LEAVE YOUR CD IN THE DRIVE, DO NOT OPEN THE DISC TRAY
2. Turn your machine off
3. Turn it back on
4. Then re-enter the application you were using 

Once the application tries to access the CD-Writer Plus drive, the 
recovery operation will make it appear that the last session is there. 
However, in reality, only a part of the CD's directory may be there. Your 
recordable CD is still usable if you can read the directory. Repeat the 
entire copy operation to make sure that your files are copied to the 
recordable or ReWritable CD.

Hard Drive Compression Software

We do not recommend using hard drive compression software. If you use 
hard drive compression software, it estimates free hard drive space based 
upon a compression ratio (often user selectable). Programs may check 
your hard drive for space needed and may think you have the necessary 
free space. However, depending on the type of files you are copying, you 
may in fact not have enough hard drive space.

Achieving optimal performance

Run SCANDISK.EXE and DEFRAG.EXE on your hard drive before using 
your CD-Writer Plus drive for the first time (see your Windows manual 
for more information). Then run them periodically after that. These 
programs improve access times to the hard drive, which will help 
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improve system performance while writing to and reading from the CD-
Writer Plus drive.

Printer Status Monitor Software

NOTE: This is only an issue if your printer is connected to the back of the CD-
Writer Plus drive.

If your printer came with a program that notifies you about the status of 
the printer (such as when it is out of paper), this printer status monitor 
software might cause problems. The printer status monitor software checks 
the status of your printer every few seconds. If this happens while you are 
writing data to your recordable CD, it will cause data corruption. Turn off 
the printer status monitor software to prevent this problem. Check the 
information that came with your printer to find out how to do this.

Known Compatibility Problems 

■ Check the Readme file that came with the CD-Writer Plus drive for 
additional information.

■ Check the web site listed on page B-5 for the most recent information.

■ Maxtor Hard Drives
You might be unable to write reliably to the CD-Writer Plus drive if 
your computer has a Maxtor hard drive (the following models):

71626A/AP (1.6 Gbyte) 

712260A (1.2 Gbyte)

72004A/AP (2.0 Gbyte) 

CD recordable devices require an uninterrupted data stream from the 
hard drive in order to write successfully to a CD. These hard drive 
models are designed with a built-in interrupt loop that may cause CD 
corruption. Please contact Maxtor's customer support at 1-800-2-
MAXTOR or on the World Wide Web at http://www.maxtor.com/ for 
more information.

■ Acer computers, some models P75 to P120
DO NOT connect the CD-Writer Plus drive to the printer (parallel) 
port. On these models, connecting an external storage device, such as 
the CD-Writer Plus drive, to the parallel port will damage the port.  
Contact your computer manufacturer for more information.

■ IBM Aptiva computers
Most have the parallel port configured to I/O base address 3BC.  This 
must be changed, see “Minimum System Requirements” on page A-1.



4-1

C
h

ap
ter 4:  Sh

arin
g

 Yo
u

r C
D

s

Chapter 4:
Sharing Your CDs

How you write your data to CD and the type of CDs that you use will 
determine who else can read the data from your discs. This chapter 
briefly explains some of the options you have in creating CDs that can be 
shared with others using different computer and CD setups.

Varying Formats
CD technology has progressed rapidly over the last few years from CD-
ROM to writable CD, and on to the technology you now own in your 
rewritable CD-Writer Plus. One of the results of these developments is 
that data can be written in several formats and on different types of CDs. 

Sharing CDs across Different Formats

Using CD-RW Discs

When should I use CD-RW discs?

CD-RW media is the ideal solution for extended personal storage on your 
own machine. You can write, erase, and rewrite data easily from 
applications and from the Windows Explorer. Your CD-Writer Plus drive, 
coupled with CD-RW media, can function as an extension of the hard 
drive on your machine. Use CD-RW media:

■ To save work in progress like presentations, documents, etc.

■ Make weekly archives of files on your hard drive.

■ Shuttle files between the office and home if you have a CD-Writer 
Plus at each location, or have an external CD-Writer Plus to use on 
both computers.
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Can I share a CD-RW disc?

Yes. You can share a CD-RW disc directly with someone owning another 
CD-RW drive or with someone that has a MultiRead CD-ROM drive and 
UDF reader software. MultiRead CD-ROM drives are a recent innovation 
to CD-ROM technology, so while not all CD-ROMs are MultiRead, they 
are available to users world wide.

How do I know if a CD-ROM is MultiRead?

Look for the MultiRead certification logo on the CD-ROM’s packaging or 
users guide. The drive will be described as MultiRead certified or will list 
CD-RW as supported media. You can also put a CD-RW disc in your CD-
ROM and see if it can read it. 

What if I want to share with users that have standard CD-ROM 
drives?

In general, you must copy your information to a CD-R disc to share it 
with users that have standard CD-ROM drives. To accomplish this: 

1. Insert your CD-RW disc in your CD-Writer Plus drive. 

2. Copy all the information from the CD-RW disc to a unique location on 
your hard drive.

3. Replace the CD-RW disc in your CD-Writer Plus with a blank CD-R disc.

4. Copy the information from your hard drive to the CD-R media using 
Direct CD.

5. When you eject the disc, DirectCD prompts you to either leave the disc 
open, or close the disc so it can be read in a standard CD-ROM drive. 
Select the option to close the CD.

 NOTE: For additional information on sharing CDs with Windows 3.x and 
DOS users, see “What if I used DirectCD to create my CD-R disc?” on page 4-3.

Can I play an audio disc I made on a CD-RW disc in my car or 
home CD player?

Probably not. Most car and home CD players are not capable of reading 
information off of CD-RW media. You must record your audio on CD-R 
discs to play them on most conventional CD players. There are however 
some newly released auto and home CD players that can read the CD-RW 
media
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Using CD-R Discs

When should I use CD-R discs?

The data you put on a CD-R can’t be erased. Use CD-R discs:

■ When you want to protect your data so that it cannot be erased

■ If you want to share your CD with users that have standard CD-ROM 
drives

■ For audio CDs

Can I automatically share a CD-R with anyone?

Not necessarily. The software application you use will determine with 
whom you can easily share the CD.

What if I used DirectCD to create my CD-R disc?

When you eject the disc from the drive, DirectCD will prompt you to 
either leave the disc open so you can add more data later, or close the 
disc so it can be read in a standard CD-ROM drive. If you intend to share 
the disc with other users, then you must “close” the disc.

■ Windows 95 and Windows NT. If you are sharing a “closed” CD-R 
with another Windows 95 or Windows NT user, your disc is now 
ready to be shared.

There may be some CD-ROMs that can’t read the CD-R. If you have 
problems try turning off the “Read Ahead” on your CD-ROM. Refer to 
your operating system documentation on how to do this. Another 
option is to use CD Copier to create a disc copy of your original CD-R 
disc. A description of how to do this can be found in the section 
“How to Make a Copy of a CD” on page 8-3.

■ Windows 3.x and DOS. Some additional steps are required if you 
want to share your “closed” disc with Windows 3.x or DOS users. You 
will need to create a copy of your original CD-R disc on another piece 
of CD-R media using the CD Copier application. This will write a disc 
in the proper format for Windows 3.x and DOS users. Follow the 
instructions given in the section “How to Make a Copy of a CD” on 
page 8-3 to accomplish this task.

NOTE: CDs created with CD Copier will display long filenames when viewed in 
Windows 95 and NT. When viewed in Windows 3.x and DOS, file names are 
shortened to the DOS standard of eight characters with a three-character 
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extension. Files and executables that expect a specific file name may not 
function as anticipated in Windows 3.x and DOS.

What if I used Easy CD Audio to create my CD-R disc?

This application automatically writes the audio format understood by 
millions of car and home CD players in existence today. You will be able 
to share this disc with virtually any user. 

Are there any other ways to create CD-R discs?

Use a CD-mastering application, such as Adaptec’s Easy-CD Creator. A 
mastering application, when used with CD-R media, is capable of directly 
writing discs using a format that can be read by virtually all CD-ROM 
drives and operating systems (Windows95, Windows NT, Windows 3.x, 
and DOS). 

Interchange Summary

The following table is a brief summary of which CD drives can read discs 
created with certain application/media combinations.

* Your CD-ROM drive must be capable of reading packet-written CDs. Most CD-ROM drives 
are packet tolerant. If you have problems, check your drive’s documentation or consult the 
drive’s manufacturer.

Application 
used to 

make a CD

Type of CD 
used

Drives that can read the CD

DirectCD CD-RW MultiRead CD-ROM with UDF 
reader
Windows 95 and NT 4.0

CD-R
(closed)

*Most CD-ROMs 
Windows 95 and NT 4.0

CD Copier CD-RW MultiRead CD-ROM

CD-R Any CD-ROM 

Easy-CD Audio CD-RW MultiRead CD-ROM

CD-R Any CD-ROM, home or car CD 
player

Easy-CD 
Creator

CD-RW MultiRead CD-ROM

CD-R Any CD-ROM
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Chapter 5:
Making Data CDs

To make data CDs, you can use DirectCD.™ DirectCD provides a way to 
write files directly to a CD-Recordable (CD-R) or CD-ReWritable (CD-RW) 
disc, much like you would to a floppy diskette or removable drive. 

With DirectCD you can read and write files directly to your CD with any 
software application that can read and write to a drive letter. Some 
examples include:

■ Software applications such as Microsoft Word, when you use the 
Save or Save As commands

■ Windows Explorer, when you drag and drop files

■ Windows 95®/NT, when you use the Send To command

■ MS-DOS, when you use command prompts from within 
Windows 95/NT

DirectCD provides a file system based on UDF v.1.5 and writes data to the 
CD-R or CD-RW disc using packet-writing technology. This file system 
gives you drive letter access to your CD-RW drive. 

DirectCD includes a wizard that guides you step-by-step through the 
process of preparing and ejecting CD-R and CD-RW discs.

Uses for DirectCD
DirectCD is the easiest way to save data files directly to CD. Uses for 
DirectCD include:

■ Archiving data

■ Backing up a hard drive
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■ Disseminating information to field offices

■ Transferring and distributing data to other Windows 95 systems

Starting DirectCD
To start DirectCD so you can begin writing data to your CD:

■ Double-click the CD-RW drive icon  on the right side of the 
taskbar.

The DirectCD Wizard appears and guides you step-by-step to prepare the 
CD so you can write data directly to it.

Writing Data to a CD the First Time

Before you can write data directly to your CD, you must first format the 
CD. To do so, follow these steps:

1. Insert a blank CD into your CD-RW drive.

2. Double-click the CD-RW drive icon  on the taskbar.

The Adaptec DirectCD Wizard window appears.

3. Click Next.

4. If you have more than one CD-R or CD-RW drive, select the CD-R drive 
containing the blank CD and click Next.

5. In the Format Disc window, select the option that says:

I will be using DirectCD to read and write the CD through the 
drive letter associated with the CD-R drive.

NOTE: Formatting a blank CD-RW disc may take approximately one hour. 
Formatting a CD-RW disc also requires additional space on the disc (up to 100 
MB or more). Thus, CD-RW discs have less than 500 MB of available space 
while CD-R discs can store over 600 MB of data.

6. Click Next to continue.

7. Type in the name you want to call your CD in the Volume Information 
window and click Finish.
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The DirectCD Disc Ready window appears when the formatting is 
complete.

8. Click OK.

The DirectCD disc is ready for you to write information directly to the 
CD.

Adding Data to a DirectCD Disc

Once your CD is formatted as a DirectCD disc, there are a number of 
ways to add data to it:

■ Drag and drop files from Windows Explorer onto the CD-RW drive 
icon.

■ Select Save As from a Windows 95/NT application File menu and 
select the drive letter of your CD-RW drive.

■ Use the Send To command.

■ Use MS-DOS command prompts from a DOS window in 
Windows 95/NT.

Ejecting a DirectCD Disc

When you eject a DirectCD disc from your CD-RW drive and you want to 
continue reading the CD on your computer using your CD-RW drive or 
another CD-R system that supports DirectCD, the disc must be formatted 
so you can continue using DirectCD. When you eject a disc, DirectCD 
automatically formats it for you. To eject a DirectCD disc, follow these 
steps:

1. Right-click the CD-RW drive icon  on the taskbar.

2. Select Eject from the drop-down list box.

DirectCD ejects your CD from the CD-RW drive.

Writing More Data to a DirectCD Disc

To add more data to your DirectCD disc—meaning that you have 
previously formatted a blank CD for DirectCD use—you can add more 
information to it until the disc is full. To do so, follow these steps:
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1. Insert the DirectCD disc into your CD-RW drive.

2. Wait for the DirectCD Disc Ready window to appear.

3. Click OK and continue writing more data to your CD.

Erasing the Contents on a DirectCD Disc
If you are using CD-RW discs and a CD-RW drive, you can erase the 
contents on the CD so you can rewrite new information to the CD. 
However, if you delete files from a CD-R disc, the files become invisible to 
the file system (such as Windows Explorer) but are not actually erased 
from the disc. Deleting files from a CD-R disc does not increase the 
available space on the disc.

To erase the contents on a DirectCD disc, follow these steps:

1. While in Windows Explorer, select the file(s) you want to erase.

2. Select Delete from the File menu.

3. Click Yes to confirm that you want to erase the files from the CD.

DirectCD erases the selected file(s) from the CD.

Getting Help
For set-up and connection problems with your CD-RW drive, refer to the 
Troubleshooting section of the hardware guide.

For information about DirectCD, including DirectCD properties, refer to 
the appropriate topics in the Online Help. To access the DirectCD 
Online Help:

■ Click Help on any of the DirectCD Wizard windows

If you need further assistance, please contact Adaptec. The information 
and support services we offer are described in the Customer Support 
section at the end of this manual.
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Chapter 6:
Making Music CDs

A music CD is a compact disc (CD) containing digital audio tracks 
recorded in the Compact Disc-Digital Audio (CD-DA) format. 

Music CDs can store up to 74 minutes of music and may contain up to 99 
tracks, each usually representing a separate piece of music. Music CDs 
can be played back from a home or car CD player or from a CD-ROM 
drive through speakers or headphones attached to the drive’s output jack.

Using Easy-CD Audio, you can:

■ Compile audio CDs of your favorite music

■ Make CDs from Wave files on your hard drive

Starting Easy-CD Audio
To start Easy-CD Audio so you can begin making your own music CDs, 
follow these steps:

1. In Windows 95, click the Start button located on the left side of the 
taskbar.

2. Select Programs, point to HP CD-Writer Plus, and select Make Music 
CDs.

The Easy-CD Audio Wizard window appears. 
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How to Make a Music CD
To make an audio CD, you can record songs from:

■ Tracks on an existing CD

■ Wave files stored on your hard drive (*.wav, a standard Windows 
format for sound files.)

■ A combination of Wave files and tracks

NOTE: Easy-CD Audio is designed to assist you in reproducing material in 
which you own the copyright or have obtained permission to copy from the 
copyright owner. Unless you own the copyright or have permission to copy from 
the copyright owner, you may be violating copyright law and be subject to 
payment of damages and other remedies. If you are uncertain about your rights, 
contact your legal advisor.

Using the Wizard

The easiest way to make a music CD is using the Easy-CD Audio Wizard. 
The Wizard appears when you first start Easy-CD Audio and guides you 
step-by-step to make a simple music CD. To use the Wizard, follow these 
steps:

1. Start Easy-CD Audio.

The Easy-CD Audio Wizard window appears.
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2. Follow the on-screen instructions in the Wizard windows.

A list of the audio tracks you are adding to your CD appears in the main 
Easy-CD Audio window. A final message box notifies you when the 
recording is complete.

Recording Audio Tracks from an Existing 
Music CD

To record songs (audio tracks) from an existing music CD, you need to 
first create a CD layout— a file that contains the list of songs and the 
order in which they will be recorded—then record the layout to a blank 
CD. To do so, follow these steps:

1. Select New CD Layout from the File menu or open an existing CD 
layout. 

2. Click the Audio CD Layout tab:

The top part of the window is Windows Explorer, where you can select 
the songs you want to record. The bottom part is the Audio CD Layout 
window, which allows you to view the contents of the CD layout. To 
make changes to the list of tracks in the Audio CD Layout tab, see 
“Changing the Order of Your Songs” on page 6-7.

Windows Explorer Audio CD Layout Window
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3. Insert the source CD, which contains the songs you want to record, into 
your CD-RW drive.

NOTE: You can record directly from a CD-ROM drive only if it supports digital 
audio extraction. See “Recording from a CD-ROM Drive” in the Easy-CD Audio 
Online Help.

4. In the Explorer section of the window, select the drive where the source 
CD is located to view the list of songs on the CD.

5. Drag the songs that you want to record from Explorer to the Audio CD 
Layout window. 

To change the name of a song, see “Renaming Songs in Your CD Layout” 
on page 6-8.

6. Repeat steps 3-5 for each existing music CD from which you want to 
record songs. 

7. Select Create CD from the File menu when you have placed all of the 
songs that you want to record into the Audio CD Layout window.

The CD Creation Setup box appears.

8. Make changes, if any, to the CD Creation Setup settings (see “CD 
Creation Setup Settings” in the Easy-CD Audio Online Help for 
descriptions) and click OK.

Easy-CD Audio begins recording your CD layout to a blank CD. Insert a 
blank CD when prompted. A final message box notifies you when the 
recording is complete.

NOTE: To make a sleeve that lists the artist, CD title, and songs, see ”Chapter 
7:  Making Inserts and Labels”.

Recording Wave Files Stored on Your Hard 
Drive

To record a music CD using Wave files (*.wav), the Wave files must be 
stored on your hard drive at 11, 22, 44.1 KHz, 8- or 16-bit, mono or 
stereo. To make a Wave file from an existing CD, see “Pre-recording 
Audio Tracks to Wave Files” on page 6-5.
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To record Wave files stored on your hard drive to a blank CD, follow 
these steps:

1. Insert a blank CD into your CD-RW drive.

2. Select New CD Layout from the File menu or open an existing layout.

3. Click the Audio CD Layout tab.

4. Select the Wave files you want to record from Explorer and drag them to 
the Audio CD Layout window.

5. To change the name of the song(s) see “Renaming Songs in Your CD 
Layout” on page 6-8.

6. Select Create CD from the File menu when you have finished adding all 
of the songs you want to record to your CD layout.

The CD Creation Setup box appears.

7. Make changes, if any, to the CD Creation Setup settings (see “CD 
Creation Setup Settings” in the Easy-CD Audio Online Help for 
descriptions) and click OK.

Easy-CD Audio begins recording your CD layout to a blank CD. A final 
message box notifies you when the recording is complete.

NOTE: To make a sleeve that lists the artist, CD title, and songs, see ”Chapter 
7:  Making Inserts and Labels”.

Pre-recording Audio Tracks to Wave Files

Pre-recording audio tracks to Wave files on your hard drive is a way to:

■ Minimize swapping CDs in and out of your drive if you want to make 
more than one copy 

■ Add sound effects to customize the song (use a third-party sound 
editor)

■ Improve the sound quality if your CD recording system is less than 
optimal
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You can pre-record one Wave file at a time. To pre-record a Wave file from 
an existing CD, follow these steps:

1. Insert the source CD, which contains the song you want to pre-record to 
your hard drive, into your CD recorder.

2. Click the Audio CD Layout tab.

3. Select the audio track you want to pre-record from Explorer and drag it 
into the Audio CD Layout window.

4. Highlight the audio track in the Audio CD Layout window.

5. Select Pre-record to WAV file from the Track menu.

NOTE: Pre-recording audio tracks to Wave files requires approximately 10MB 
of space on your hard drive for one minute of music.

6. Type in a file name for the Wave file and choose a different location on 
your hard drive if you do not want to record your Wave file to your Temp 
directory.

7. Click Save.

Easy-CD Audio pre-records your Wave file to your hard drive. A final 
message box notifies you when the recording is complete.
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Combining Both Audio Tracks and Wave Files

You can make a music CD that contains songs both from pre-recorded 
Wave files stored on your hard drive and from audio tracks on an existing 
music CD. To do so, follow the steps outlined in “Recording Audio Tracks 
from an Existing Music CD” on page 6-3 and “Recording Wave Files 
Stored on Your Hard Drive” on page 6-4, depending on the type of songs 
you want to record. Once you have added all of the audio tracks and 
Wave files you want to record to your CD layout, select Create CD from 
the File menu.

Modifying Your CD Layout
The following sections describe how to make changes to your CD layout.

Changing the Order of Your Songs

Once you have added more than one song to your CD layout, you can 
change the order of the songs at any time before creating the CD.

To change the order of the songs, follow these steps:

1. Select the song whose order you want to change in the CD layout.

2. Drag it to the position you want it to appear in the Audio CD Layout 
window.

Removing Songs from Your CD Layout

You can remove any song you have added to a CD layout at any time 
before you create a CD. To remove a song from your CD layout, follow 
these steps:

1. Select the song you want to remove in the Audio CD Layout window.

2. Select Cut from the Edit menu.
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Renaming Songs in Your CD Layout

To rename a song listed in your CD Layout, follow these steps:

1. Select the song you want to rename in the Audio CD Layout window.

2. Select Rename in the Track menu.

3. Type in the new name in the text box.

Saving a CD Layout

You can create a CD layout, save it, then use it to record a CD later. To 
save a CD layout, follow these steps:

1. Select Save As from the File menu.

2. Type in the File name.

3. Select the location where you want to store the file.

Opening an Existing CD Layout

To open a CD layout you have previously saved:

■ Select Open CD Layout from the File menu. 

Easy-CD Audio displays the contents of the layout.

Playing Music CDs
Use the Windows 95 CD Player to listen to music CDs.
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Getting Help
For setup and connection problems with your CD-RW drive, refer to the 
Troubleshooting section of the hardware guide.

For information about Easy-CD Audio refer to the appropriate topics in 
the Online Help. To access the Easy-CD Audio Online Help:

■ Select Help Topics from the Help menu.

If you need further assistance, please contact Adaptec. The information 
and support services we offer are described in the Customer Support 
section at the end of this manual.
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Chapter 7:
Making Inserts and 
Labels

A jewel case insert is a cover you can print and insert in the CD’s jewel 
case—the plastic case that holds the CD—to indicate the title and 
contents of your CD.

The cover is printed on one side of a sheet of paper and then folded. One 
side lists the files or tracks and the other side shows the title and may also 
contain graphics.

Easy-CD Audio allows you to customize your own jewel case insert. Once 
you have edited the jewel case insert, you can preview it, print it, cut it to 
size, and insert it in the case.

You can also design and print a label for the top of the CD. You can use a 
standard printer if you use special paper designed for disc labels.
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Starting Jewel Case Designer
There are two ways to start the Jewel Case Designer:

1. In Windows 95, click the Start button, select Programs, point to HP 
CD-Writer Plus, and select Make Inserts and Labels.

2. If you are already in Easy-CD Audio, click the Jewel Case Layout tab.

How to Make a Jewel Case Insert
When you make a music CD, Easy-CD Audio uses the CD layout 
information to create a basic jewel case insert, including the CD title, 
artist name, and list of songs. You can then click the Jewel Case Layout 
tab to modify and customize that information, such as changing font 
styles and adding graphics. 

When you make a data CD, you can select Make Inserts and Labels from 
the program group to create your own custom jewel case insert.

Creating custom jewel case inserts involves three basic procedures:

■ Editing inserts

■ Adding text and graphics

■ Printing

The following sections explain how to view and edit inserts, add text and 
graphics, and print jewel case inserts.

Editing Inserts

The following sections describe the different ways you can view and edit 
jewel case inserts before printing them.

Viewing Inserts

To view the different parts (pages) of the jewel case insert, follow these 
steps:

1. Click the Jewel Case Layout tab.
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2. From the Page menu, select the part of the insert you want to view:

■ Jewel Front—to view the Inside Jacket and Front Cover

■ Jewel Back—to view the Back Cover

■ Disc Printer—to view the Compact Disc label

Easy-CD Audio displays the view.

Zooming

To view a section of an insert page in greater detail, you can magnify the 
view. To change the magnification of the page, follow these steps:

1. Select Zoom from the Page menu.

2. Select the zoom level you want to apply.

3. Click OK.

Easy-CD Audio changes the magnification level.

Using Rulers and Grids

You can use rulers and grids to position text and graphics on your jewel 
case insert. See “Setting Insert Layout Options” in the Easy-CD Audio 
Online Help to define your preferences.

Using Rulers

Rulers are displayed along the perimeter of the Jewel Case Layout 
window and help you to measure the insert and its objects.
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To display or hide the rulers, do the following:

■ Select the Ruler option from the View menu to view rulers.

■ Deselect the Ruler option from the View menu to hide rulers.

Using Grids

Grids help you to more precisely position objects on the insert with 
respect to other objects on the physical page.

To snap objects to a grid—meaning the objects are automatically moved 
to the grid line—do the following:

1. Select Grid from the Layout menu.

2. Select Snap to Grid from the Layout menu.

The objects snap to the nearest grid marker when you move them around 
on the page.

To display or hide the grids, do the following:

■ Select the Grid option from the Layout menu to view grids.

■ Deselect the Grid option from the Layout menu to hide grids.

Positioning Inserts

You can position the insert at any location on the physical page. For an 
approximate position, use the box at the intersection of the two 
rulers.

To position the insert, follow these steps:

■ Drag the box at the intersection of the ruler to the position on the 
page where you want the upper left corner of the insert to be located.

For more precise control over the position of the insert, use the Origin 
settings in the preferences. See “Setting Insert Layout Options” in the 
Easy-CD Audio Online Help.
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Adding Text

You can add as much text as you like to the jewel case insert. When you 
add text, you can define some attributes, such as font style, color, and 
background fill color. 

To add text, follow these steps:

1. Select Insert Text from the Edit menu. 

2. Type the text in the Text box.

3. Select the text attributes you want to use:

4. Click OK.

The text is added where the cursor is located on the Jewel Case Layout 
window.

Attribute Description

Fill Color Select the color you want surrounding the 
text. 
NOTE: When text is marked Transparent—
meaning that you can see the background 
behind the text— you can not define a fill 
color.

Text Color Select the color of the text.

Font Select the font, style, and size of the text.



7-6 How to Make a Jewel Case Insert

Editing Text Objects

To change the attributes of any text object in the jewel case layout, 
follow these steps:

1. Double-click the text object you want to edit.

2. Select the text attributes you want to change. See “Adding Text” on page 
7-5.

3. Click OK.

Adding Graphics

The graphics used in Easy-CD Audio are called OLE objects. OLE is a 
Windows feature that maintains associations with objects across different 
applications. For example, if you add OLE objects to inserts, you can 
double-click the object to open the associated application so you can edit 
the object.

To create and insert an OLE object, follow these steps:

1. Select Insert New Object from the Edit menu.

2. Select the Create New option.

3. Select the application in which you want to create the object in the 
Object Type drop-down list box.

4. Click OK.

The graphic appears in the Jewel Case Layout window.

NOTE: See the Easy-CD Audio Online Help for information on editing and 
moving objects.

Arranging Track Titles

Information about tracks listed in the Audio CD Layout is automatically 
added to the Jewel Case Layout window. If you delete tracks while 
making an audio CD, the associated information is automatically 
updated in the Jewel Case Layout tab.
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Deleting tracks while making an audio CD may cause blank rows to 
appear in the tracks list of the Jewel Case Layout tab. Therefore, if you 
make changes to the track list that affect the position of the tracks on the 
Jewel Case Layout window, Easy-CD Audio asks if you want the tracks 
automatically repositioned.

The Jewel Case Layout tab provides some commands that let you create 
columns of track information, display the length and number of each 
track, and automatically position tracks on the layout for better 
positioning.

The following sections describe different ways you can arrange the tracks 
in the Jewel Case Layout.

Creating Track Column Lists

You can arrange the track information boxes:

■ Randomly by dragging them to new positions in the Jewel Case 
Layout window, or 

■ In a linear list with one or two columns.

To create a track list:

■ Select One Column or Two Column from the Text menu.

Displaying Track Numbers and Duration Times

Easy-CD Audio includes the track number and duration time for each 
audio track. The track number indicates the order in which the audio 
tracks are recorded. The duration time is shown in minutes and seconds.

To display the track numbers:

■ Select Display Track Number from the Text menu.

To display track duration times:

■ Select Display Track Time from the Text menu.

Fitting Tracks on a Page

Fitting tracks means all the track information is centered on each page 
and aligned along the first character of each track.

You can move track titles from the inside jacket and the back cover to the 
front cover. However, Best Fit will move tracks back to their original 
location.
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To fit the tracks on the page as described above:

■ Select Best Fit from the Arrange menu.

Printing Jewel Case Inserts

You can print a jewel case insert while the Jewel Case Layout tab is open. 
The commands and options available for printing depend on the type of 
printer that is connected to your computer. For information about these 
options, see your printer’s guide.

To print a jewel case insert or a disc label, follow these steps:

1. Select Print from the File menu.

2. Click OK.

To preview an insert before printing it:

1. Select Print Preview from the File menu.

2. Click OK.

Getting Help
For setup and connection problems with your CD-RW drive, refer to the 
Troubleshooting section of the hardware guide.

For information about making jewel case inserts, refer to the appropriate 
topics in the Easy-CD Audio Online Help. To access the Easy-CD Audio 
Online Help:

■ Select Help Topics from the Help menu.

If you need further assistance, please contact Adaptec. The information 
and support services we offer are described in the Customer Support 
section at the end of this manual.
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Chapter 8:
Copying CDs

The most common use for making a copy of a CD is to create a working 
copy of a CD and archive the original in a safe place.

NOTE: CD Copier is designed to assist you in reproducing material in which 
you own the copyright or have obtained permission to copy from the copyright 
owner. Unless you own the copyright or have permission to copy from the 
copyright owner, you may be violating copyright law and be subject to payment 
of damages and other remedies. If you are uncertain about your rights, contact 
your legal advisor.

What Kinds of CDs Can I Copy?
Using CD Copier, you can make backup copies of almost any type of CD. 
The following table lists the types of CDs that can be copied and some 
notes about making backup copies:

Type of CD Notes

Audio If you are using a drive other than a CD-R or CD-RW 
drive, a source CD-ROM drive capable of reading 
audio digitally is required. Not all drives support 
digital audio extraction. See “Testing Your System 
Configuration” in the CD Copier Online help. (Easy-
CD Audio tests your drive to determine its capabilities 
when the source CD is inserted.)

CAUTION: This release of CD Copier supports copying 
CDs in Track-at-Once mode. This means that there is a 
two-second gap of silence between tracks.
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Starting CD Copier

You can open CD Copier from the Start button in the Windows 95 
taskbar. To do so, follow these steps:

1. In Windows 95, click the Start button located on the left side of the 
taskbar.

2. Select Programs, point to HP CD-Writer Plus, and select Copy CDs.

The CD Copier Source and Destination tab appears.

DirectCD 
Discs

Some CD-ROM drives may not be able to read a 
DirectCD disc. If you have a CD-ROM drive that is 
multiread capable, there should be no problems.

Mixed-Mode Mixed results. Some CDs copy perfectly; others do 
not, possibly because the CD is formatted to 
circumvent copying or because some CDs do not 
follow the standard specifications.

CD Extra Some audio may be lost if there is less than a
two-second gap on the source CD.

Photo CD Requires a source CD-ROM drive capable of reading 
CD-ROM XA. Most current CD-ROM drives support 
this.

Video CD Requires a source CD-ROM drive capable of reading 
CD-ROM XA. Most current drives support this.

Type of CD Notes
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How to Make a Copy of a CD
To make a backup copy of a CD, follow these steps:

1. Select the source drive from which you want to copy the CD. This can be 
your CD-R, CD-RW, or CD-ROM drive. See “Source CD-ROM Drives for 
CD-to-CD Copying” in the CD Copier Online Help if you are going to 
copy directly from a CD-ROM drive.

2. Select the destination drive that contains the blank CD. This is your 
CD-RW drive.

3. Make changes, if any, in the Advanced tab settings. See “CD Copier 
Advanced Tab Settings” on page 8-4.

4. Select one of the following options:

■ Test—Select this option to perform a test in which the files to be 
recorded are passed to the CD recorder. No information is recorded to 
the CD. Use this option if you have made any changes to your CD 
recorder setup.

■ Test & Copy—Select this option to perform a test in which the files to 
be recorded are passed to the CD recorder. Recording begins after a 
successful test.

■ Copy—Select this option when you do not want to perform the test. 
Use this option if you have successfully recorded a number of similar 
CDs and you have not made any changes to your CD recorder setup.

5. Select the number of copies you want to make. 

6. Click Copy to begin recording a copy of your CD.

7. Follow the on-screen instructions and insert a blank CD when prompted.

CD Copier begins copying the files and folders from your source to a 
blank CD. A final message box notifies you when the copying is 
complete.
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CD Copier Advanced Tab Settings

Getting Help
For setup and connection problems with your CD-RW drive, refer to the 
Troubleshooting section of the hardware guide.

For information about CD Copier refer to the appropriate topics in the 
Online Help. To access the CD Copier Online Help:

■ Select Help Topics from the Help menu.

If you need further assistance, please contact Adaptec. The information 
and support services we offer are described in the Customer Support 
section at the end of this manual.

Setting Description

Current CD 
Recorder Speed

Select the speed at which you want to create the 
backup copy of the CD. For greater certainty, 
record at 1x.

Disc Copy Select this option to copy the source CD to your 
hard drive first to speed up the recording process 
if you are making more than one copy of a CD. 
Once the source has been copied to your hard 
drive, CD Copier records the disc copy to the CD.

Select Location To make a disc copy, type in a different location 
to store the image file if you do not want to use 
the Temp directory.
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Chapter 9:
HP Simple Trax

Welcome to HP Simple Trax
HP Simple Trax protects your data by copying files and folders to a CD 
and saving information about them in the Simple Trax information vault 
on your hard drive. This makes it easy for you to find and retrieve any 
protected version of a file you need.

HP Simple Trax is designed to work just the way your Windows Explorer 
works. You can drag and drop items or use the menus. You can also click 
on items with the right mouse button to use the popup menus. Use your 
favorite method or try a new one.

The installation program will place the HP Simple Trax icon on the 
desktop and under My Computer. When you open or explore the Simple 
Trax icon, instead of folders, you see icons representing all the CDs you 
have used to protect your files with HP Simple Trax. You can see which 
files and folders are in each CD without putting a CD in your CD-Writer. 
Retrieving one or more files or folders from a CD is a snap — just treat 
the Simple Trax folder as a regular CD drive and copy the files using HP 
Simple Trax's handy popup menus. HP Simple Trax asks you for the 
correct CD(s) as needed to retrieve the selected files.

You don’t have to log or track what is stored on your CDs, HP Simple 
Trax does it for you automatically. You can create a list of important files 
or folders that you want to protect regularly and even schedule 
protection to take place automatically when you are not using your 
computer. It's that easy to protect all your important information!

With HP Simple Trax, your important files are secure and easy to retrieve. 
You can even retrieve older versions of files, allowing you to undo major 
revisions or changes. HP Simple Trax also helps you find the file(s) you 
want to retrieve, including specific versions of a file, with its search 
option.
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HP Simple Trax is installed along with your other CD-Writer Plus 
software. No special installation or configuration is necessary. All you 
need to do before using HP Simple Trax is to prepare a CD for writing 
with your CD-Writer Plus.  The method to prepare a CD can be found on 
page 5-2.

This chapter shows you how to:

■ Protect files and folders on CD

■ Create a Protection List

■ Schedule a protection session to run automatically

■ Retrieve protected files and folders

■ Search the HP Simple Trax information vault

■ Use the HP Simple Trax Control Panel

For more complete information on any topic see the on-line help.

Protecting Files and Folders Immediately
To protect files and folders immediately:

1. Place the CD you want to use to protect information into your CD-Writer 
Plus.

2. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.

3. Click the file or folder you want to protect with the right mouse button. 
A popup menu appears.

To select multiple files or folders within a single folder, press and hold 
the CTRL key while clicking the desired items with the left mouse button. 
Then release the CTRL key and click with the right mouse button.
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4. Point to HP Simple Trax and click Protect... from the HP Simple Trax 
menu.

The View Versions option only appears if you have selected a single file.

HP Simple Trax copies the selected file(s) and folder(s) to the CD in your 
CD-Writer Plus and places information about the protected files into its 
information vault.

If the CD you placed in your CD-Writer Plus has not been used with HP 
Simple Trax before, the program prompts you to type a name to identify 
the CD. This name is used only in the HP Simple Trax information vault. 
Be sure to write the same name on the CD label.

NOTE: When you use Direct CD to write to your CD-Writer Plus directly, as 
described in chapter 5, HP Simple Trax does not save any information about 
this operation in its information vault. For HP Simple Trax to save information 
about the files you are protecting you must use the HP Simple Trax popup 
menus as described above, drag and drop to the HP Simple Trax icon, or copy 
and paste on the HP Simple Trax icon.

Creating a Protection List
The HP Simple Trax Protection List contains all files and folders you have 
designated for protection. You can then schedule a protection session to 
copy all items in the Protection List to a CD at once. This is a much more 
efficient method of protecting your important information because it 
copies all designated files and folders in one operation, saving you time 
and effort.

To add files and folders to the Protection List:

1. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.
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2. Click the file or folder you want to protect with the right mouse button. 
A popup menu appears.

To select multiple files or folders within a single folder, press and hold 
the CTRL key while clicking the desired items with the left mouse button. 
Then release the CTRL key and click with the right mouse button.

3. Point to HP Simple Trax and click Add to Protection List from the HP 
Simple Trax menu.

The View Versions option only appears if you have selected a single file.

HP Simple Trax places the selected file(s) and folder(s) in the Protection 
List.

4. Repeat steps 2 and 3 for any other files or folders that you want to add to 
the Protection List.

To protect the files and folders in the Protection List, use the HP Simple 
Trax Control Panel Schedule Setup tab. See the next section or the HP 
Simple Trax Control Panel section later in this chapter for more 
information.

Scheduling a Protection Session to Run 
Automatically

HP Simple Trax allows you to schedule a protection session to run at a 
specified time on selected days. Scheduled sessions automatically protect 
all files and folders in the Protection List so you don't have to remember 
to do so. You can even schedule a protection session to run in the middle 
of the night or any other time your computer is on but not in use.
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For a scheduled protection session to run unattended you will need to 
have a CD that already  has a name for use in HP Simple Trax. If it is the 
first time you use the CD in HP Simple Trax the software will prompt you 
to type a name to identify the CD when the session begins.

To schedule a protection session:

1. Double-click the HP Simple Trax Control Panel shortcut on your 
desktop or click the Start button and point to Programs, then to HP CD-
Writer Plus, then to HP Simple Trax, and select Control Panel from the 
HP Simple Trax menu.

2. Click the Schedule Setup tab. The following screen appears:

3. Use the row of buttons along the top of this tab to select the day(s) to 
perform a scheduled protection session. Click the desired day button(s).

4. Set the time you want the scheduled protection session to start on the 
selected day(s).

5. Select the desired protection option:
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■ All files in the list: Protects every item in your Protection List, 
whether changed or not.

■ Only changed files: Protects only those items in your Protection List 
that have changed since the last protection session.

6. Click OK to schedule the protection session.

Be sure to place the desired CD in your CD-Writer Plus before the 
scheduled protection session is set to begin. Since the first time you use a 
CD in HP Simple Trax the program prompts you to type a name to 
identify the CD, make sure you have already used the CD in HP Simple 
Trax for the scheduled protection session to run unattended.

Leave your computer on so the scheduled protection session can run.

Click Run Now if you want to protect the items on your Protection List 
immediately. The protection session will still run as scheduled.

Retrieving Protected Files and Folders
Retrieving protected files and folders using HP Simple Trax is very quick 
and easy. You don’t need to insert a CD into your CD-Writer Plus before 
the retrieval actually begins. HP Simple Trax shows you all the files and 
folders you have protected on all CDs and prompts you for the correct 
CD(s) during the retrieval process. Since HP Simple Trax automatically 
gives you the most recent version available of a file you may have to 
insert a CD you didn’t expect to.

To retrieve protected files and folders:

1. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.

2. Double-click the Simple Trax icon.
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3. Double-click the CD label for the CD from which you want to retrieve 
files or folders. Open the folder containing the file(s) and folder(s) you 
want to retrieve.

If you do not know which CD contains the files or folders you want to 
retrieve, click the Tools menu, point to Find, and click In Simple Trax...  
to use HP Simple Trax Find feature.

4. Click the file or folder you want to retrieve with the right mouse button. 
A popup menu appears.

The View Versions option only appears when you right-click on a file. 

To select multiple files or folders within a single folder, press and hold 
the CTRL key while clicking the desired items with the left mouse button. 
Then release the CTRL key and click with the right mouse button.

5. Click Retrieve from the popup menu.

6. Set the retrieve options:

■ Make sure Ask before overwriting files is checked to prevent 
retrieved files from overwriting existing files of the same names 
without HP Simple Trax prompting you to do so first.
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■ Make sure Include subdirectories is checked to retrieve all 
subdirectories in the selected folder. (This option is useful only if you 
have selected one or more folders.)

■ Click Copy files to an alternate location and type the desired drive 
and path or click Browse and select the new location from the list of 
folders on your hard disk(s).

NOTE: If you choose to retrieve the selected files or folders to an alternate 
location, all of the retrieved files are removed from the original folders and 
subfolders and are placed in the alternate location. If you want to keep the 
directory information either drag and drop the items or use copy and paste.

7. Click OK to continue.

8. Insert the correct CD if it is not already in your CD-Writer Plus. HP 
Simple Trax prompts you for the required CD.

9. Confirm that you want to replace existing files, if prompted to do so. 

HP Simple Trax retrieves the most recent versions of files that you 
selected. In order to do this HP Simple Trax may prompt you for different 
CDs depending where the most recent version was copied.

TIP: If you are using multiple CDs disable the DirectCD banner.

You can also retrieve earlier versions of a file using the View Versions 
option. This option will bring up the File Protection History dialog box, 
which lists all the protected versions of the file. The most common 
reason for retrieving an older version of a file is to undo major revisions 
or changes.

To display the File Protection History dialog box run Explorer, click the 
file on your hard disk that you want to examine with the right mouse 
button, point to HP Simple Trax on the popup menu, and select View 
Versions. You can also double-click the HP Simple Trax icon, click the file 
you want to examine with the right mouse button, and select View 
Versions.
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The File Protection History dialog box appears:

To retrieve an older version of a file, click the desired file version in the 
File Protection History dialog box and click the Retrieve button. Older 
versions of a file can only be retrieved one at a time.

Searching the HP Simple Trax Information 
Vault

HP Simple Trax helps you find protected files in the HP Simple Trax 
information vault so that you can see if a file has been protected, see 
when it was last protected, and retrieve it if desired.
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To find protected files in the HP Simple Trax information 
vault:

1. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.

2. Double-click the HP Simple Trax icon.

3. Click the Tools menu, point to Find, and click In Simple Trax... to 
display the Find dialog box.

4. In the Named box, type all or part of the filename you want to find.

You can use a file filter to search for files or folders based on name 
patterns.

A file filter is a generalized description of a filename composed of a 
partial filename and one or more of the wildcard characters. The wildcard 
characters take the place of one or more letters or numbers to help you 
find a file whose name you do not know or specify a group of files with 
similar names. The wildcard characters are:

* = any number of characters

? = a single character

Examples:

■ To find all files that end in .txt, type *.txt

■ To find all files that end in .wp and one additional character, type 
*.wp?

■ To find all files that begin with report and have any extension, type 
report.*

5. To limit the search to a specific CD, drive, or folder, click the desired CD, 
drive, or folder in the Look in: box.

6. Click Find Now to begin searching.

If you want to stop the search click Stop.
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If you do not know the name of the file(s) or folder(s) you want to find, 
click the Date tab to search the information vault for items created, 
modified, or protected during a specified period of time.

Click a file with the right mouse button to retrieve it or view protected 
versions.

The HP Simple Trax Find menu provides additional options. Refer to the 
on-line Help for complete information.

HP Simple Trax Control Panel Overview
The HP Simple Trax Control Panel provides access to many HP Simple 
Trax options. The HP Simple Trax Control Panel has three notebook tabs 
that organize the available functions:

■ Selection: The Selection tab gives you full control over the HP Simple 
Trax Protection List, allowing you to add and remove files and folders 
as needed to protect your valuable information.

■ Schedule Setup: The Schedule Setup tab allows you to schedule 
automatic protection of all items in the Protection List.

■ Error Logs:  An error log is automatically created during every 
protection or retrieval session whether or not an error occurs. You 
may wish to consult the error log for additional information in the 
event that an error message appears during an operation.

To run the HP Simple Trax Control Panel, double-click the HP Simple 
Trax Control Panel shortcut on your desktop or click the Start button, 
point to Programs, then to HP CD-Writer Plus, then to HP Simple Trax, 
and click Control Panel.
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Selection Tab

The Selection tab gives you full control over the HP Simple Trax 
Protection List, allowing you to add and remove files and folders as 
needed to protect your valuable information.

The HP Simple Trax Control Panel Selection tab is divided into two 
sections:

Available Files

■ Drive List: Choose the drive you want to work with from this drop-
down list.

■ Folder List: Click the folder you want to open.

■ File List: Displays the files in the selected folder that meet the criteria 
specified by the File Selection radio buttons.

■ File Selection Radio Buttons: Control how files are displayed and 
selected for protection. There are three options:
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1. All Files & Folders: Selects all files and any subfolders in the current 
folder for protection. The contents of the current folder appear in the 
File List.

2. File Type: Specifies the type of files that are selected for protection 
and displayed in the File List. Type the desired file filter in the 
accompanying combo box or select a file filter you have used before 
from the drop-down list. Only filters of the form *.??? are allowed. 
Some examples of these filters are *.bmp, *.doc, and *.txt. The 
advantage of using a file type when creating a Protection List is that 
future files of that type are automatically included.

3. Individual Files: Allows you to choose the specific files to be 
protected from the File List. Click the desired file(s).

■ Add to List Button: Adds the selected files to the Protection List.

Protection List

■ Protection List: Contains all files and folders you have designated for 
protection. You can then schedule a protection session to copy all 
items in the Protection List to a CD at once.

■ Remove from List Button: Click the items you want to remove from 
the Protection List and click this button.

Schedule Setup Tab

The Schedule Setup tab allows you to schedule automatic protection of 
all items in the Protection List.

The controls on this tab are contained in a single group:

■ Day of the Week Buttons: Use this row of buttons to select the day(s) 
on which to perform a scheduled protection session. You can click as 
many days as desired. The selected day buttons remain pressed. To 
remove a day from the schedule, click the desired button.

■ Options: These radio buttons set the protection options.

All files in the list: Protects every item in your Protection List, 
whether changed or not.

Only Changed files: Protects only those items in your Protection List 
that have changed since the last protection session.

■ Start Time: Type the time at which the scheduled protection session 
is to begin. The Start Time is the same for all selected days.
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■ Run Now... Button: Click this button to protect all items in your 
Protection List immediately.

Error Logs Tab

An error log is automatically created during every protection or retrieval 
session whether or not an error occurs. You may wish to consult the error 
log for additional information in the event that an error message appears 
during an operation.

The controls on this tab are contained in a single group:

■ Error Log List: This portion of the tab displays information about the 
error logs and allows you to select a specific error log so that you can 
get more information on any errors that occurred. 

■ View Button: Click the error log you want to open and click this 
button. Use this option to see the details of any errors that occurred. 
The information contained in the error log can help you solve the 
problem.

■ Delete Button: Click the error log you want to delete and click 
Delete.

CAUTION: When you delete an error log, it cannot be restored.

■ Keep last x error log entries: Click this radio button to set the 
number of error log entries HP Simple Trax is to keep. Type the 
number of error logs to keep or use the spin buttons to set the desired 
number. When this number is exceeded, the oldest error log is 
automatically deleted.

■ Keep all error log entries: Click this radio button to keep all error log 
entries. You can then delete unwanted entries manually using the 
Delete button.

HP Simple Trax’s seamless integration to Explorer makes protecting and 
retrieving your valuable information easy. Schedule protection sessions 
of your important documents so that they will always be available. Keep 
your hard drive from getting cluttered by versions of files you think you 
might want in the future by protecting them with HP Simple Trax.



10-1

C
h

ap
ter 10:  A

d
o

b
e 

Ph
o

to
D

elu
xe™

Chapter 10:
Adobe PhotoDeluxe™

Welcome to Adobe PhotoDeluxe™

PhotoDeluxe software makes it easy to be creative with your own 
photographs. Instead of simply viewing photos in frames or albums, with 
PhotoDeluxe you can use your photographs to make calendars, cards, 
and T-shirts, or to add a very personal touch to your gifts. And you’ll 
have fun doing it.

Registration

We are confident that you will find PhotoDeluxe both fun and 
rewarding. So that we can continue to keep you informed about updates 
to Adobe PhotoDeluxe and offer you technical support, please register 
your software by using the online registration software provided.

Starting PhotoDeluxe

In Windows, click the Start button, click Programs, click Adobe, click 
PhotoDeluxe 2.0, and click Adobe PhotoDeluxe 2.0.

NOTE: When using PhotoDeluxe, keep the HP SureStore Plus CD in your CD-
ROM drive as much as possible. Although the CD is not required to use the 
program, you will need it when you want to use the sample photos and clip art 
or use the guided activities stored on it.
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If You have Problems

For solutions to problems you encounter while using the program, see 
the topic “Troubleshooting” in online Help. For important information 
that became available after this book went to press, see the Readme file 
installed in the same folder as PhotoDeluxe.

Adobe also provides technical documents that address many problems. 
Technical documents are freely available on the Adobe Systems World 
Wide Web site at http://www.adobe.com/supportservice/custsupport. Access 
to the web site is only in English and there is limited content in other 
languages.

Learning PhotoDeluxe
Use this guide to become familiar with the process of editing and using 
photos in PhotoDeluxe. For complete information about tools and 
commands, see the comprehensive online Help topics. You can read 
online Help topics at any time by clicking a Help button.

NOTE: Help buttons appear in guided activity steps and in the toolbar. If you 
don’t have a photo window open you can still use online Help by choosing a 
command from the Help menu.

In addition to this guide and the online Help, the documentation for this 
program includes the tour movie on the HP SureStore Plus CD, which 
demonstrates some PhotoDeluxe fundamentals. The movie is provided 
only in English.
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Looking at PhotoDeluxe
PhotoDeluxe is organized so that the most important tools are ready 
when you need them. Step-by-step guided activities make projects easy.

A. Buttons organize guided activities into categories. B. Introduction (Intro) 
tabs acquaint you with each section or guided activity. C. Numbered tabs 
guide you through steps in order. D. Clue cards guide you with information 
about a step. E. Square Help buttons provide specific information within 
steps. F. Round Help buttons display the table of contents for online Help 
where you can get information about any tool or command. G. The status 
bar tells you how much memory your photo uses.
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Toolbar and Photo Organizer

You’ll find the toolbar at the top of the photo window.

A. Zoom In button magnifies an image. B. Zoom Out button reduces an 
image. C. Zoom tool magnifies the area you click or drag across. D. Zoom 
menu lets you choose a magnification. E. Trash Can button deletes the 
selected object. F. Object-order menu button provides options for 
overlapping objects. G. Text tool lets you add text to a photo. H. Help 
button opens online Help. I. Undo button reverses your most recent change 
to the photo.

When you use a gallery, or photo collection, the photo organizer appears. 
The photo organizer floats above other windows.

Getting a Photo into PhotoDeluxe
Adobe PhotoDeluxe works with photos that are already stored as digital 
files. If your photos are stored on your computer, on a disk, or on CD, or 
if you are using a camera or scanner connected to your computer, then 
you are working with digital photos. If your photos are in the form of 
prints, slides, or negatives, they’re not digital yet. You can make digital 
photos with a digital camera, scanner, video-capture device, or a digital 
photo-finishing service. PhotoDeluxe recognizes many kinds of digital 
photo files and can work directly with many brands of scanners and 
cameras.
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If you don’t have any digital photos yet, you can still use PhotoDeluxe 
with any sample photo from one of the photo organizer galleries stored 
on the HP SureStore CD.

Using the Get Photo Button

The Get Photo button gives you access to all of the ways you can get a 
digital photo into PhotoDeluxe.

To get a photo:

1. Click the Get Photo button and read the information under the Intro 
tab that appears. Then click the Get Photo tab.

2. Click the button for the location where the photo is coming from. It’s 
either on your computer, on a disk, or you’re about to create it using a 
connected device such as a scanner, camera, or video-capture device. 
Follow the on-screen instructions.

3. As necessary, complete any dialog boxes that appear. The options that 
appear vary depending on the device you’re using, so you may have to 
consult the instructions that came with the device. When you finish, 
PhotoDeluxe converts the photo into its own file type to give it access to 
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all the features in the program. The photo appears in the photo window, 
ready for use in PhotoDeluxe.

■ If you get the photo from outside PhotoDeluxe, it opens as an untitled 
photo so it’s important to save it right away. A quick way to do this is to 
drag the photo into the My Photos gallery in the photo organizer.

4. Click the My Photos button. When the My Photos window opens, drag 
the photo there.

Getting a Photo from the Photo Organizer

Adobe PhotoDeluxe comes with a photo organizer that appears as a 
floating window where you can organize your photos. You can get or 
store photos by dragging photos out of or into the photo organizer 
window.

The photo organizer stores sets of photos in galleries. You can create your 
own galleries and add or remove photos from them. PhotoDeluxe 
includes the Sample Photos and Clip Art galleries, which you can find 
using the Get Photo button. Unlike galleries you create, the Sample 
Photos and Clip Art galleries are permanently stored on the HP SureStore 
Plus CD, so you cannot change them.

To get a photo from My Photos, Sample Photos, or Clip Art:

1. Insert the HP SureStore Plus CD into your CD drive.
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2. Click the Get Photo button, click the Get Photo tab, and then click the 
My Photos, Sample Photos, or Clip Art button. The gallery appears in a 
photo organizer window.

3. Drag a photo from the photo organizer window to the PhotoDeluxe 
window.

NOTE: You can also just double-click a photo in the photo organizer window.

Saving and Printing your Photos
When you finish working on a photo, you can send the photo to your 
hard disk, another program or computer, the Internet, or to a printer.

Saving your Work

Changes you make to a photo occur only in your computer’s RAM 
(temporary memory) and are not permanently recorded until you save 
the photo to disk. Therefore, as soon as you get a photo into your 
computer it’s a good rule to save the photo immediately and to save 
often, usually after any successful change to the image. The most 
convenient way to store photos is to drag them to the My Photos gallery 
in the photo organizer included with PhotoDeluxe.

To move a photo to the photo organizer:

1. If the My Photos window isn’t already open, click the Get Photo button, 
click the Get Photo tab, and then click the My Photos button.
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2. Drag the photo to the My Photos window.

NOTE: If you are not using the Object selection tool, choose it before dragging to 
the My Photos window.

To save changes to a photo:

■ With the photo window open and in front, choose the Save command 
from the File menu.

Sending Photos to Another Program or 
Computer

PhotoDeluxe can package photos using any of several file formats, 
making it easy to transfer photos to another program or computer. 
Different file formats exist because each has characteristics that work best 
for a specific purpose. For example, the JPEG format works well for 
Internet photos, and the TIFF format works well for desktop publishing.

To prepare a photo for use in a Web page or e-mail message:

1. With a photo open, complete any activity you may be using, click the 
Send button, and then click the To Internet tab.
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2. Click the button that matches the destination of your photo, and follow 
the instructions on the tabs.

To send a photo to a file format for use in another program:

1. With a photo open, complete any activity you may be using, click the 
Send button, and then click the To Disk tab.

2. Click the Export button and then click the 1 Export tab.

Click the button that matches how the photo will be used. The following 
list of typical uses can help you choose:

■ To make a photo you can use on a World Wide Web page, click GIF 
Format.

■ To make a photo that will print well from a desktop-publishing program, 
click Other Export, and then choose EPS or TIFF from the Save As menu.

■ To make a photo readable on many kinds of computers and over the Web 
(using free Acrobat Reader software), click Create Acrobat File.

■ To make a photo that displays well on a system that cannot display more 
than 256 colors, click Index Color.

■ To make a black-and-white version of a color photo, click Grayscale.

■ To save in another format not already mentioned, click Other Export 
and then choose a file format from the Save As menu.

3. Specify a location and filename for the photo, and click Save. After 
PhotoDeluxe finishes saving the photo, click Done.
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Printing a Photo

You can print completed photos or projects with your printer. To prevent 
mistakes and save paper, use Print Preview to check the size of the photo 
on the paper you selected and confirm settings in Page Setup before you 
actually print.

To check the photo size in Print Preview:

1. Click the Send button at the upper left corner of the screen. Click the To 
Printer tab and then click the Print Preview button.

2. After the photo appears on the preview of the printed page, see if the 
entire photo fits within the page boundary. If it doesn’t, you may want to 
use Page Setup to change the page size or orientation or use PhotoDeluxe 
to resize or rotate the photo so it fits.

To check Page Setup options:

1. Click the Send button at the upper left corner of the screen. Click the To 
Printer tab and then click the Page Setup button.

2. Specify the options you want and then click OK.

To print a photo:

1. Click the Send button at the upper left corner of the screen, click the To 
Printer tab, and click the Print button.

2. Select the options you want from the top half of the Print box.

NOTE: The Print Range option applies only to guided activities that create more 
than one page.

3. Select a PhotoDeluxe Output Quality setting from the bottom half of the 
Print box and click OK.
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To print multiple copies on a single page:

1. Click the Send button at the upper left corner of the screen, click the To 
Printer tab, and click the Tiled Printing button.

2. Specify the number of copies you want on the same page for Copies 
Across and Copies Down and then click Print.

Touching Up a Photo
Not all photos are perfect right out of the camera. You can correct 
common photo problems using the Touch Up and More Touch Up tabs. 
They are located next to the Get Photo tab so that you can correct 
common problems as soon as you start using a photo.

To use a Touch Up Activity:

1. Click the Get Photo button, click the Get Photo tab, and open a photo 
using one of the available buttons.

2. Click the Touch Up or More Touch Up tab.

3. Click the button for the adjustment you want to use and follow the 
step-by-step tabs for the button you clicked.

4. Click the step tabs in order and click Done when you complete all of the 
steps. PhotoDeluxe displays Clue cards to help you through the steps.

NOTE: Remember to protect changes to your photo by saving it frequently.
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Undoing Mistakes

Changes you make don’t always look right the first time. Use the 
following strategies to correct mistakes in various situations:

■ You can undo the most recent change by clicking the Undo button on 
the toolbar. When you have a choice between clicking Undo and 
correcting the mistake manually, click Undo—it is faster and will preserve 
more image quality than making a second change over the first. 
However, you can undo only the most recent change.

■ If you’ve already made too many changes to undo, but have not saved 
the photo since making the unwanted changes, choose the Revert to 
Saved command from the File menu.

■ If you’ve applied a change but PhotoDeluxe isn’t finished processing it 
(for example, you see the progress bar at the bottom of the photo 
window), you may be able to cancel the operation by pressing the Esc 
key.

■ To close a dialog box without applying changes, click Cancel. If you 
already clicked OK and you don’t like the changes, click the Undo 
button.

NOTE: To compare the two versions of a photo before and after you apply an 
effect, click Undo repeatedly. This alternates between the two versions.

Adding Text
You can add text to a photo using the Text tool. You can color, move, 
resize, and distort text. If you use PostScript® or TrueType™ fonts, text 
stays sharp and smooth as you resize and distort it. When you send the 
file to another format, text is included with the photo.

NOTE: For text features to work properly in PhotoDeluxe, you must have 
installed Adobe Type Manager, which is part of the PhotoDeluxe installation 
process.

To add text:

1. Click the Text button ( ) on the toolbar in the photo window.
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2. Type into the Text Tool box. The text automatically goes to the next line 
in the text box, but will appear as a single line in the photo unless you 
press Enter where you want to create a new line. In this box you can 
select other options, but you won’t see the effects of options until you 
click OK to close the Text Tool box.

3. Select the typeface you want from the Font list.

4. Click the Color swatch to select a color for the text. Click OK when 
you’re done.

5. Click the Alignment button that looks like the kind of text alignment 
you want. The bottom three options align each line vertically instead of 
horizontally.



10-14 Exploring Advanced Features

6. Click OK after you set the options you want. After clicking OK, you can 
drag the text to any position within the photo.

The text appears on the photo surrounded by a box with small black 
squares (called handles) on each side and corner. You can use the handles 
to resize text.

7. Drag any corner handle of the text box. To resize only the horizontal or 
vertical dimension of the text, drag any top or side handle (not a corner 
handle).

To change text that already exists in a photo:

■ Double-click the text, make changes, and then click OK.

Exploring Advanced Features
As you gain experience with photo editing, you can go beyond the built-
in guided activities. PhotoDeluxe has advanced features that enhance a 
guided activity when you want to do something completely original or 
when you are experienced with other software programs. The quickest 
way to turn on Advanced features is to click the Advanced button. The 
Advanced features consist of tabs of effects you can apply without 
following steps and additional options to the menu bar.
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A. The Advanced button presents PhotoDeluxe features without guided 
activities so you can use them in any order. Clicking the Advanced button 
also displays long menus. B. To keep long menus on when the Advanced 
button is not selected, choose the Long Menus from the Preferences menu 
on the File menu. C. Normally, you can open only one photo window at a 
time. To use more than one photo window, choose the Allow Multiple 
Document Windows from the Preferences menu on the File menu. D. The 
online Help button in the photo window is available in both guided activities 
and in Advanced mode.

Marking Areas with Selection Tools

With PhotoDeluxe, you can apply changes to the entire photo or only 
part of it. When you want to change just a part of a photo, you must first 
tell PhotoDeluxe which area to change. When you use a selection, your 
next action changes only the part of the photo inside the selected area.

When you select an area, its border flashes to let you know that the line 
you see is only a marker and not an actual line on the photo. In step-by-
step activities in which selection is necessary, PhotoDeluxe presents the 
appropriate tool to you at the step where you need it. If you prefer to 
choose from all selection tools available in PhotoDeluxe, use the 
Selections palette which can be accessed under the View menu.
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NOTE: The view menu will only appear when long menus are activated. To 
activate long menus select File, Preferences, Long Menus.
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Chapter 11:
Corel Print House Magic™

Corel Print House™   is back, and it's better than ever! Welcome to Corel 
Print House Magic™, a powerful suite of applications designed to help 
you create exciting printing projects in no time at all. Whether it's for 
business or home, Corel Print House Magic has everything you need to 
create cards, stationery, banners, and more. In addition, Corel Print 
House Magic is so easy to use; you'll be making professional-looking 
projects right from the start.

Corel Print House Magic includes the powerful combination of Corel 
Print House and Corel Photo House™, and a new and exciting tool to 
complete the Corel Print House team: introducing Corel Family & 
Friends™, your own personal information manager. This easy-to-use 
information and event management tool helps you track the holidays, 
birthdays, and anniversaries related to your Corel Print House projects. 
There has never been a more complete, time-saving solution to 
managing personal events, lists, and print jobs.

Corel Print House Magic makes creating colorful printing projects easier, 
faster, and more fun than ever before. Regardless of the occasion, Corel 
Print House Magic has the tools — all you need is your imagination. So 
have fun! Enjoy Corel Print House Magic!

What's in Corel Print House Magic?
Check out what's new and improved in Corel Print House Magic. 

Corel Print House™ 3

If you've used Corel Print House before, you'll notice some exciting 
changes, such as
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■ newly designed user interface, including an on-screen Color Palette

■ redesigned Notebook, for easier access to all of the Corel Print House 
features and functionality

■ Symbol tool, for drawing all sorts of shapes

■ Symbol Sprayer tool, for scattering symbols as you drag your mouse 
over the page

■ Zoom tool, for changing the project view quickly and easily

■ thousands of new sample files, and 150 new fonts

Corel Photo House™ 2

Now Corel Photo House™ has even more features to help you make your 
projects picture perfect, such as

■ expanded Photo Library, for a wider selection of photos

■ newly designed user interface, including an on-screen Color Palette

■ redesigned Notebook, for easier access to all of the Corel Photo House 
functions and features

■ Objects, a new category of photographic objects that you can add to 
your images

■ Frames, a new category of images that you can use to frame your 
photo

■ Zoom tool, for changing the project view quickly and easily

■ special effects to transform your photos in fun and interesting ways

Corel Family & Friends™

Corel Family & Friends™ is an exciting new addition to the Corel Print 
House team. This easy-to-use tool provides a handy way of tracking the 
people and events in your life. Corel Family & Friends reminds you when 
it's time to create a greeting card for a special occasion, stores addresses 
and telephone numbers, and lets you create a list of your favorite books 
or recipes — all at the same time! For more information about Corel 
Family & Friends, see the Corel Family & Friends section in this manual. 
For information about procedures, see the online Help.

What You Need To Use Corel Print House Magic

To use Corel Print House Magic, your computer must have the following 
as minimum system requirements: 486 DX cpu, a CD-ROM drive, and an 
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SVGA monitor with 800x600 resolution. You must also have 45–65 
megabytes of free disk space and 8 megabytes RAM (for Windows 95) or 
12 megabytes RAM (for Windows NT).

Corel Print House 3
Corel Print House 3 makes any printing job fun and easy to do. Greeting 
cards, banners, letterhead, stationery, calendars, and envelopes are only 
some of the projects you can create. In addition, Corel Print House Magic 
now includes two powerful tools to help you with your projects: Corel 
Photo House 2 and Corel Family & Friends. Corel Photo House offers a 
fun, yet powerful way to edit photos and other bitmaps. Corel Family & 
Friends, the newest addition to the Corel Print House team, can help you 
organize and manage all your Corel Print House project information. 
There are so many uses for Corel Print House, the possibilities are 
endless!

Corel Print House is powerful, yet easy to use — even for beginners. You 
can use the Notebook's Guided Activities page to walk you through each 
project step by step and view hundreds of sample projects. Customizing 
your work is made easy with the colors, shadows, and clipart available in 
the Notebook. More experienced users may want to use the drawing and 
editing tools to create designs from scratch or edit clipart and photos.

Whatever you need to print, you can use Corel Print House to make it 
easier, faster, and more creative than ever before. Get ready to experience 
the magic of Corel Print House!

To start Corel Print House

1. Do one of the following:

■ If you created a shortcut to Corel Print House on your desktop, 
double-click the shortcut. 

■ In Windows 95 or Windows NT 4.0, click Start, Programs, HP CD-
Writer Plus, Corel Print House Magic, Corel Print House 3.

2. In the Notebook, click the method you want to use to design your 
project.

■ Start with a sample for the fastest results. The Sample wizard lets you 
choose from a variety of project types, each with sample projects 
based on different themes and occasions. 
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■ Start from scratch to build your project from the ground up. The 
Scratch wizard lets you choose from various blank paper layouts. 
Then, it's up to you to add text, clipart, and other graphics.

■ Choose the Open Existing option to access any project you have 
saved previously. To open your project, type the name of the file or 
choose it from the list.

■ Choose the Open Last option to access the project you saved the last 
time you used Corel Print House. This option is not available the first 
time you run Corel Print House.

The Corel Print House 3 Desktop

The desktop is what you see on your screen when you start Corel Print 
House 3. The following picture shows the desktop and identifies 
important items you may use to create your projects. 

When you start Corel Print House, the Property Bar shown above is not 
displayed. To view it, click View, Property Bar. A check mark beside the 
command name indicates that the Property Bar will display on your 
screen.
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The Notebook

The Notebook is located on the left side of the Corel Print House desktop. 
Use the Notebook to

■ access the catalog of Corel Print House resources, including clipart, 
backdrops, borders, phrases, and photos

■ get assistance with tasks such as adding graphics, editing text, and 
saving and printing projects 

■ add color, line, shadow, text, and wrappers to your project

The Notebook is made up of three main pages, each providing access to 
other pages that contain more options. To open a specific page, click its 
tab.

The Toolbox

The Toolbox holds all the tools you need to create and edit designs.  
There are tools to create  shapes, freehand objects, symbols, text, and 
tables. They're easy to use — just click a tool to select it. Once you select a 
tool, instructions for using it appear on the Guides page of the Notebook.

The Style Bar

The Style Bar provides easy access to the coloring, line, shadow, and text 
styles. Simply click the button for the style type you want to apply. The 
Notebook automatically displays the corresponding style page.

From each style page, you can choose from a selection of preset styles or 
click the Custom button to create your own style.

The Property Bar

The Property Bar displays the properties of a selected text or shape object. 
Properties are attributes such as size, rotation, and position. To change an 
object's properties, select the object with the Pick tool, then click the 
button on the Property Bar that corresponds to the attribute you want to 
change. As you switch from one object to another, the Property Bar 
automatically changes to display the available properties for the selected 
object.

The Color Palette

Located on the right side of your screen, the Color Palette displays a wide 
selection of colors that you can quickly apply to selected text or objects. 
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By default, the Color Palette automatically appears when you launch 
Corel Print House. You can hide the Color Palette by clicking View, Color 
Palette. The check mark beside the command name disappears when the 
Color Palette is hidden.

The rulers

Rulers measure the size of the page and tell you the exact location of your 
cursor. You can use rulers to help you resize or draw objects to specific 
dimensions or to move objects to a precise location on the page. By 
default, rulers automatically appear when you launch Corel Print House. 
To hide the rulers, click View, Rulers. The check mark beside the 
command name disappears when the rulers are hidden.

Corel Print House 3 Projects

The projects that you can create using Corel Print House 3 are divided 
into the following 11 categories:

■ Greeting Cards

■ Special Projects

■ Banners

■ Stationery

■ Signs

■ Labels

■ Kid Stuff

■ Envelopes

■ Certificates and Awards

■ Menus

■ Calendars

Each category has many different samples to choose from. You can 
browse through the samples by clicking From Sample on the New 
Project page of the Notebook.
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Corel Photo House 2
Welcome to Corel Photo House 2, a photo-editing and bitmap-creation 
program you can use with Corel Print House 3 and other applications. 
Corel Photo House makes it easy for you to touch up photographs, add 
fun special effects to them, or create your own bitmap images using the 
painting tools. With Corel Photo House, you'll find that taking the 
picture is just the beginning — making it better is half the fun!

Corel Photo House provides powerful photo-editing and painting tools 
but is easy enough for beginners to use. When you need assistance, the 
Notebook helps you apply effects, choose a paint brush, and access the 
Corel Print House photo collection quickly and easily. For more 
flexibility, you can preview special effects before applying them to your 
photos and experiment to get the look you want. If you're planning on 
painting, you'll find that the paint tools come with a large selection of 
brush shapes and sizes to satisfy your creative needs.

Whether you're creating new images or bringing new life to old ones, 
your photos and paintings will look their best with Corel Photo House.

To Start Corel Photo House

■ If you created a shortcut to Corel Photo House on your desktop, 
double-click the shortcut. 

■ In Windows 95 or Windows NT 4.0, click Start, Programs, HP CD-
Writer Plus, Corel Print House Magic, Corel Photo House 2.

Beginning your work

There are several ways to setup an image for editing or enhancement in 
Corel Photo House. You can

■ create a blank image and either paint an image or create a montage 
with parts of other images

■ use an existing image file. Corel Photo House allows you to open 
several file formats.

■ access your scanning software from Corel Photo House and create an 
image file from a photograph or drawing
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Setting up the page

When you create a blank image, you set the image size and resolution 
and choose the paper color. The image's size and resolution are 
particularly important because they affect both the size of the file and the 
quality of your printed image. If you're not sure of the difference between 
image size and resolution,  see “Image size and resolution” in the online 
help.

The Corel Photo House 2 Desktop

The desktop is what you see on your screen when you use Corel Photo 
House 2. The picture below shows the desktop and identifies important 
items you use to create and edit photos. 

If you prefer more space on your desktop, you can hide the Color Palette 
and toolbar shown above. To hide them, click View, Color Palette or 
View, Toolbar. A check mark next to each command name indicates that 
the item will display on your screen.

The Toolbox

The Toolbox holds tools you can use to create and edit bitmaps. They're 
easy to use — just click a tool to select it. Once you select a tool, 
instructions for using it appear on the Guides page of the Notebook.
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The Notebook

The Notebook is located on the left side of the Corel Photo House 
desktop. Use the Notebook to

■ get assistance with tasks such as using the painting and selection tools 

■ choose brushes, colors, and effects

■ access the photos available on the Corel CD (non-U.S. users should 
use the CD containing the appropriate language)

The Notebook is made up of three pages, each with different 
information. To open a specific page, click its tab. 

The Color Palette

Located on the right side of your screen, the Color Palette displays a wide 
selection of colors that you can quickly apply to selected text or objects. 
By default, the Color Palette automatically appears when you launch 
Corel Photo House. You can hide the Color Palette by clicking View, 
Color Palette. The check mark beside the command name disappears 
when the Color Palette is hidden.

Corel Photo House 2 Effects 

Effects can help you take ordinary images and change them in 
extraordinary ways. You can turn poor-quality images into professional-
quality photographs using the Touch-Up effects, or you can bring new 
life to old photos using the Special effects.

Experimentation is the key to unlocking the power of Corel Photo House 
2. Try several different effects before applying them to your image. Some 
of the more powerful effects take a little getting used to. The best way to 
master the subtleties of these effects is to see how different settings affect 
your image. The results are well worth the effort.

Touch-Up effects

The Touch-Up effects are ideal for repairing or enhancing the appearance 
of photographic images. For example, the Brightness/Contrast effect lets 
you control the balance of colors in highlights and shadow — try using it 
on your overexposed or underexposed photographs. The Sharpen effect 
can be used to bring out indistinct detail in older photographs, and the 
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Dust And Scratches effect can be used to improve damaged areas of 
images.

Special effects

Special effects let you transform your photos in fun and interesting ways. 
They can change image colors and textures, create three-dimensional 
effects, and distort image appearances. It's easy to combine effects to 
create different results.

Plug-In effects

Corel Photo House lets you install additional image effects created by 
other manufacturers. Plug-In effects work in the same way as the Touch-
Up and Special effects. You can access them from the Effects page of the 
Notebook and from the Image menu.

Corel Family & Friends
Corel Family & Friends provides a handy way of keeping track of the 
people and events in your life. Whether you want to schedule activities, 
maintain address and personal information on family and friends, or 
create lists, Corel Family & Friends can help you. Corel Family & Friends 
includes three components — the Calendar, the Address Book, and the 
List Book. It also includes Corel Reminders, which automatically opens 
when you start your computer and displays the day's events. 

Use the power and flexibility of Corel Family & Friends to

■ track upcoming events, including holidays, birthdays, and 
anniversaries

■ store addresses, phone numbers, etc., and merge them with your 
Corel Print House projects

■ create lists of team members, favorite CDs, gourmet recipes, and more

You can start Corel Family & Friends from Corel Print House 3 by clicking 
Tools, Launch Family & Friends. You can also launch Corel Print House 
from Corel Family & Friends by clicking the Corel Print House button 
on the Corel Family & Friends desktop.
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The Calendar helps you schedule events and displays them in the 
familiar format of a paper calendar. However, it lets you add even more 
detail than a paper calendar. The Details window lets you display 
messages about each event you schedule and shows you how often the 
event repeats. The Calendar also includes a Reminder option to remind 
you about each event in advance.

The Address Book lets you keep detailed information about your family 
and friends close at hand. You can record each person's address, birthday, 
and anniversary. You can also record the holidays you spend together, 
special notes regarding that person, and lists of items, such as hobbies, 
relating to that person.

The List Book helps you organize information and keep it accessible. You 
can create lists of personal items, such as your CD collection, or you can 
link your list to the Address Book. When you create a linked list, you gain 
instant access to all of the records and information in your Address Book. 
You can add any of these records to your list. When you do, all the 
information about the individual or family that you entered in the 
Address Book automatically becomes part of the List Book record. You 
don't have to retype a thing!
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Chapter 12:
Photo Organizer

Welcome to Photo Organizer—the best way to create electronic photo 
albums, catalog all their photos for easy retrieval, create Internet web 
pages, and launch popular “digital darkroom” photo-editing programs. 
The Photo Organizer is installed automatically with the CD-ROM 
software.

Getting Started
This section explains how to start the Photo Organizer and load your first 
set of photos to the Media Library.

Starting the Photo Organizer

To start Photo Organizer:

1. Choose Start, Programs, Photo Organizer, Photo Organizer 1.1.

2. The first time you load the program, a screen introduces the Photo 
Organizer Wizard, which leads you through the process of adding digital 
photographs to the media library. Click Next to continue using the 
Wizard, or click Cancel if you prefer not to use the Wizard. If you do not 
want to see this page every time you load the program, mark the 
checkbox beside Don’t show me this page again.
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Adding Photos to the Media Library

Photo Organizer can import picture files from any drive that can be 
accessed by your computer: hard drives, floppy drives, CD-ROM drives, 
and network drives. It can also import pictures directly from a scanner.

To add photos to the Media Library:

1. Click the Get tab and click an icon representing the import source: Files 
(on a hard drive), Compact Disc, Floppy, PhotoMail or Scanner. You 
can also choose File, Import Files or Action, Get from the main menu.

2. A series of questions guides you through the import process for each 
source.

3. The final screen in the import process selects the destination for the 
imported pictures. The pictures can be placed on the Light Table, which 
is a temporary work space for organizing and editing pictures, or in an 
album. You may choose an existing album or create a new album.

Viewing Pictures

Pictures can be viewed on four different tabs: Gallery, Presenter, 
Catalog, and Details. The different views can be accessed by clicking a 
tab name at the bottom of the Viewer pane or by choosing View from 
the main menu.

■ Gallery is the default view. Pictures are displayed as thumbnails.

■ Presenter displays enlarged pictures, one at a time. Thumbnails of all 
pictures are displayed in a film strip. Display, rotation, and notes are 
controlled using the buttons at the bottom of the window.

■ Catalog displays a thumbnail of each picture, along with the picture's 
title, author, date created, comments, keywords and classifications. 
Every field, except the file path, can be edited directly on the screen.

■ Details displays information in a table format, with no thumbnails. 
Each picture has a row of information.



Getting Started 12-3

C
h

ap
ter 12:  Ph

o
to

 
O

rg
an

izer

Rearranging Pictures on the Gallery Tab

To rearrange the order of pictures on the Gallery tab:

■ Click the left mouse while dragging a picture to its new location. To 
place a picture in front of another picture, position the mouse pointer 
on the left side of the picture.

■ To place the picture after another picture, position the mouse pointer 
on the right side of the picture.

Viewing a Slideshow

To view your pictures in a slideshow format, choose View, Slideshow 
from the main menu.

Each picture is displayed for a few seconds. Use the control buttons to 
pause the slideshow, view individual pictures, and control the slideshow 
properties.

Pause the slideshow. Visible only when slideshow is playing.

Play the slideshow. Visible only when slideshow is paused.

Display next picture.

Display previous picture.

Display first picture.

Display last picture.

Access slideshow properties.

To return to Photo Organizer, click the Stop button.
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Creating Albums

Albums are collections of pictures. You can group pictures into albums by 
subject, event, or any other criteria that you choose. Pictures can be 
added to an album by scanning or importing, or by copying or moving 
pictures from the Light Table or from other albums.

To create an album:

1. Select the pictures on the Light Table.

2. Click Album on the Create tab.

3. Enter a name for the new album.

4. Specify whether the pictures should be moved or copied to the new 
album.

5. Click OK.

Creating E-Mail

Pictures from the Light Table, an album, the Trash, or Search Results can 
be used to create e-mail messages.

1. Select the pictures on the Viewer pane.

2. On the Create tab, click the E-mail icon.

3. A series of questions will guide you through the process of sending an e-
mail.

4. Address your mail message using the postcard template that is provided. 
You can manually type the e-mail addresses of each recipient or use the 
address book. Type a subject and the text of your message in the spaces 
provided.

5. When you are ready to send the mail message, click the Send button.
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Cataloging Pictures

Pictures can be cataloged for later retrieval using the Search tool. 
Keywords and classifications are used to catalog pictures.

Keywords are words or phrases that you create to identify pictures. 
Keywords that are common to a group of pictures can be entered during 
the import process. Keywords for individual pictures can be viewed and 
edited on a picture’s Catalog Properties sheet.

1. Classifications are pre-existing labels that are used to identify people, 
places, events, and things. The classification hierarchy provided by Photo 
Organizer should be sufficient to label most of your pictures. However, 
you can add new classifications if necessary.

Classifications are assigned using a picture’s Classification Properties 
sheet.

Assigning Keywords

To assign keywords:

1. Select a picture by clicking it.

2. Click the Properties button in the bottom right corner of the screen or 
right-click the picture and choose Properties from the Image menu.

3. Click the Catalog tab.

4. Enter the keywords in the Keywords field. Separate each keyword with a 
comma.

Assigning Classifications

To assign classifications:

1. Select a picture by clicking it.

2. Click the Properties button in the bottom right corner of the screen or 
right-click the picture and choose Properties from the menu.

3. Click the Classification tab.
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4.  Click the major classification that applies to the picture.

5. Expand the major classification by clicking the plus sign (+) beside it.

6. Choose the sub-classification that applies to the picture.

7. Click the Add button to assign the selected classification to the picture.

8. Repeat this process for each desired classification.

9. Click OK.

Searching for Pictures

You can search for pictures across albums, on the Light Table and in the 
Trash, using keywords, classifications, picture filenames, and other 
properties, including the author’s name, comments, source, and dates 
that pictures were taken.

A search can be performed using a free-form text entry or by searching 
lists of existing keywords and classifications.

The results of a search are displayed on the Viewer pane.

Entering Search Terms

To enter search terms:

1. Click the Search button or the Search Results icon on the Browser pane.

2. Enter your search term(s) in the Look For field and press ENTER. You can 
enter search terms found in the following fields on the picture's property 
sheets: Picture title, author, date picture was taken, source, keywords, 
comments, and classifications.

3. All pictures that match your search term are displayed on the Viewer 
pane.
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Performing Keyword Searches

To search for pictures using the list of existing keywords:

1. Switch to the Tree Browser by clicking the Tree Browser button.

2. Open the Keywords listing by clicking the plus sign (+) beside Keywords. 
All the keywords that have been assigned to pictures are listed in 
alphabetical order.

3. Highlight a keyword. All the pictures that have been assigned that 
keyword are displayed on the Viewer pane.

Performing Classification List Searches

To search for pictures using the Classifications List:

1. Switch to the Tree Browser by clicking the Tree Browser button.

2. Open the Classifications listing by clicking the plus sign (+) beside 
Classifications. The first level of classifications is displayed.

3. To open a level, click the plus sign beside it. All sublevels are then 
displayed, including all new classifications that you defined when 
assigning classifications to pictures.

4. As you highlight each classification, the matching pictures displayed on 
the Viewer pane will vary, depending on whether the Show All checkbox 
is marked.

Changing Pictures

Options on the Change tab enable you to alter the appearance of a 
picture.

Save As—Enables you to save images using different file formats. You can 
replace the original image with the new format or save the image as a 
new file.

Resize Image—Specify a new height and width for the selected picture. If 
the checkbox beside Keep Aspect Ratio of Images is marked, you need to 
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specify only one of the dimensions; the program automatically changes 
the other.

Crop Image—To crop a picture, press the left mouse button and outline 
the cropped area. To resize the image so that it fills the entire area before 
cropping, click the Scale Image button.

Rotate Image—To rotate an image, click the appropriate button (90 
Degrees Clockwise or Counter-clockwise) or enter the degrees in the field 
provided. To reset the image to its original rotation, click the Reset 
button.

Change Lighting—To brighten or darken a picture, use the Brightness 
slide bar. Use the Contrast slidebar to adjust the contrast. More contrast 
widens the range of luminance in the picture. Less contrast narrows the 
range of luminance.

View the effects on the preview screen. Click the Automatic Adjustment 
button to reset the brightness and contrast to the default values.

Change Focus—To accentuate edges and contrasts in a picture, increase 
the focus by sliding the bar toward Sharpen. To smooth edges and 
minimize contrasts, slide the bar toward Blur. View the effects on the 
preview screen.

Add Mosaic—The mosaic effect groups pixels using tiles. Specify the tile 
size by sliding the bar toward Smaller or Larger. View the effects on the 
preview screen.

Add Embossing—Raises the background of a picture by suppressing 
color and outlining the edges in black. Specify the degree of embossing 
by sliding the Depth bar toward In or Out. View the effects on the 
preview screen. To specify the directional gradient of the embossed edges, 
use the mouse to spin the needle on the Direction meter.

Correcting Color and Exposure—When you click the Auto Correct 
Color button, the color correction is applied automatically, using pre-
defined settings. To fine-tune the colors afterwards, you can increase or 
decrease the level of each color. Change the red, green, or blue values by 
sliding the pointer beside one of the colors to the right or to the left. The 
results are displayed in the sample picture shown on the right side of the 
dialog.

To automatically correct the exposure, click the Auto Correct Exposure 
button. The results are displayed in the sample picture shown on the 
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right side of the dialog. To cancel the color and/or exposure corrections 
and restore the original settings, click the Reset button.

To scale a picture to fill the white drawing space, click the Scale Picture 
button. Note that this does not apply to the Save As or Resize command.

Sending Pictures to Other Imaging Programs

Pictures from Photo Organizer can be opened in other image editing 
programs. The first time you click the Send tab, only the Setup icon is 
displayed. Click the Setup icon to have the program automatically search 
your hard drive for imaging programs. Afterwards, the icons for these 
programs will be displayed on the Send tab.

Use any of the following methods to send pictures to another 
program:

■ Drag the picture to a program icon on the Send tab.

■ Select one or more pictures and then click the program icon on the 
Send tab.

■ Select one or more pictures and then right-click a picture and choose 
Send To on the Image menu.

Printing Pictures

Pictures can be printed individually, one per page, or as combined 
thumbnails on an index print. Pictures can be printed from the Light 
Table, albums, Search Results or Trash.

To print pictures individually, one per page:

1. Select one or more pictures.

2. Choose File, Print Photograph from the main menu. You can also right-
click any selected image and choose Print from the menu.

To produce an index print:

1. Select multiple pictures.

2. Click the Index Print icon on the Create tab or choose File, Index Print 
from the main menu.



13-1

p
p

Live Q
uick-Start Tu

to
rial

Chapter 13:
PaperMaster Live 
Quick-Start Tutorial

This tutorial is designed to get you up and running quickly with 
PaperMaster Live. You’ll learn the basics and find out that PaperMaster 
Live is fun and easy to use! Once you’ve completed this tutorial, you’ll be 
familiar with:

■ Searching for a document 

■ Viewing and customizing documents

■ Faxing, e-mailing and printing your documents

■ Creating a new cabinet

■ Copying/Moving items into your new cabinet

■ Creating customized drawers and folders

■ Filing a document into PaperMaster Live

■ Publishing, sharing and archiving a cabinet to CD

■ Closing cabinets and exiting PaperMaster Live

■ Viewing a cabinet stored on CD

Remember, this tutorial only goes over the basics. Read carefully through 
the on-line help to discover even more ways PaperMaster Live can help 
you get organized and save time.
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Searching for a Document
One of the main features that makes PaperMaster Live such an effective 
organizing tool is its AutoSearch capability. With AutoSearch, you can 
locate documents in your cabinet quickly and easily without having to 
remember where they were filed. Search by drawer, folder or document 
title, annotations, or document content, and AutoSearch will present 
matches ordered by rank and based on the frequency of the keywords 
you’ve selected. When you “Read & Index” a document, PaperMaster 
Live reads the text in a document, and creates an index (much like the 
index in the back of this manual). When you’re searching for a particular 
document, PaperMaster Live looks through this index for keyword 
matches in the text. To learn more about reading a document, see Help.

1. Launch PaperMaster Live.

2. Choose AutoSearch... in the cabinet window’s Tools menu. This brings 
up the AutoSearch dialog box.

3. Type the words “Reg” and “card ” in the “Words to Look For” field. 
AutoSearch is not case-sensitive, so you can type any combination of 
lower and upper case letters.

4. Click on “Entire Cabinet” in the Where to Search box if it’s not already 
selected.
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5. Click on “Documents” in the Search For box if it’s not already selected.

6. Click “Search.” Matching documents are then displayed by Rank 
(frequency of keywords). The number of document found (under “Items 
Found”), and the number of documents searched (under “Items 
Searched”) are also displayed.

Viewing and Customizing Your Documents
There are several tools in PaperMaster Live that you can use to customize 
your documents. We’ll go over some of them in this tutorial.

Opening and Viewing a Document

Opening a document in PaperMaster Live is very easy. Here is a quick 
demonstration of how to open the registration card in the Document 
Viewer. From there, you’ll move on to cropping the document, filling out 
the registration card using Type Text annotations, faxing it to 
DocuMagix, and then printing a copy for your own use.

1. Double click on the document you wish to open from the Search 
window or select it and click on the “Open Document” button.

If you know where the document is, you can skip the search. Double-click on the 
“Open Me First!” drawer. Double-click on the “DocuMagix Information” folder. 
Double-click on the document entitled “DocuMagix Registration Card.”

Cropping Your Document

This is a very useful feature, especially when you have smaller documents 
you want to keep track of, such as business cards or the registration card.

1. Choose AutoCrop from the Image menu. This automatically removes 
any excess white space around the document.

PaperMaster Live also offers a manual crop tool should you wish to crop a 
specific portion of your document. This is particularly useful when for saving a 
single newspaper article without the need to cut the paper.

Creating Annotations

There are different ways to annotate a document in PaperMaster Live. 
One is the “Sticky Note” method, which hides the annotation under a 
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sticky note icon, and another is through the “Type Text” tool, which 
allows you to type directly onto the document. 

“Sticky Note” Annotation 

Use this type of annotation to make notes to yourself about the 
documents you’ve filed. 

1. Choose Sticky Note from the Tools menu.

2. Click anywhere on the registration card to add a “Sticky Note” 
annotation. In the title field of the “Sticky Note” dialog box, type in the 
action taken (i.e. faxed) and today’s date. In the message section, type in 
details of the action (i.e. the fax number and address of where the 
registration card was sent). You can change the Sticky Note to the color of 
your choice by selecting the Color button in the dialog box. Click OK.

If you adopt personal conventions in your sticky notes, such as “To Do:” and 
“Payment due:” you can later search on all outstanding items by specifying 
these keywords in your search.

Type Text Tool 

1. Choose Type Text from the Tools menu.

This brings up the Type Text dialog box, where you can choose the 
properties of the text, including font, point size, style (Bold, Italic, or 
Underline), text color, and background color. 

Use the background color (opaque or transparent) to help block out items behind 
the text or to allow them to overlap such as lines on a form.
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2. Position the mouse where you’d like to have text, click the left mouse 
button once, and begin filling out the DocuMagix registration card. To 
delete a text annotation, just point and click on the box around it, go 
into the Edit menu, and choose Delete Annotation. You can also click 
on the right mouse button to display a pop-up menu with annotation 
options.

To edit the annotation, click inside the box and make your text changes. To 
move it, click on the outside border of the box and drag it to its new location. 
You can also resize the text by dragging on any corner.

Faxing and Printing Your Documents
Once your fax hardware and software are installed, faxing from 
PaperMaster Live is easy. If you have a printer installed, you can print 
documents just as easily. Here we’ll demonstrate these functions by 
helping you fax the registration card directly to DocuMagix, and print 
out a hard copy to mail. See online Help to learn how to set fax/modem 
preferences.

Both Fax and Print options can be invoked from the document viewer (as we 
will demonstrate) or from the folder window (no need to open the document 
first).

Faxing

1. Choose Fax under the File menu. This Fax dialog box lets you set the 
range, scaling options, quality, number of copies, collation, and whether 
to fax annotations. 

The Print Annotations, Type Text box needs to be selected to fax your filled-in 
Registration Card.

2. Click “OK” on the fax dialog screen. (PaperMaster Live will now invoke 
your own installed fax software).

3. Fill in the fax information, and click “Send.” This step may vary 
according to your fax software. Fax your registration card to DocuMagix 
at (800) 362-8621 or outside North America at (408) 434-0915.
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Printing

1. Choose Print under the File menu. This Print dialog box lets you set the 
print range, scaling options, print quality, number of copies, collation, and 
whether to print annotations. If everything is correct, click OK.

The Print Annotations, Type Text box needs to be selected to print your filled-in 
Registration Card.

Creating a New Cabinet and Copying 
Information

PaperMaster Live allows you to create an unlimited number of cabinets, 
so you can back up information easily. For example, if you’d like to have 
a cabinet for your office business and another for your home business.

Creating a New Cabinet

1. Choose Cabinet>New Cabinet... under the Cabinet Window’s File 
menu.

2. In the New Cabinet dialog box that pops up, name the cabinet 
“Backup Cabinet ” and select the location of the cabinet.

If you have a CD-RW, you can select this drive as the location for your new 
cabinet. If you have a CD-R drive, you should select a different location for the 
new cabinet (see the “Publishing, sharing and archiving cabinets to CD” 
section for information on how to store this cabinet to CD after it has been 
created).

You can share cabinets with multiple users over a network drive by setting the 
Read-Only cabinet attribute. See online Help for more information.

Copying/Moving items into Your New Cabinet

The steps for copying and moving any items in your cabinet are the same 
whether the item be a drawer or a page. The important thing to 
remember is that the hierarchy must be maintained. Therefore a drawer 
can only be moved or copied into a cabinet and a page can only be 
moved or copied into a document. Likewise, items can be moved and 
copied between cabinets as easily as within the same cabinet.
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1. Using the right mouse key, drag the Open Me First! drawer from the old 
cabinet into an empty slot in the “Backup Cabinet” cabinet. When the 
Move/Copy menu pops up, select Copy.

As a default, dragging and dropping containers between two cabinets using the 
left mouse button will perform a Copy command. Dragging and dropping 
containers between the same cabinet using the left mouse button will perform a 
Move command. The right mouse button will always give you the pop up menu 
and allow you to make a selection.

Creating Customized Drawers and Folders
With PaperMaster Live, you have cabinets, drawers, and folders, just like 
you do with a real file cabinet. It’s easy to customize them for your needs.
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Creating a New Drawer

1. Create a drawer by choosing New Drawer from the cabinet window’s 
File menu. This brings up the New Drawer dialog box.

2. Replace the default name “Drawer #1” in the name field with 
“DocuMagix”.

3. Choose the color blue from the pull-down Text Color menu.

4. Choose a drawer icon by selecting the Choose Icon button. From the 
list of Standard icons double-click on your choice.

You will now see your new drawer in the cabinet window. You can 
change the drawer’s location by dragging and dropping the drawer to 
another empty location.

Creating a New Folder

Open the “DocuMagix” drawer by double-clicking on it. 

1. Create a folder by choosing the New Folder command from the drawer 
window’s File menu. As with the New Drawer command, this brings 
up a dialog box that allows you to choose the folder’s properties. Just as 
you did with the new drawer, type in a folder name (for the purposes of 
this tutorial, type in “PaperMaster Live”), select a color from the pull-
down menu, and click OK.

You’ll now see the new folder displayed in your “DocuMagix” drawer.
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Filing a Document into PaperMaster Live
There are several ways of filing documents into PaperMaster Live, 
including scanning, downloading from the Web, importing, and filing 
from any Windows application (including fax software, word processors 
and e-mail). We’ll go over the scanning method in this tutorial. For 
details on the other ways of filing into PaperMaster Live, see the 
Reference section of this manual.

PaperMaster Live allows you to put papers into your filing cabinet using 
any TWAIN or ISIS compliant scanner.

1. Choose any paper (for example, the registration card) that you would like 
to file in your DocuMagix filing cabinet.

2. Open the folder where you’d like to file the scanned document.

3. Scan in the registration card by placing it in your scanner, and choosing 
New Document>Scan from the File menu. This activates the scanner, 
and brings the scanned image of the registration card into the document 
viewer.

4. If this is the first time you’re scanning a document, the Select Source 
dialog box for your scanner will pop up. Select the scanner you’re using 
from the list, and click “OK”.

Steps for scanning may vary by scanner and driver used. Refer to your scanner 
documentation for detailed instructions.

Starting a scan from a folder window, files the document into that folder 
automatically. Starting a scan in the cabinet window files the document 
in the Inbox. Drag and drop to file the document in another drawer.

5. Name the document by typing “Registration Card” into the Name field 
of the Document Viewer. The name is displayed in the title bar. If you 
don’t choose a name, PaperMaster Live will assign a default name 
consisting of the date and time the document was filed.
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Publishing, Sharing and Archiving 
Cabinets to CD

If you have a CD-R or CD-RW, you have the tool necessary to take a large 
cabinet with all of your custom documents just about anywhere. Because 
CD’s are very light and compact while providing a large medium for 
storage, they are the ideal mechanism for storing and sharing 
information.

1. Create your custom file cabinet and fill it with the documents you want 
with any necessary annotations. 

It is important to verify the information before placing it on a CD because once 
there, the information will be read-only and cannot be altered in any way. You 
will not be able to add or delete documents, rename any of the contents, crop or 
annotate any of the pages. 

2. Select the Publish Cabinet icon from the toolbar in the cabinet window.

3. A dialog will appear asking you to select the location of the new cabinet 
as well as the cabinet name. 

4. You will also be given the option to include a cabinet viewer with the 
published CD. (This is particularly useful if you are going to be sharing 
the information with someone who may not own PaperMaster Live.)

5. Click on the Publish button.

Closing a Cabinet
1. Choose Close Cabinet from the cabinet window’s File menu.

This closes the cabinet including all of its drawers, folders and 
documents. If this is the only open cabinet, this operation will exit 
PaperMaster Live.
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Viewing a Cabinet Given to you on CD
If you own PaperMaster Live, you can view a cabinet on a CD simply by 
selecting Open Cabinet from your local cabinet and opening the one on 
the CD. The cabinet on the CD will function similar to the cabinet on 
your local drive except it will be read-only.

If you do not own a copy of PaperMaster Live, you can use the special 
PaperMaster Live Viewer which was published on the CD with the 
cabinet. This viewer will allow you to open any PaperMaster file cabinet 
(not just the one on the CD) and give you full PaperMaster Live 
functionality without any of the editing tools. This is a great opportunity 
for you to try PaperMaster Live and see for yourself how powerful yet 
easy it is to use.

Congratulations! 
You’ve successfully completed the PaperMaster Live tutorial, and learned 
the basics. Wasn’t that incredibly easy? You can now customize your own 
file cabinet, scan, e-mail, fax and print your documents. You can also 
find them after they’ve been filed. 

But remember, PaperMaster Live has even more great features, so check 
them out in the online Help.

Upgrade Notification
If you are currently using PaperMaster Live 3.1, you qualify for a free 
upgrade to PaperMaster Live 98. 

To check the version of your software, launch your file cabinet and select 
Help|About... from the menu bar in the Cabinet window. 

Download your free upgrade from http://www.documagix.com/updates/
hpcdr. If you do not have access to the internet, you can request to have 
a CD sent to you for a nominal shipping and handling fee. Please contact 
DocuMagix Customer Support at the address or telephone number in the 
back of this user’s guide for more information.
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PaperMaster Live 98 allows allows you to store common Window’s 
application files in their original format directly into your file cabinet. 
This let’s you search for all of your documents (scanned paper, web pages 
and even application files) in one easy to organize file cabinet. For more 
information on the new features in PaperMaster Live 98, check the 
DocuMagix Web page at http://www.documagix.com/customer/
upgrades.
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Chapter 14:
Norton AntiVirus

This chapter explains how to use Norton AntiVirus to protect your 
computer from viruses. In general, Norton AntiVirus operation is the 
same for Windows 95, Windows NT 3.51, and Windows NT 4.0. 
Wherever there are differences, they are specifically noted.

About Norton AntiVirus
Norton AntiVirus is the most sophisticated and powerful product 
available to defend your computer from virus infection. Its automatic 
protection features continually and vigilantly safeguard your computer 
while you work. If a virus is ever found, Norton AntiVirus guides you 
through the process of eliminating it.

The Norton AntiVirus preset options balance efficiency with maximum 
protection; you do not need to change anything. Install Norton 
AntiVirus and you are immediately protected from computer viruses.

What is a virus?

A computer virus is, simply, a computer program written by an ill-
intentioned programmer. Your computer can catch a virus from disks, a 
local network or the Internet. Just as a cold virus attaches itself to a 
human host, a computer virus attaches itself to a program… and just like 
a cold, it’s contagious! 

Viruses take control of your computer without your knowledge. Often, 
they remain inactive until a predetermined trigger date (for example, 
Friday the 13th) to wreak havoc. They can cause your computer to 
behave strangely, for example, beep or display annoying messages, as 
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well as damage data, delete files, and even completely erase your hard 
disk. Macro viruses, the newest threat, infect and spread throughout 
Word and Excel documents.

Whenever an infected program is run or an infected document is opened, 
the attached virus is activated and spreads to other programs and 
documents. Viruses don’t, however, infect or damage hardware, such as 
keyboards or monitors. You may experience strange behaviors (such as 
characters appearing upside down) but your disks are not physically 
damaged, just what’s stored on them.

What Norton AntiVirus does automatically

Norton AntiVirus safeguards your computer from virus infection, no 
matter what the source. You are protected from viruses that spread from 
hard drives and floppy disks, those that travel across networks, and even 
those that are downloaded from the Internet. In short, Norton AntiVirus 
does the following:

■ Eliminates viruses and repairs virus-damaged files.

■ Makes sure your computer is safe from viruses at startup.

■ Checks for viruses every time you use software programs on your 
computer, floppy disks, and document files that you receive or create. 
(For example, the newest kind of viruses are spread via Microsoft 
Word and Excel macros.) 

■ Monitors your computer for any unusual symptoms that may 
indicate an active virus.

■ Runs a scheduled scan automatically once per week to confirm that 
your hard disks are virus-free.

■ Protects your computer from Internet-borne viruses as part of regular 
operation. No separate programs or Norton AntiVirus options 
changes are necessary. Program and document files are scanned 
automatically as they are downloaded and files within compressed 
files are scanned when they are extracted.

What you have to do

Once a month, obtain from Symantec updated information that Norton 
AntiVirus needs to keep your virus protection up-to-date. You can do this 
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online (for example, over the Internet) or by mail. See “Keeping virus 
protection current” on page 14-14.

WHY? New viruses are being written all the time. You have to regularly 
obtain files from Norton AntiVirus that contain the latest virus 
protection. If you don’t, you are not protected against viruses that have 
been released into the computer world since you bought the product.

Windows 95: Create Norton AntiVirus Rescue Disks to help recover from 
a virus emergency.

WHY? Rescue disks are an important part of your virus protection for 
Windows 95. For example, they allow you to safely restart your computer 
if it is halted due to a virus in memo. See “Windows 95: Create rescue 
disks” on page 14-7.

System requirements for installation

Using Norton AntiVirus
Every time you start your computer, Norton AntiVirus Auto-Protect lets 
you know it is working. The Auto-Protect icon in the lower-right corner 
of the taskbar on your Windows desktop reminds you that you are fully 
protected against virus infection. 

Windows 95 486 IBM or compatible PC with 8 MB of memory

 Microsoft Windows 95

 10 MB of free hard disk space

Windows NT Administrator-level privileges

 16 MB of memory (32 MB or more recommended)

 Microsoft Windows NT versions 3.51 or 4.0

 16 MB of free hard disk space
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Turning Auto-Protect off temporarily

WHY? You are sometimes told to disable your antivirus software when 
you are installing new computer programs. In this case, you disable Auto-
Protect temporarily and then turn it back on again.

To turn off Norton AntiVirus Auto-Protect temporarily:

1. Double-click the Norton AntiVirus Auto-Protect icon in the lower-
right corner of the taskbar on your Windows desktop.

Windows NT 3.51: Double-click the Auto-Protect icon on the 
desktop.

2. Click Disable. 

To turn on Norton AntiVirus Auto-Protect:

1. Double-click the Norton AntiVirus Auto-Protect icon in the lower-
right corner of the taskbar on your Windows desktop.

2. Click Enable.

What else can I do with Norton AntiVirus?

Start Norton AntiVirus

WHY? From the Norton AntiVirus main window you can initiate scans, 
change how Norton AntiVirus works, or click LiveUpdate to get the latest 
virus protection files directly from Symantec.

To open the Norton AntiVirus window:

■ On the Windows taskbar, click Start, point to Programs, point to HP 
CD-Writer Plus, point to the Norton AntiVirus group, then click 
Norton AntiVirus. 

■ Windows NT 3.51: Double-click the Norton AntiVirus icon in the 
Norton AntiVirus group.
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Register Norton AntiVirus

WHY? After registration, you are eligible for 90 days of free technical 
support, special upgrade pricing, and up-to-date product and company 
information.

To register Norton AntiVirus:

1. In the Norton AntiVirus main window, choose About Norton 
AntiVirus from the Help menu.

2. Click Register Now and follow the on-screen instructions.

Get help

WHY? The Norton AntiVirus help system has step-by-step procedures to 
help you keep your computer safe from viruses.

To get help using Norton AntiVirus, do one of the following:

■ Choose Contents from the Help menu.

■ Click the Help button on any Norton AntiVirus screen.

■ Right-click any option in a Norton AntiVirus screen and choose 
What’s This for a brief definition of the option. (Right-click help is 
not available in Windows NT 3.51.)

You’ll be able to register directly over the Internet, by a dial-up modem 
connection, or print a form to mail to Symantec.

Click to update 
your virus 
protection online

Click to view 
descriptions of 
known viruses

Choose Contents 
from the Help 
menu for all 

Click to get a 
description of 
everything you can 
do from this window

Select drives to 
scan for viruses
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Scan for viruses

WHY? We recommend you scan all floppy disks before you use them.

To scan drives for viruses:

1. Start Norton AntiVirus.
2. In the Norton AntiVirus main window, check specific drives in the 

Drives list box or select multiple drives by checking items in the 
Drive types box.

3. Click Scan Now.

To scan individual files or folders for viruses:

1. Start Norton AntiVirus.
2. From the Scan menu at the top of the Norton AntiVirus main 

window, choose Folder or File.
3. Make your choice and click Scan.

TIP: To quickly scan a drive, folder, or file, right-click an item in a My 
Computer or Windows Explorer window and choose Scan with Norton 
AntiVirus.

Schedule virus scans

WHY? A weekly scheduled scan is an additional reassurance that your 
computer is virus-free. When you installed Norton AntiVirus, a scan is 
already scheduled to run once per week automatically. 

To schedule a scan:

1. Start Norton AntiVirus.
2. In the Norton AntiVirus main window, click Scheduler.
3. Click Add.
4. Select Scan For Viruses for the Type Of Event.
5. Select Weekly for the Frequency.
6. Type /L in the What To Scan text box.

This tells Norton AntiVirus to scan all local drives. You could also 
enter specific drive letters, for example, C: D: instead.

7. Click OK to close the dialog box, then click OK again to confirm.
8. Click Exit in the upper-right corner of the Norton Scheduler dialog 

box.
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9. Windows 95: Click Minimize to close the dialog box but leave the 
Norton Scheduler running. Under Windows NT, the Scheduler service 
runs all the time.

Your computer must be turned on when the scan is due to take place.

Customize Norton AntiVirus

WHY? Norton AntiVirus is preset to provide you with complete 
protection against viruses. It is unlikely you need to change any settings. 
However, Norton AntiVirus provides options for users (for example, 
system administrators) who want to customize the way virus protection 
works.

To customize Norton AntiVirus protection:

1. Start Norton AntiVirus.
2. Click the Options button in the Norton AntiVirus main window. 
3. Click one of the tabs in the Options dialog (for example, Auto-

Protect). The dialog changes to show options for the selected feature.
4. Click Help to get information about options.
5. Make your changes and click OK to exit.

TIP: Right-click an option and choose What’s This for an explanation of the 
option.

Windows 95: Create rescue disks

WHY? Rescue Disks are an important part of your virus protection for 
Windows 95. For example, they allow you to safely restart your computer 
if it is halted due to a virus in memory. Because Windows NT operates 
differently than Windows 95, Rescue Disks are not needed for Windows 
NT. To update virus protection, see “Keeping virus protection current” on 
page 14-14.

You need three 1.4 MB floppy disks that are either new or do not contain 
any data that you want to keep and three disk labels.
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To create or update rescue disks:

1. On the Windows taskbar, click Start, point to Programs, point to HP 
CD-Writer Plus, point to the Norton AntiVirus group, then click 
Rescue Disk.

2. Follow the on-screen instructions.
3. After the rescue disks are created, store them in a safe place.

TIP: Create new rescue disks whenever you install new hardware, add or change 
an operating system, repartition your hard disk, or update your virus protection. 
Using outdated Rescue Disks could cause serious problems. 

Windows NT: Bypass boot record scans

WHY? Norton AntiVirus is preset to scan your disk’s boot records for 
viruses as part of its regular operation. As a security precaution, some NT 
systems are configured to prevent users from accessing these disk areas. 
You must have administrator-level rights to scan boot records. If you see 
a dialog box saying that you cannot access the boot records, you can set a 
configuration option to bypass boot record scans.

To bypass boot record scans for Windows NT:
1. Start Norton AntiVirus.
2. Click Options in the Norton AntiVirus main window.
3. Click the Scanner tab.
4. In the What to Scan group box, uncheck Master Boot Record and 

Boot Records.
5. Click OK to save your settings and close the dialog box.

Click to skip only the 
boot records and 
continue the scan
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What to do if a virus is found

Windows 95: If you see a virus alert
1. Look for words that identify the type of problem. 
Read the whole message.
2. Press Enter to choose the action that is preselected 
for you, or type the first letter of the action you want to 
take (for example, type R for Repair). If you need more 
information, see “Quick guide to alert actions” on the 
next page.

If your computer is halted because of an active virus in 
memory, turn off the power, insert your Norton 
AntiVirus Emergency Boot Disk in the A: drive, and 
turn the power back on. Follow the on-screen 
instructions. (See “Windows 95: Create rescue disks” on 
page 14-7.)

Windows NT: If you see a virus alert
1. As part of Auto-Protect operation, Norton AntiVirus 
for Windows NT is preset to Deny Access to an infected 
file during regular computer operation. See“Customize 
Norton AntiVirus” on page 14-7 to change how Auto-
Protect works.
2. Start Norton AntiVirus and scan your disk to 
eliminate the virus. See “Scan for viruses” on page 14-6.

Windows 95 and Windows NT:
If you see the Norton AntiVirus Repair Wizard
Click Next to have Norton AntiVirus automatically get 
rid of the virus.

Windows 95 and Windows NT:
If you see the Problems Found dialog
1. Highlight an entry in the list box.
2. Read the message at the bottom of the dialog box.
3. Click Repair when infected files are found. 

See “Quick guide to alert actions” on the next page for 
information about the other actions. 



14-10 What to do if a virus is found

NOTE: If a virus is detected during Windows 95 startup, a text 
message will be displayed. Just follow the on-screen instructions.Quick guide to 
alert actions

Actions If a Norton AntiVirus alert or Problems Found dialog box appears on your screen, use this 
table to decide what to do.

[Repair]
For a VIRUS FOUND, Repair is always the best choice. Repair eliminates the virus 
and repairs the infected item automatically. 
Type R or click Repair.

[Delete]
Erases both the virus and the infected file. The virus and file are gone forever. 
Choose Delete if Repair is not successful. Replace a deleted file from the original 
program disks or backup copy. If the virus is detected again, your backup copy or 
original disk is infected.
Type D or click Delete.

[Stop]
Stops the current operation to prevent you from using an infected file. Stop does 
not solve the problem. You’ll be alerted again the next time you do the same 
thing.
Type S or click Stop.

[Continue]
Continues the current operation. Only choose Continue if you are sure a virus is 
not at work. You’ll be alerted again. If you’re not sure what to do, it’s safer to 
choose Stop.
Type C or click Continue.

[Exclude]
If you choose Exclude and a virus is at work, the virus won’t be caught. Exclude 
should be used only by system administrators for system tuning.
Type E or click Exclude.

[Inoculate]
Windows 95 Only (Inoculation is not part of Windows NT protection)
For an UNINOCULATED ITEM, Inoculate stores information about an item in a 
special file that is later used to ensure your system stays virus-free. Type C or 
click Inoculate.
For an INOCULATION CHANGE, Inoculate updates the stored inoculation data 
for a boot record or file that has changed since it was last inoculated. 
Inoculation changes fall into two categories:
Expected: If you’ve just updated a program, the boot records and system files 
may change. In this case, type C or click Inoculate.
Unexpected: Changes to boot records and system files are usually caused by 
viruses. If you have not recently upgraded a program, Type R or click Repair.



What to do if Norton AntiVirus can’t repair 14-11

C
h

ap
ter 14:  N

o
rto

n
 

A
n

tiV
irus

What to do if Norton AntiVirus can’t repair
WHY? One of the most common reasons Norton AntiVirus can’t repair a 
file is that you don’t have the most up-to-date virus protection files. Click 
LiveUpdate in the Norton AntiVirus main window to obtain the latest 
files via modem or Internet.

If an item can’t be repaired

Update your virus protection and scan again. See “Keeping virus 
protection current” on page 14-14 for details.

Read the information on your screen carefully to identify the type of 
item that can’t be repaired, then match it to one of the types below.

■ Infected files are those with file names that include .COM or .EXE. 
Document files such as .DOC, .DOT, and .XLS can also be infected.

■ Compressed files may contain many files. You can often tell a 
compressed file by its name. Many compressed files end in .ZIP. 

■ Hard disk master boot record, boot record, or system files (such as 
IO.SYS or MSDOS.SYS) and floppy disk boot record and system files 
are replaced using the Rescue Disks or, sometimes, your operating 
system (Windows or DOS) disks.

Infected files

If infected files can’t be repaired, you need to delete them from your 
computer. If you leave an infected file on your computer, the virus 
infection can still spread. Once deleted, the infected file and the virus are 
gone forever. 

If Norton AntiVirus can’t repair a file:

1. Choose Delete when prompted.
2. Replace the deleted document file with a backup copy or reinstall a 

deleted program from the original program disks. Be sure to scan the 
backup disks before you use them.

If the virus is detected again after you replace or reinstall the file, your 
backup copy or original program disks are probably infected. You can try 
contacting the manufacturer for a replacement.



14-12 What to do if Norton AntiVirus can’t repair

Compressed files

A compressed file may contain many individual files. For example, 
MYFILE.ZIP may contain the files: FILE1.DOC, FILE2.DOC, FILE3.TXT, 
FILE.EXE, and so on. Norton AntiVirus can detect viruses in the 
individual files within the compressed file; however it cannot repair or 
delete these files until you uncompress (open up) the compressed file.

To uncompress and repair:

1. Double-click the Norton AntiVirus Auto-Protect icon in the lower-
right corner of the taskbar on your Windows desktop, then click 
Disable to turn Auto-Protect off temporarily.

2. Create a a temporary folder (for example, C:\TEMP).
3. Move the infected, compressed file to the temporary folder.
4. Use a program such as Norton Navigator, WinZip, or PKUNZIP to 

uncompress the file in the temporary folder.
5. On the Windows taskbar, click Start, point to Programs, point to HP 

CD-Writer Plus, point to the Norton AntiVirus group, then click 
Norton AntiVirus.

6. From the Scan menu at the top of the Norton AntiVirus main 
window, choose Folders.

7. Select the C:\TEMP folder, then click Scan to scan the files again.
8. Let the Repair Wizard automatically repair all the infected files.
9. Click Exit to close Norton AntiVirus.
10. Delete the infected, compressed file.
11. Double-click the Norton AntiVirus Auto-Protect icon in the lower-

right corner of the taskbar on your Windows desktop, then click 
Enable to turn Auto-Protect on again.

After the virus is eliminated, recompress the files if desired.

Hard disk master boot record or boot record

Windows 95: If Norton AntiVirus can’t repair your hard disk or master 
boot record, you can use your up-to-date Norton AntiVirus Emergency 
Boot Disk to restore it. (See “Windows 95: Create rescue disks” on page 
14-7.) If your Norton AntiVirus Emergency Boot Disk isn’t up to date, 
contact Symantec Technical Support. See the Service and Support 
Solutions at the end of this manual.

WARNING: If the critical information stored on the Boot Disk disk is outdated, 
it could cause problems when you attempt to restore your computer. It is 
unlikely you would be able to fix these problems on your own. However, if you 
have a current Boot Disk, the following procedure is safe to attempt.
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To restore your hard disk:

1. Switch off your computer using the power switch.
2. Place your write-protected Norton AntiVirus Emergency Boot Disk in 

the A: drive, then switch on your computer.
3. At the DOS prompt (A:\>), type RESCUE /RESTORE and press Enter.

The Restore Rescue Information dialog box appears.
4. Make sure Drive A: is specified for the location of the rescue data.
5. Check all the items in the Items To Restore group box.

Press Tab to move around the dialog box. Press spacebar to check or 
uncheck items.

6. Choose Restore to restore the selected items.
7. When the process is complete, remove your Norton AntiVirus 

Emergency Boot Disk from Drive A: and restart your computer.

Windows NT: If Norton AntiVirus could not successfully repair the 
master boot record or a boot record on your hard disk, restart your 
computer from the Windows NT Emergency Repair Disk that you created 
when you installed Windows to attempt a repair. If this fails, you will 
have to reinstall Windows NT.

Floppy disk boot record

If Norton AntiVirus cannot repair a floppy disk boot record, it still 
removes the virus. The information on the floppy disk remains accessible 
and you can safely copy the files onto another disk. However, the floppy 
disk is no longer bootable. 

System file

Windows 95: If Norton AntiVirus cannot repair a system file (for 
example, IO.SYS or MSDOS.SYS) you cannot delete it. You must reinstall 
Windows. 

Restart your computer from an uninfected, write-protected floppy disk 
and reinstall Windows. You can use your Norton AntiVirus Emergency 
Boot Disk (see “Windows 95: Create rescue disks” on page 14-7) or the 
Windows 95 Startup Disk that you created when you installed Windows 
to start up. You could also use a boot disk from any version of DOS from 
version 5.0 or later.
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Keeping virus protection current
WHY? Norton AntiVirus relies on up-to-date information to detect and 
eliminate viruses. One of the most common reasons you may have a 
virus problem is that you have not updated your protection files since 
you purchased the product.

Symantec provides online access to these new files, called virus 
definitions files, at no charge every month. You need to update your 
virus definitions files monthly.

■ From Windows, use a modem or Internet connection to let 
LiveUpdate automatically download and install updated files.

■ Get updates by mail. This service requires a fee. For more 
information, see Symantec Service and Support Solutions at the end 
of this manual. 

Updating virus protection with LiveUpdate

WHY? LiveUpdate is the easiest way to keep virus protection current 
because it automatically downloads the proper files and installs them on 
your computer. You can get virus protection updates anytime by clicking 
the LiveUpdate button.

To update virus protection:

1. Start Norton AntiVirus.
2. In the Norton AntiVirus main window, click LiveUpdate.
3. In the How Do You Want To Connect drop-down list box, select one 

of the following:

Find Device 
Automatically

Norton AntiVirus determines if you have an 
Internet connection or must connect using your 
modem.

Internet Norton AntiVirus connects to a special Symantec 
site on the Internet.

Modem Norton AntiVirus dials a preset number and 
connects to a Symantec server through your 
modem.
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TIP: We recommend Find Device Automatically. However, you may want to 
control the choice depending on long-distance telephone charges for the direct 
modem connection or access time from the Internet site.

4. Click Next to start the automatic update.

Using LiveUpdate Email

WHY? Whenever a major virus threat is discovered that requires an 
update to your virus protection, Symantec can notify you by email so 
you can run LiveUpdate immediately. The email includes an attachment 
that can start a LiveUpdate session for you.

To receive LiveUpdate Email:

1. Point your Internet browser to 

www.symantec.com/avcenter/newsletter.html

2. Fill out the registration form.
3. Click the Subscribe Me button. Symantec will notify you by email 

whenever protection updates are available.

To start a LiveUpdate session from the LiveUpdate Email:

■ When you receive a LiveUpdate Email, launch or run the email 
attachment called LIVEUPDT.NLU from your mail program.

You must launch or run the attachment; simply reading or viewing it will 
not work. When the attachment runs, it automatically starts a 
LiveUpdate session on your computer. You don’t have to do anything 
else.

Scheduling automatic LiveUpdates

WHY? Scheduling a LiveUpdate to run automatically is the best way to 
ensure that you don’t forget to update virus protection every month.

To schedule automatic LiveUpdates:

1. Start Norton AntiVirus.
2. In the Norton AntiVirus main window, click Scheduler.
3. Click Add.
4. Select Scheduled LiveUpdate for the Type Of Event.
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5. Select Monthly for the Frequency.
6. Click OK to close the dialog box, then click OK again to confirm.
7. Click Exit in the upper-right corner of the Norton Scheduler dialog 

box. 
8. Windows 95: Click Minimize to close the dialog box but leave the 

Norton Scheduler running. Under Windows NT, the Scheduler service 
runs all the time.

Your computer must be turned on when the LiveUpdate is due to take 
place.

Updating virus protection without LiveUpdate

WHY? Symantec supplies a special program called Intelligent Updater if 
you cannot use LiveUpdate. If you don’t have a modem or Internet 
connection, you can get the updates by mail. You may also choose to 
download the updates from an online service or bulletin board. The 
Intelligent Updater program is available from several sources — phone 
numbers are included in the Symantec Service and Support Solutions at 
the end of this manual. 

To install the latest virus definitions on your computer: 

1. Download the Intelligent Updater program to any folder on your 
computer or Insert the disk you received from Symantec in the A: 
drive.

2. From a My Computer or Windows Explorer window, locate and then 
double-click the Intelligent Updater program.

The filename for Intelligent Updater has the form mmNAyyI.EXE, 
where mm is the month and yy is the year.

3. Follow all prompts displayed by the update program. The Intelligent 
Updater program searches your computer for Norton AntiVirus, then 
installs the new virus definitions files in the proper folder 
automatically. 

If prompted to overwrite, click Yes. The files are being replaced with 
new ones.

4. Restart your computer.
5. Scan your disks to make sure newly discovered viruses are detected.
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Troubleshooting

Norton AntiVirus can’t repair my infected files. 

The main reason that Norton AntiVirus may not be able to repair your 
infected files is:

■ You don’t have the latest virus definitions files installed on your 
computer. You should update these files monthly to protect your 
computer from the latest viruses. To update virus definitions, see 
page 14.

Norton AntiVirus Auto-Protect doesn’t load when 
I start my computer.

If the Norton AntiVirus Auto-Protect icon does not appear in the lower-
right corner of the taskbar on your Windows desktop, Auto-Protect is not 
loaded. Make sure that Norton AntiVirus is not configured to start Auto-
Protect automatically.

1. Start Norton AntiVirus.
2. Click the Options button in the Norton AntiVirus main window.
3. Click the Auto-Protect tab.
4. Check the Load Auto-Protect At Startup check box.
5. Click OK to save your settings and close the Options dialog box.

I’ve scanned and removed a virus, but it keeps 
infecting my files.

The virus may be in a program file with an unusual extension that 
Norton AntiVirus isn’t set to look for. Do this:

1. Start Norton AntiVirus. 
2. Click the Options button in the Norton AntiVirus main window.
3. Click the Scanner tab.
4. Select the All Files option in the What To Scan group.
5. Click OK to save your settings and close the Options dialog box.
6. Scan all disks that you use and repair all infected files.
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The source of the infection is a floppy disk.

■ Scan all the floppy disks you use for viruses.

Some Norton AntiVirus features are password 
protected, and I don’t know the password. 

Uninstall Norton AntiVirus, then reinstall it.

A program does not work properly after repair.

Although Norton AntiVirus removes the virus, the file may be damaged 
beyond repair.

■ Delete the program and replace it with a backup copy or reinstall it 
from the original program disks. If the virus is detected again, the 
backup copy or original program disks are probably infected.

Windows 95: My Norton AntiVirus Emergency 
Boot Disk doesn’t work

Due to the number of product specific technologies used by 
manufacturers to configure and initialize hard disks, Norton AntiVirus 
cannot always create a bootable Norton AntiVirus Emergency Boot Disk 
automatically. If your Norton AntiVirus Emergency Boot Disk does not 
work properly, do one of the following:

■ If you have a special boot disk for your computer, add it to your 
Norton AntiVirus rescue disk set. In a virus emergency, boot from that 
disk (first slide open the plastic tab on the back of the disk to make 
sure it is write-protected). Remove the disk and insert your rescue disk 
labelled “Norton AntiVirus Program Disk.” At the DOS prompt, type 
A:GO and press Enter, then follow the on-screen instructions. 

■ Use the Disk Manager or similarly named program that came with 
your computer to make your Norton AntiVirus Emergency Boot Disk 
bootable. Be sure to test your modified Norton AntiVirus Emergency 
Boot Disk.
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Sometimes, your Norton AntiVirus Emergency Boot Disk does not work 
properly because you have more than one operating system installed, 
such as Windows NT and Windows 95. To modify the disk, do the 
following:

■ Start up from your hard disk, insert your Norton AntiVirus Emergency 
Boot Disk in the A: drive, and, from a DOS prompt, type SYS A: and 
press Enter. This transfers the operating system to the rescue disk. Be 
sure to retest your Norton AntiVirus Emergency Boot Disk.

Command-line switches

The Norton AntiVirus scanner can be run with command-line switches to 
override configuration settings. When scanning using command-line 
switches, Norton AntiVirus runs minimized, but will pop open on your 
screen if a virus is found.

Some switches are used alone, while others are followed by a parameter, 
either a plus (+) or minus (-) sign. You can use more than one switch and 
more than one parameter on a command line. The vertical bar symbol (|) 
means that you should use either parameter, but not both. Do not type 
the brackets around the parameters on the command line.

Windows 95: NAVW32 [[pathname] options]

Windows NT: NAVWNT [[pathname] options] 

pathname Any drive, folder, file, or combination of these is 
scanned. If you want to scan a combination of items, 
use a space to separate the items. You can use 
wildcards when specifying pathnames for a group of 
files. For example,
NAVW32 A: C:\MYDIR\*.EXE)
NAVWNT A: C:\MYDIR\*.EXE

/A All drives, except drives A: and B:, are scanned. 
Network drives are scanned if the Allow Network 
Scanning option is selected in the Scanner Advanced 
Settings dialog box

/L All local drives, except drives A: and B:, are scanned.
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/S[+|-] Enables (+) or disables (-) scanning of subfolders for 
any folders specified in the pathname. S+ is the 
default.

/M[+|-] Windows 95 only: Enables (+) or disables (-) scanning 
of memory (for example, NAVW32 C: /M+ or 
NAVW32 D: /M-)

/MEM Windows 95 only: Only memory is scanned.

/B[+|-] Enables (+) or disables (-) scanning of boot records 
(for example, NAVW32 A: /B+ or NAVWNT B: /B-).

/BOOT Only the boot records of the specified drives are 
scanned

/NORESULTS No scan results are reported on screen.
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Appendix A:
Technical Specifications

Minimum System Requirements
Your computer should meet or exceed these requirements:

■ IBM or compatible Pentium/75 Mhz processor or above

■ Microsoft® Windows 95® or Windows NT® 4.0

NOTE:  For Windows NT, Service Pack 3 is required.

■ 16 MB RAM

■ Hard drive with at least 528 MB storage capacity (that is, with a 
transfer rate of at least 800 kB/sec and disk access time of less than 20 
msec)

■ 110 MB free hard drive space for installing software
10 MB free hard drive space for each minute of music to be recorded

■ High-speed parallel port (EPP or ECP) set to:
- IRQ 7 and I/O address 378 or 
- IRQ 5 and I/O address 278

In Windows 95, to check the configuration settings of your parallel 
port:
- Right-click on the My Computer icon
- Select Properties
- Select the Device Manager tab
- Highlight Printer Port
- Click on the Properties button
- Select the Resources tab
- Look at the numbers listed for Input/Output Range (I/O)
  and Interrupt Request (IRQ)

If the numbers need to be changed, see the documentation that came 
with your computer.
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What Affects System Performance
How well your computer functions with the CD-Writer Plus drive, 
particularly how fast it writes data to a CD, depends on a number of 
factors. Some of these factors are listed below.

■ Processor (CPU). The type and speed of your processor greatly affects 
the speed at which your computer transfers data to and from the CD-
Writer Plus drive. If the processor speed is too slow, you may have to 
write at 1x speed.

■ RAM. Your computer must have enough memory available to handle 
its operating system, the CD-Writer Plus drive’s applications, and the 
data you are transferring to and from CDs. The system should not 
have to swap data to and from the hard drive.

■ Your Hard Drive. The speed at which your hard drive accesses and 
transfers data (its access time and transfer rate) affects performance. 
Newer hard drives, those with a storage capacity greater than 528 MB, 
are fast enough to handle the CD-Writer Plus drive’s 2x write speed.

■ Parallel Port Type. The type of parallel port on your computer has a 
major influence in determining the speed at which your CD-Writer 
Plus drive runs. Possible parallel port types are:

■ Standard parallel port (SPP) which is sometimes called bi-
directional or compatible

■ Enhanced parallel port (EPP)

■ Extended capabilities port (ECP)

Most PCs shipped since January 1995 contain support for the 
required high-speed EPP and ECP modes. Systems shipped before this 
date may only support SPP.

SPP mode allows the CD-Writer Plus drive to run at up to a 2x read 
speed and up to a 1x write speed if the other minimum system 
requirements are met.

EPP and ECP modes allow the CD-Writer Plus drive to run at up to a 
6x read speed and a 2x write speed if the other minimum system 
requirements are met.

TIP: Check your computer’s specifications to see which kind of parallel port was 
installed. Sometimes a fast ECP/EPP port will be set up as a slow standard 
mode port at the factory (for example, some HP Vectra models). Check your 
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computer’s manual to find out how to reset it to the faster speed. If that doesn’t 
work you can also install a faster parallel port.

■ I/O and IRQ. The IRQ (interrupt request level) and I/O (input/
output) base address are the computer resources used by the parallel 
port. The CD-Writer Plus drive requires a parallel port set to:

IRQ 7 with I/O base address 378, or 

IRQ 5 with I/O base address 278

Most computers automatically assign these. But, depending on your 
configuration, you may run into conflicts with other devices. For 
example, another device (such as your sound card) may be assigned 
the same settings. If there is a conflict, it must be corrected before 
installing the drive.

To find out which device is in conflict:

In Windows 95, right-click on the My Computer icon, select 
Properties, select the Device Manager tab, double-click on the 
computer icon to see a list of which device is using each resource 
setting on your computer.

■ For optimum performance, run SCANDISK.EXE and DEFRAG.EXE 
on your hard drive before using your CD-Writer Plus drive for the first 
time (see your Windows manual for more information). Then run 
them periodically after that. These programs improve access times to 
the hard drive, which will help improve system performance while 
writing to and reading from the CD-Writer Plus drive.

NOTE: Refer to your computer manual or contact your computer vendor if you 
have any questions about your computer’s configuration or capabilities.

Drive Specifications
Discs supported

120 mm and 80 mm CD-R (write-once) media 
(any CD-ROM drive can read this media)

120 mm CD-RW (ReWritable) media 
(for use only in CD-ReWritable and MultiRead CD-ROM drives)
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ISO 9660 Disc Data Capacity (74 Minute CD)

*1 MB is defined as 106 bytes

UDF 1.5 Disc Data Capacity (74 Minute CD)

493 MB for CD-RW

618 MB for CD-R

Dimensions

Height: 2.6" (66 mm)

Width: 7.1" (180 mm)

Depth: 11.2" (284 mm)

Weight (net): 2,157 grams (~4.7 lbs)

Performance

Buffer size: 750 kB

Average access time (1/3 stroke): <325 ms

Data transfer rate (recording):
150 KB/s sustained (1x speed)
300 KB/s sustained (2x speed)

Data transfer rate (reading):
150 KB/s (1x speed)
300 KB/s (2x speed)
up to 900 KB/s (6x speed)

Number 
of 
sessions

Size required for header 
information

Size available for data/
per session

1 approximately 23 MB* 627 MB one session

5 approximately 79 MB
(approx. 23 for the first, 
14 MB each of the rest)

114 MB each session

10 approximately 149 MB
(approx. 23 for the first, 
14 MB each of the rest)

50 MB each session

30 approximately 430 MB
(approx. 23 for the first, 
14 MB each of the rest)

7.4 MB each session
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Appendix B:
Customer Support

Who do you need to call for help?
The following table will help direct you to the appropriate customer 
support service.

Software or Hardware Customer Support Service Page

HP CD-Writer Plus HP Customer Support page B-2

Direct CD Adaptec Customer Support page B-2

Easy-CD Audio Adaptec Customer Support page B-8

Jewel Case Designer Adaptec Customer Support page B-8

CD Copier Adaptec Customer Support page B-8

HP Simple Trax HP Customer Support page B-5

Adobe Photo Deluxe Adobe Customer Support page B-9

Corel Print House Magic Corel Customer Support page B-11

Photo Organizer Digital NOW! Customer 
Support

page B-13

Paper Master Live Documagix Customer 
Support

page B-14

Norton Antivirus Symantec Customer Support page B-17



B-2 Before You Call HP

Before You Call HP
If your own troubleshooting efforts fail, contact Customer Support. Make 
sure you are at your system and have your drive installed when you call. 
Phone numbers begin on page B-5. Before you contact them, have the 
information below ready. For help finding this information, see page B-3. 
If you receive an error message, write it down before you call.

Information For your computer

CD-Writer Plus drive model

Drive firmware version

Drive serial number

Computer brand and model

Operating system and version? Windows 95 or Windows NT 4.0
Version Number:
(for NT) Service Pack Number:

Amount of RAM installed

Other CD-ROM drives? yes/no
(If yes, list them)

Sound card? yes/no Type:

IDE controller settings Primary / Secondary / Other
IRQ _______
I/O base address _______
Master in use?_______
Slave in use?_______

Other IDE devices in your 
computer system?
yes/no (If yes, list them)

IDE adapter board brand/model, if 
any
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Where to Find This Information

CD-Writer Plus drive model

The CD-Writer Plus drive model number appears on a small sticker on 
the underneath side of the tray of the CD-Writer Plus drive, as well as 
on the box.  Example: 7200i (internal) or 7200e (external)

Drive firmware version

In Windows 95, the drive firmware version and model number (above) 
appear in the CD-ROM settings. Right-click on the My Computer icon, 
select Properties, select the Device Manager tab, double-click on 
CDROM. Double-click on the CD-Writer Plus drive, and then click on the 
Settings tab. Example: Firmware revision 1.00

In Windows NT, the drive firmware version and model number (above) 
appears in the CD-ROM settings. Open the Control Panel. Click on SCSI. 
Scroll down the list, double-click on ATAPI. Double-click on the CD-
Writer Plus drive, and then click on the Settings tab. Example: Firmware 
revision 1.00

Drive serial number

The CD-Writer Plus drive serial number appears on the main label on the 
top of the drive.  See page 1-5. It also appears on the underside of the CD 
tray.

Computer brand and model

The computer brand appears on the front of your computer and in the 
documentation that came with your computer. Example: Dell Dimension 
XP-90.

Operating system and amount of RAM installed

In Windows 95, from the Start menu on the task bar, select Settings/
Control Panel.  Double-click on System.  Select the General tab.  Write 
down the version number and the amount of memory installed; for 
example:  4.00.950 and 16 MB RAM.

In Windows NT (while signed on as Administrator), from the Start menu 
on the task bar, select Programs/Administrative Tools (Common)/
Windows NT Diagnostics.  Select the Version tab and write down the 
version number and service pack number; for example:  4.00.1381 and 
Service Pack 2.  Then select the Memory tab and write down the amount 
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of memory listed under Physical Memory - Total; for example:  16 MB 
RAM.

Other CD-ROM drives

Your computer may have come with an internal CD-ROM or you may 
have purchased a CD-ROM drive. Check the documentation that came 
with your computer or CD-ROM drive. Example: Mitsumi 4x CD-ROM

Sound board

Your computer may have come with a sound board and speakers or you 
may have purchased them separately. Check the documentation that 
came with your computer or sound board. Example: 16-bit audio card

IDE controller settings

1. Insert the CD labeled “Software Disc 1” into your CD-ROM drive.
2. Click the Start button on the task bar, select Run, 

type D:\ASSIST /S (where D: is your CD-ROM’s drive letter)
and click on OK.

3. Print the results. You will have a list of technical information about 
each IDE controller in your system and each device attached. 

Other IDE devices

Any devices attached to IDE controllers in your computer system, such as 
a CD-ROM drive, hard drive, tape drive, and so on. Example: HP Colorado 
5GB

IDE adapter board brand/model

If you are using a paddle board to add another IDE controller to your 
computer system, check the manual that came with your IDE board. 
Example: GSI 2C
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HP Customer Support
If you have questions about the HP Simple Trax software, call the appropriate number 
listed in this section. If you need help with your CD-Writer Plus drive, your local 
reseller has the latest information regarding HP products and services and can provide 
support under HP's comprehensive menu of reseller services. If your reseller is not able 
to help, you can obtain support from HP directly either through free 24-hours/day 
interactive electronic services or by telephone (free during warranty).

America Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Keyword: hpstor

CompuServe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Go HPSYS

World Wide Web  . . . . . . . . . . . . . . . . . www.hp.com/isgsupport/cdplus

Bulletin board site (8,N,1,F, 1200-28.8K baud) 
Europe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +31 (0)495 546909
Asia/Pacific

Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9890 0276
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Hitel: (02) 762-0228 

Access: Go HPK 
Chollian: (02) 220-2001

New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (09) 356 6642
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02)9233233

First Name: HP
Last Name: BBS

HPFirst Faxback Service 
Simply dial the fax number from a touch-tone phone or Group 3 fax machine and 
follow the voice prompts to select the index of available support and product 
information documents.

USA and Canada  . . . . . . . . . . . . . . . . . . . 800-368-9673 or 970-635-1510
Europe

Austria (free line) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0660 8128
Belgium (free line)
- Dutch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0800 11906
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0800 17043
Denmark (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 800 10453
Finland (free line). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9800 13134
France (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 05 905900
Germany (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . 0130 810 061
Italy (free line) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1678 59020
Netherlands (free line) . . . . . . . . . . . . . . . . . . . . . . . . . . 06 022 2420
Norway (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 800 11319
Spain (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 900 993123
Sweden (free line). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 020 795743
Switzerland (free line)
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155 1526
- German  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155 1527
United Kingdom (free line)  . . . . . . . . . . . . . . . . . . . . . . 0800 960271
Other locations in Europe (toll line) . . . . . . . . . .+31 (0)20 681 5792
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Asia/Pacific
Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9272 2627
China . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (8610) -65055280
Japan. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (3) 3335-8622
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 769-0543
New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (09) 356 6642
Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (65) 291-7951
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02)7195589

E-mail  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . SureStore_Support@hp.com

FTP Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ftp.hp.com
Login:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .anonymous
Password:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (Your email address)
Directory:  . . . . /pub/information_storage/surestore/cd-writer_plus

Telephone 
USA and Canada (M-F, 6am-6pm Mountain time)

Literature and dealer referral . . . . . . . . . . . . . . . . . . . . 970-635-1500
Canada (for French-speaking customers)
pour assistance en français. . . . . . . . . . . . . . . . . . . . . . 800-387-3867

During warranty period
- Technical support  . . . . . . . . . . . . . . . . . . . . . . . . . . . 970-635-1500

After warranty period (charges begin only when you connect to a Support Technician, 
prices are subject to change without notice)

Technical Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 800-810-0130
(Per incident fee of $25 US dollars charged to 
Visa, MasterCard or American Express)
U.S. only Technical Support. . . . . . . . . . . . . . . . . . . . . 900-555-1800
($2.50 per minute/maximum of $25. You must be 18 years
of age or have parental permission to call 900 numbers.)

Europe (M-F, 8:30-18:00 Central European Time)
Use these Technical Support numbers during and after your warranty period. No charge 
for Technical Support during warranty period. Per incident charge after warranty period.

Austria  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 06 60 63 86
Belgium
- Dutch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 626 88 06
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 626 88 07
Denmark. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39 29 40 99
Finland . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 03 47 288
France . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 04 50 43 98 53
Germany. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0180 52 58 143
Ireland  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01 662 55 25
Italy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 2 641 0350
Netherlands  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 020 606 87 51
Norway . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22 11 62 99
Portugal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01 44 17 199
Spain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90 23 21 123
Sweden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 08 61 92 170
Switzerland (French, Italian, and German) . . . . . . . . 08 48 80 11 11
United Kingdom. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0171 512 52 02
English language support from other countries  . +44 171 512 52 02
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Asia/Pacific
Australia (M-F 7am-7pm, Eastern Standard Time). . . (03) 9272 8000
China (M-F 8:30-17:30) . . . . . . . . . . . . . . . . . . . . . (8610)-62625666

extensions 5602 through 5609, 5611 and 5612
(8610)-62614174
(8610)-62624175
(8610)-62614176

Korea (M-F, 8:30-19:00)  . . (02) 3270-0700 / 080-999-0700 (toll free)
New Zealand (M-F, 9am to 9pm Auckland Time)  . . . . (09) 356 6640
Singapore (M-F, 9:00-17:00) . . . . . . . . . . . . . . . . . . . . . (65) 271-7233
Taiwan (M-F, 8:30-17:30) . . . . . . . . . . . . . . . . . . . . . . . (02) 717-9609

FAX 
USA. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 970-667-0997
Asia/Pacific

Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9272 4099
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 3270-0707
New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .(+61 3) 9272 4099
Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (65) 278-9225
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02)5140276
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Adaptec Customer Support

Electronic Support
Technical information, including product literature, answers to commonly asked 
questions, information on software upgrades and other topics is available electronically 
through the following:

World Wide Web  . . . . . . . . . . . . . . . . . . . . . . . . . . . . www.adaptec.com

On the Internet, you can send CD-ROM, CD-R, and CD publishing-specific messages to 
support@adaptec.com. Include “CD-R SW” in the subject.

The Adaptec Software Products Group can also be found on several CD-ROM, CD-R, 
and CD publishing newsgroups and lists on the Internet.

Interactive Fax System  . . . . . . . . . . . . . . . . . . . . . . . . . . 303-684-3400

Interactive Voice Response System  . . . . . . . . . . . . .1-800-959-7274

Technical and Product Support
 To speak with an Adaptec product support representative, call:

In the U.S.  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-408-934-7283

In Europe  32-2-352-3490
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Adobe PhotoDeluxe Technical Support
U.S. and Canada

Adobe's CustomerFirst program offers the following Technical Support 
options:

■ A technical support database on the World Wide Web providing 
PhotoDeluxe technical notes:
http://www.adobe.com/supportservice/custsupport/

■ Adobe FaxYI, a free fax-on-demand system that can fax any of more 
than 1,000 technical and customer service documents on 
PhotoDeluxe. In North America, call 206-628-5737 from a touch-tone 
phone and follow the recorded instructions. The index of 
PhotoDeluxe issues, the document is 360099.

■ Technical documents from Adobe by e-mail. All documents available 
through Adobe FaxYI are also available through e-mail. To receive an 
index of documents for PhotoDeluxe issues, send e-mail to 
techdocs@adobe.com and type 360099 in the subject line.

■ The Adobe Forum for America Online© or CompuServe®. 
Correspond with PhotoDeluxe experts to get answers to commonly 
asked questions. On America Online, type the keyword Adobe and 
enter the Adobe PhotoDeluxe message board. On CompuServe, type 
GO ADOBEAPP and enter the PhotoDeluxe Forum. Forums and 
availability may vary by country. 

■ The Internet button in PhotoDeluxe. Click on the button to access 
PhotoDeluxe tips, techniques, and other resources over the Web. 

Additionally, you can choose from a variety of support options in North 
America and Canada through the Adobe CustomerFirst® program, 
including single-incident call support, 900 number access, and even 
yearly support contracts. For information on the Adobe CustomerFirst 
program, call 800-685-3652 between 6 A.M. and 5 P.M., Pacific Standard 
Time, Monday through Friday. 

Outside North America or Canada, terms may vary. Contact your local 
subsidiary or distributor for details. For the phone number of your local 
subsidiary, visit our Web site at this address: 
http://www.adobe.com/supportservice/intlsupport.html 
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CUSTOMER SERVICE

Disk replacements or User's Manuals can only be provided from the 
manufacturer that included the PhotoDeluxe program with your new 
hardware device.

European Support
Email  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . techdocs@adobe.com
Fax(Call BackByFax Service to documents) . . . . . . +44 131 458 3022
Internet  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .http://www.adobe.com
BBS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +44 131 458 4666

Modem settings: Up to 14,400 baud; Data Bits: 8 Stop Bits; 1 Parity: None. 
Leave the username and password blank on first call. 

Telephone (UK only, £1.50 per minute)  . . . . . . . . . . . 0897 161 345
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Corel Print House Magic Service & Support
Corel is committed to providing customers with high-quality, timely technical 
support. This section describes the range of support services available.
Note: The terms of Corel's technical support offerings are subject to change 
without notice.

Technical Support Services
Classic technical support services
Technical support is available for 30 days from the day you place your first call to 
technical support at 613-728-6891 (North America Only). There will be no 
support fees charged for this initial 30 day period other than applicable long 
distance telephone toll charges.  Corel representatives are available to respond to 
calls from Monday to Friday, 8:30 a.m. to 7:30 p.m., Eastern Standard Time.

During and after your classic support period, you can also use other basic services. 
Descriptions of other services are available from Corel’s home page on the World 
Wide Web at HTTP://WWW.COREL.COM. For details on the support options 
available after your classic support service expires, please contact Corel Technical 
Support at (613) 728-6891 (Please note: Long distance toll charges will apply).

Worldwide Technical Support
Corel customers residing outside North America can contact Corel Technical 
Support representatives in Dublin, Ireland, or a local Authorized Support Partner. 
Technical support outside North America is available to you at the following 
locations. If your country is not listed below, please check the Services and 
Support section on our World Wide Web site at: WWW.COREL.COM. You may 
also dial (353)-1-7082500 for information on reaching Technical Support.

Priority Technical Support services
To request an up-to-date listing of Corel's Authorized Support Partners worldwide, 
and a copy of Corel's Priority Technical Support Policy, contact Corel Technical 
Support at (353)-1-7082500.

Access numbers for Corel Print House Magic Technical 
Support

Latin America
Argentina . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (0541) 954-6500
Brazil. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 011 5505 4725
Chile. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 562 671-3060
Columbia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-1-2150411
Mexico . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .01-800-024-2673
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Middle East
Dubai . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 971.4.523.526
Isreal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02-6793-723

Eastern Europe
Czech Republic. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .420-2-312-3871
Poland  . . . . . . . . . . . . . . . . . . . . . . . . . (0048)-(71)-728-141 ext. 289

Europe
Austria  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (01)-589-241-30
Belgium-French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 714-41-30
Belgium-Dutch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 714-41-31
Denmark. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .35-25-80-30
Finland . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (90)-229-060-30
France . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (1)-40-92-76-20
Germany  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01805-2582-11
Hungary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +36-1-3275737
Ireland  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .(01)-7082600
Italy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .02-452-812-30
Netherlands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 020-581-4426
Norway. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22-97-19-30
Poland  . . . . . . . . . . . . . . . . . . . . . . . . . (0048)-(71)-728-141 ext. 289
Portugal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+353-1-708-2333
Russia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (095) 361-2000
Spain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-661-3627
Sweden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0680-711-751
Switzerland-French  . . . . . . . . . . . . . . . . . . . . . . . . . . .0848-80-85-90
Switzerland-German  . . . . . . . . . . . . . . . . . . . . . . . . . .0848-80-85-90
United Kingdom  . . . . . . . . . . . . . . . . . . . . . . . . . . . 0171 - 298 85 16

Asia Pacific
Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02-9898-6860
Hong Kong . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8100-3729
India . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91 11 3351948
Indonesia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .001-800-65-7266
Japan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 03-5645-8379
Malaysia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-800-800-1090
New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 09 526 1155
Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-800-773-1400
South Korea . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .82-2-639-8778
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (886) 2-593-3693

Africa
South Africa . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 021-658-4222

Please note:  The terms of Corel's technical support offerings are subject to change 
without notice.
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Photo Organizer Customer Support
Call the appropriate number listed in this section if you have questions 
about the Photo Organizer software.

US . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301 419 0000

Canada . . . . . . . . . . . . . . . . . . . . . . . . . . . .1 (905) 475 2777 , ext264

Latin America & Asia pacific
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 415 635 6639
Online. . . . . . . . www.broder.com/support/support.html

Europe (except Holland)  . . . . . . . . . . . . . . . . . . . . 001 329 365 9980

Holland  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 011 358 9 348 40 311
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PaperMaster Technical Support

United States and Canada 
DocuMagix, Inc.
2880 Zanker Road
Suite 204
San Jose, CA 95134 

USA 
Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-408-434-1001
Sales . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-800-362-8624
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-408-434-0915

United Kingdom 
Esselte MSD
PaperMaster
Norman Park
Bar Hill
Cambridge CB3 8SS
UNITED KINGDOM 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . .  +44 (0) 1954 78 90 37
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+44 (0) 1954 78 27 57 

Australia 
Indigo Pacific Pty Ltd.
PaperMaster
Level 16, 275 Alfred Street
North Sydney NSW 2060
AUSTRALIA 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+61-2-9955 8000
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+61-2-9955 8511

Austria/Switzerland 
Karl Bene & Co
PaperMaster
Industriestrasse 346
A-2822 Erlach a.d. Pitten 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +43(0)2627 400 000
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +43(0)2627 400 138

Belgium 
Esselte N.V.
PaperMaster
Industriepark-Noord 30
PO Box 85
B-9100 St Niklaas 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  +32(0)3 760 3311
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +32(0)3 766 0612
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Denmark 
Esselte A/S
PaperMaster
Nordre Fasanvej 117-119
DK-2000 Frederiksberg 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  +45 38 16 7800
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +45 38 16 7935

Eastern Europe/Middle East/Africa/Greece/Cyprus/Turkey 
Esselte UK Ltd. (Export Div)
PaperMaster
Kingsnorth Industrial Est
Wotton Road
Ashford, Kent TN23 6FL
England 
Support. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+44(0) 1233 62 44 21)
Sales . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +44(0) 1233 61 30 00
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +44(0) 1233 64 69 03

Finland 
Esselte OY
PaperMaster
Kutomotie 2
Fin-00380 Helsinki
Telephon  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+358(0) 9 565 3355
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+358(0) 9 565 0261

France/Switzerland 
Esselte SA
PaperMaster
192, rue Championnet
F-75018 Paris, FRANCE 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +33(0)14 485 1700
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +33(0)14 229 8944

Germany 
Esselte Deutschland GmbH
PaperMaster
Anderter Str. 99 d
D-60559 Hannover

GERMANY 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+49(0)511 95 95 000
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+49(0)511 95 95 302
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Italy/Switzerland 
Esselte SpA
PaperMaster
Centro Direzionale Lombardo
Via Roma 108
I-20060 Cassina de Pecchi
Milan, ITALY 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +39 2 95 300 991
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +39 2 95 300 300

Netherlands 
Esselte B.V.
PaperMaster
Apmereweg 17
NL-3440 AE Woerden
Tel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  +31(0)348 41 50 84
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  +31(0)348 42 12 03

Norway 
Esselte AS
PaperMaster
Postboks 62 Okern
N-0508 Oslo
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +47 22 88 55 00
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +47 22 65 07 00

Poland 
Esselte Polska Sp. Z.o.o.
PaperMaster
ul Okrezna 95
Pl-02-933 Warsaw
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +48(0)22 651 6021
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +48(0)22 651 6021

Spain/Portugal 
Esselte
PaperMaster
Tomas Redondo s/n
Edificio Luarca
E-28033 Madrid, SPAIN 
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+39(9) 3 415 0333
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .+34(9) 1 381 5120

Sweden 
Esselte Sverige AB
PaperMaster
Sundybergsvagen
Box 1377
S171 27 Solna
Telephone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +46(0) 8 705 15 00
Fax  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +46(0) 8 705 15 55
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Symantec Service and Support Solutions
Symantec is committed to excellent service worldwide. Our goal is to 
provide you with professional assistance in the use of our software and 
services, wherever you are located.

Technical Support and Customer Service solutions vary by country. If you 
have questions about the services described below, please refer to the 
section “Worldwide Service and Support” at the end of this section.

Virus definitions update disk

If you don’t have a modem to obtain virus definitions files using the 
Internet, Compuserve, America Online, or the Symantec BBS, you can 
order regular updates from Symantec to arrive by mail. This service 
requires a fee.

To order, do one of the following:

■ In the United States, call (800) 441-7234.

■ Outside the United States, contact your local Symantec office or 
representative.

Technical support

Symantec offers an array of technical support options designed for your 
individual needs to help you get the most out of your software 
investment.

World Wide Web

The Symantec World Wide Web site (http://service.symantec.com) is the 
doorway to a set of online technical support solutions where you will 
find the following services:

■ Interactive problem solver: Symantec’s online interactive problem 
solver (known as the Support Genie) helps you solve problems and 
answer questions about many Symantec products.

■ Product knowledgebases: Product knowledgebases enable you to 
search thousands of documents used by Symantec Support 
Technicians to answer customer questions.



B-18 Symantec Service and Support Solutions

■ FAQs: Frequently Asked Questions documents, also known as FAQs, 
list commonly asked questions and clear answers for specific 
products.

■ Discussion groups: Discussion groups provide a forum where you can 
ask questions and receive answers from Symantec online support 
technicians.

■ FTP: Point your Web browser to http://service.symantec.com to 
search for and download technical notes and software updates. You 
can also click the LiveUpdate button in programs enabled with this 
feature to automatically download and install software updates and 
virus definitions.

Other Symantec support options include the following:

America Online Type Keyword: SYMANTEC to access the 
Symantec forum.

CompuServe Type GO SYMANTEC to access the Symantec 
forum.

Symantec BBS Set your modem to 8 data bits, 1 stop bit, no 
parity and dial (541) 484-6669.

Automated fax 
retrieval system

To receive general product information, fact 
sheets and product upgrade order forms 
directly to your fax machine, please call our 
Customer Service fax retrieval system at (800) 
554-4403 or (541) 984-2490.

For technical application notes, please call our 
Technical Support fax retrieval system at (541) 
984-2490 and select option 2.

StandardCare 
Support

If you can’t access the Internet, take advantage 
of your 90 days of free telephone technical 
support (from the date of your first call) at no 
charge to all registered users of Symantec 
software. Call (541) 465 8420.

PriorityCare and 
PlatinumCare 
Support

Expanded telephone support services available 
to all registered customers. For complete 
information, please call our automated fax 
retrieval service, located in the United States, 
at (800) 554-4403 or (541) 984-2490, and 
request document 070, or visit our website: 
www.symantec.com/techsupp/telesupp.html
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Support for old and discontinued versions

When a new version of this software is released, registered users will 
receive upgrade information in the mail. Telephone support will be 
provided for the previous version for six months after the release of the 
new version. Technical information may still be available through online 
support.

When Symantec announces that a product will no longer be marketed or 
sold, telephone support will be discontinued 60 days later. Support will 
only be available for discontinued products through online services. See 
the section “Technical support” for online service options.

Customer Service

Symantec’s Customer Service department can assist you with non-
technical questions. Call Customer Service to:

■ Order an upgrade.

■ Subscribe to the Symantec Support Solution of your choice.

■ Fulfill your request for product literature or demonstration disks.

■ Find out about dealers and consultants in your area.

■ Replace missing or defective CDs, disks, manuals, etc. 

■ Update your product registration with address or name changes.

You can also visit Customer Service online at at our website 
www.symantec.com/custserv for the latest Customer Service FAQs, to 
find out the status of your order or return, or to post a query to a 
Customer Service discussion group.

Worldwide Service and Support

Symantec provides Technical Support and Customer Service worldwide. 
Services vary by country and include International Partners who 
represent Symantec in regions without a Symantec office. For general 
information, please contact the Symantec Service and Support Office for 
your region.
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■ NORTH AMERICA

Symantec Corporation (800) 441-7234 (USA & Canada)
175 W. Broadway (541) 334-6054 (all other locations)
Eugene, OR, 97401 Fax: (541) 984-8020

Automated Fax Retrieval (800) 554-4403
(541) 984-2490

■ BRAZIL

Symantec Brazil +55 (11) 5561 0284
Av. Juruce, 302 - cj 11 Fax: +55 (11) 5530 8869
São Paulo - SP
04080 011
Brazil

■ EUROPE

Symantec Europe Ltd. +31 (71) 535 3111
Kanaalpark 145 Fax: +31 (71) 535 3150
2321 JV Leiden
The Netherlands

Automated Fax Retrieval +31 (71) 535 3255

■ ASIA/PACIFIC RIM

Symantec Australia Pty. Ltd. +61 (2) 9850 1000
408 Victoria Road Fax: +61 (2) 9850 1001
Gladesville, NSW 2111
Australia

Automated Fax Retrieval +61 (2) 9817 4550

Most International Partners provide Customer Service and Technical 
Support for Symantec products in your local language. For more 
information on other Symantec and International Partner locations, 
please call our Technical Support automated fax retrieval service, in the 
United States at +1 (541) 984-2490, choose Option 2, and request 
document 1400.

Every effort has been made to ensure the accuracy of this information. 
However, the information contained herein is subject to change without 
notice. Symantec Corporation reserves the right for such change without 
prior notice. 
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Returning a Drive
All other countries except USA. If your Hewlett-Packard product requires repair 
or replacement, call the HPCustomer Support at the phone number listed in 
”Appendix B:  Customer Support” to receive instructions.

In the USA. If your Hewlett-Packard product requires repair or replacement, 
follow these instructions:

Call the number listed in Appendix B: Customer Support, B-5. Make sure you are 
at your system and have your drive installed when you call. Customer Support 
will help you determine if your drive is defective. Provide the product type, serial 
number, and date of purchase. You will be given a return authorization number. 
Keep the return authorization (RA) number for future reference.

Securely repackage the product to prevent shipping damage (use the original 
packaging, if possible) and mark the return authorization number on the box.

All product returns must have an accompanying return authorization number. To 
ensure timely and accurate processing of your return, the number must be clearly 
printed on the outside of the box.

Use the appropriate address for your location. A traceable shipping method is 
recommended. The postage, shipping, and insurance charges incurred in shipping 
to Hewlett-Packard will be paid by Purchaser and all risk for the product shall 
remain with Purchaser until such time as Hewlett-Packard takes receipt of the 
product.

Once your product is received at Hewlett-Packard, we will ship the replacement 
product. Hewlett-Packard will pay shipping charges to the Purchaser for 
replacement product covered under warranty.

If the product is still under warranty, there is no charge for the replacement. If the 
product is not covered under warranty, an exchange cost will be quoted when the 
return authorization number is issued.



Index-1

Index

A

access time 3-4, A-2, A-3, A-4
accessing online Help 10-2
Acer brand computer 3-7
adding graphics to inserts 7-6
adjusting a photo 10-11
Adobe Acrobat file 10-9
Adobe Acrobat Reader 10-9
Adobe Systems Web site 10-2
Advanced button 10-15
alerts

Windows 95 14-9
Allow Multiple Document Windows com-

mand 10-15
annotating

documents 13-3
application software

installing 1-8–1-12
uninstalling 1-12–1-13

applications
improper operation after repair 14-18

arranging track titles 7-6
assigning drive letter 3-5–3-6
audio cable

connecting 1-7
disconnecting 1-14

Audio CD Layout window 6-3
audio CDs

track-at-once mode 8-1
audio connector 1-7
audio distortion 3-3–3-4, A-4
audio tracks 6-2

combined with wave files 6-7
pre-recording to wave files 6-5
recording 6-3

automatic protection of files 9-4

Auto-Protect feature
disabling temporarily

Windows 95 14-4, 14-12
enabling

Windows 95 14-12, 14-17
failure to load on startup

Windows 95 14-17
Auto-Protect icon

Windows 95 14-3
AutoSearch 13-2

B

backup copies
infected 14-10, 14-11, 14-18
replacing deleted infected files 14-11

bi-directional parallel port 3-4, A-2
black-and-white, converting to 10-9
boot records

bypassing scans of 14-8
unable to repair

Windows 95 14-12
booting

Auto-Protect failure to load after 14-17
from Emergency Boot Disk

irreparable master boot record 14-12
buffer size A-4
buffer underrun 3-4–3-5
bypassing boot record scans 14-8

C

cabinets
closing 13-10
creating 13-6

cables
audio 1-7, 1-14
data 1-6, 1-14
power 1-2
printer 1-5, 1-15

canceling an action 10-12
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capacity, CD A-4
CD Copier

changing temp directory location 8-4
disc copy option 8-4
Online Help 8-4
selecting destination drive 8-3
selecting source drive 8-3
starting 8-2
test options 8-3
types of CDs that can be copied 8-1

CD layout
about 6-3
changing song order 6-7
modifying 6-7
opening 6-8
removing songs 6-7
renaming songs 6-8
saving 6-8

CD-DA 6-1
CD-ROM

cleaning discs 2-4
CD-ROM drive

changing drive letter 3-5–3-6
identifying B-4
identifying drive letter 2-4
problem reading CDs 3-5
SCSI 2 3-3

CD-ROM drives
recording audio 6-4

CD-ROM XA 8-2
CDs

cannot find CD 3-5–3-6
capacity A-4
cleaning discs 2-4
copy prevention feature 3-3
inserting 2-1–2-2
maintenance 2-4
multi-session 3-5
music 1-7
power loss while writing 3-6
problems inserting 2-2
purchasing 2-3
reading problem 3-5
removing 2-2
rewritable 2-2, 2-3, A-3
selecting 2-2–2-3

supported by CD-Writer drive A-3
write-once 2-3, 3-5, A-3

CD-Writer drive
audio cable 1-7, 1-14
changing drive letter 3-5–3-6
compatibility problems 3-7
connecting 1-1–1-15
connecting to another computer 1-13, 1-

15
Customer Support B-2
data cable 1-6, 1-14
dimensions A-4
disconnecting 1-13–1-15
driver files 3-8
installing application software 1-8–1-12
model number B-3
not recognized 3-5–3-6
optimizing performance 3-6–3-7, A-3
package contents 1-1
performance A-2–A-3, A-4
performance enhancement 3-4
power supply 1-2
power switch 1-3, 1-14
printer cable 1-15
returning 21
selecting CDs 2-2–2-3
serial number B-3
sharing parallel port with printer 1-4–1-5,

3-3
supported discs A-3
system requirements A-1
using earphones or speakers 3-3

changed files, protection of 9-13
changing song order 6-7
changing text attributes 7-6
cleaning CD-Writer drive 2-4
Clip art 10-6
closing

cabinets 13-10
closing tray 2-1
Clue cards 10-3, 10-11
collage.  See layers 10-15
compatibility A-1
compatibility problems 3-7
compatible parallel port 3-4, A-2
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compressed files
file extension 14-11
repairing

Windows 95 14-12
scanning downloaded

Windows 95 14-2
compression software 3-6
computer

identifying model B-3
processor speed A-1, A-2
system requirements A-1

connecting
audio cable 1-7
CD-Writer drive 1-1–1-15
CD-Writer drive to another computer 1-

13, 1-15
data cable 1-6
power cord 1-2

connector
audio 1-7
parallel port 1-4, 1-6
printer port 1-4

contacting Customer Support B-2
contents, package 1-1
Continue action button

Windows 95 14-10
control panel for HP Simple Trax 9-11
copy prevention feature 3-3
copying

audio CDs 8-1
CD Extra discs 8-2
DirectCD discs 8-2
drawers 13-6
mixed-mode CDs 8-2
photo CDs 8-2
video CDs 8-2

copying CDs
making mulitple copies 8-3
steps 8-3

copying from CD to CD 3-3
copyright notice 6-2, 8-1
Corel Family & Friends 11-10
Corel Photo House 2 11-7
Corel Print House 3 11-3
Corel Print House Magic 11-1
correcting

mistakes 10-12
creating

annotations 13-3
cabinets 13-6
drawers 13-7, 13-8
folders 13-7, 13-8
Sticky Note annotations 13-4

creating a protection list 9-3
creating audio CDs 6-4
cropping

documents 13-3
CTRL-ALT-DEL 3-6
Customer Service B-19
Customer Support, contacting B-2
customizing

Norton AntiVirus
Windows 95 14-7

customizing jewel case inserts 7-2
cycling power 1-8, 1-10, 3-1

D

data cable
connecting 1-6
disconnecting 1-14

defining text attributes 7-5
Delete action button

Windows 95 14-10
deleting infected files

procedure
Windows 95 14-11

when and why
Windows 95 14-10

desktop publishing, preparing photo for 10-9
Device Manager 1-10, 3-5, A-1, B-3, B-4
digital audio extraction 6-4
dimensions A-4
Direct CD 3-5
DirectCD 5-2

Online Help 5-4
starting 5-2
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DirectCD discs
about formatting CD-RW disc 5-2
adding data 5-3
ejecting 5-3
formatting 5-2

disabling
virus protection

Windows 95 14-4, 14-12
disc labels

printing 7-8
disconnecting

audio cable 1-14
CD-Writer drive 1-13–1-15
data cable 1-14
printer cable 1-15

displaying
grids 7-4
track numbers 7-7
track times 7-7

distortion
audio 3-3–3-4
video 3-4

documents
annotating 13-3
cropping 13-3
faxing 13-5
filing 13-9
naming 13-9
printing 13-6
scanning 13-9
viewing 13-3

drawers
copying into cabinets 13-6
creating 13-7
customizing 13-7

drive letter
changing 3-5–3-6
identifying 2-4

drivers
finding 3-8

drives, scanning
Windows 95 14-6

E

earphones 3-3
Easy-CD Audio

Online Help 6-9
starting 6-1
wizard 6-2

EasyPhoto Organizer.  See photo organizer
effects.  see Effects in online Help
eject button 2-1, 2-2
ejecting DirectCD discs 5-3
email 3-4
Emergency Boot Disk

booting from
irreparable master boot record 14-12

failure to boot from 14-18
enabling virus protection

Windows 95 14-12, 14-17
environmental specifications A-5
EPS file format 10-9
erasing files on CDs 5-4
error logs tab in HP Simple Trax 9-14
error message

buffer underrun 3-4–3-5
cannot find CD 3-5–3-6
CD not recognized 1-11
unable to read 3-5

error rate A-4
Exclude action button

Windows 95 14-10
exploring advanced features 10-14, 10-15
Export button 10-9
exporting a photo.See also Sending a photo

10-9

F

FAQs B-18
fax modem 3-4
faxing 13-5
file extensions

infected files 14-11
file formats

sending to 10-9
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files
automatic protection 9-4
changed, protection of 9-13
filters 9-10
protected versions of 9-8
protection history 9-8
protection of 9-2
retrieving 9-6
scanning individual

Windows 95 14-6
filing

documents 13-9
Find Device Automatically option

Windows 95 14-15
finding in HP Simple Trax 9-9
firmware version B-3
fitting tracks on a page 7-7
fixing a photo 10-11
floppy disks

scanning
Windows 95 14-6

unable to repair boot record
Windows 95 14-13

virus definitions update disk B-17
folders

creating 13-7
customizing 13-7
scanning individual

Windows 95 14-6
formatting DirectCD discs 5-2
FTP site B-18

G

galleries 10-6
Get Photo button 10-5
GIF file format 10-9
guided activities 10-3

H

hard drive
access time 3-4, A-2, A-3, A-4
compression software 3-6
Maxtor brand 3-7
speed A-2
storage requirements A-1
transfer rate A-1, A-2

Help
CD Copier 8-4
DirectCD 5-4
Easy-CD Audio 6-9
jewel case inserts 7-8

help. See online Help
high-pressure air 2-4
history of protection for a file 9-8
HP Simple Trax

control panel 9-11
error logs tab 9-14
protecting files 9-2
protection list 9-3
retrieving protected files 9-6
schedule setup tab 9-13
scheduling a protection session 9-4
selection tab 9-12

HP VersaWriter CD drive
identifying drive letter 2-4
uninstalling 1-12–1-13

humidity specifications A-5

I

I/O channel setting 3-7, A-1
IBM Aptiva brand computer 3-7
indexed color 10-9
infected files

types of file extensions 14-11
unable to repair

Windows 95 14-11–14-13
Inoculate action button

Windows 95 14-10
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inoculation changes, expected vs. unexpect-
ed

Windows 95 14-10
inserting a CD 2-1–2-2
inserting objects 7-6
installing

Norton AntiVirus for Windows 95
system requirements 14-3

software programs, disabling Auto-Pro-
tect 14-4

updated virus definitions
Windows 95 14-16

installing application software 1-8–1-12
installing parallel driver files 3-8
Intelligent Updater

Windows 95 14-16
Internet

obtaining LiveUpdates
Windows 95 14-14

Symantec World Wide Web site B-17–B-
18

intro tabs 10-3
IRQ setting A-1, A-3

J

jewel case inserts
adding graphics 7-6
editing 7-2
editing text 7-6
graphics

OLE objects 7-6
making 7-2
Online Help 7-8
positioning 7-4
printing 7-8
rulers and grids, using 7-3
viewing 7-2
zooming 7-3

jewel case layout 7-2
Page menu 7-3

JPEG file format 10-8

L

learning PhotoDeluxe 10-2
listening to music CDs 1-7
LiveUpdate button B-18
LiveUpdates

obtaining
when unable to repair files 14-11

Windows 95 procedure 14-14–14-16
scheduling

Windows 95 14-15
updating virus protection without

Windows 95 14-16
Long Menus command 10-15

M

magnifying 10-4
mailed virus protection updates

Windows 95 14-16
maintenance 2-4
making a disc copy 8-4
making multiple copies 8-3
master boot record

Windows 95 14-12
Maxtor brand hard drive 3-7
measuring inserts and objects 7-3
memory A-1, A-2, B-3

needed for a photo 10-3
mistakes 10-12
model number, locating B-3
modem, obtaining LiveUpdates

Windows 95 14-14
modifying CD layouts 6-7
More Touch Up tab 10-11
moving CD-Writer drive to another computer

1-15
MSCDEX version 3-5
multi-session CD 3-5
music CDs 1-7

playing 6-8
My Photos gallery 10-6

storing a photo in 10-6
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N

naming documents 13-9
networks 3-4
Norton AntiVirus for Windows 95

automatic features 14-2
customizing 14-7
installing

system requirements 14-3
starting 14-4

Norton AntiVirus window
Windows 95 14-4

O

Object-order menu button 10-4
OLE objects 7-6
online Help 10-2

button locations 10-3
online help, Norton AntiVirus

Windows 95 14-5
opening CD layouts 6-8
opening Norton AntiVirus window

Windows 95 14-4
opening tray 2-1
operating system

compatible A-1
identifying version B-3

operating systems
multiple installed

Windows 95 14-19

P

package contents 1-1
Page menu 7-3
Page Setup 10-10
parallel port A-5, B-4

compatible 3-4, A-2
configuration 1-10, A-1

conflicting device 1-10–1-11, 1-11, 1-12,
A-3

connector 1-4, 1-6
ECP 1-10, 3-5, A-2
EPP 1-10, 3-5, A-2
minimum requirements A-1
sharing 1-4–1-5, 3-3
SPP 3-4, A-2

PDF file format. See Adobe Acrobat file
performance A-2–A-3, A-4

optimizing 3-6–3-7, A-3
photo organizer 10-4, 10-7
photo window

opening more than one 10-15
playing music CDs 6-8
positioning objects 7-4
power cord

connecting 1-2
power loss while writing 3-6
power management feature 3-2, 3-4
power requirements A-5
power supply 1-2

light 1-2, 1-12
power switch 1-3, 1-14
power-saving mode 1-3, 1-14
problems 1-12
unplugging 1-14

power switch 1-3, 1-14
power-saving mode 1-3, 1-14
preparing a photo.  see sending a photo
Print Preview 10-10
printer

compatibility problems 3-8
monitor software 3-7
problems 1-11
sharing parallel port with CD-Writer

drive 1-4–1-5, 3-3
printer cable

connecting 1-5
disconnecting 1-15

printer monitor software 3-7
printer port connector 1-4
printer status monitor software 3-5, 3-7, 3-8
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printing 1-5, 10-10–10-11
disc labels 7-8
jewel case inserts 7-8
problems 1-11
while playing audio CDs 3-3

printing documents 13-6
problems

solving 10-2
Problems Found dialog

Windows 95 14-9
processor speed A-1, A-2
product certification vi
product knowledgebases B-17
programs

uninstalling 1-12–1-13
protecting

automatically 9-4
changed files 9-13
definition of 9-1
files 9-2
schedule for 9-4

protection list, adding files to 9-3
protection, file’s history of 9-8
purchasing CDs 2-3

R

RAM. See memory
reading error 3-5
reading from CD

speed A-2, A-4
recording

CD to CD 3-3
power loss during 3-6
while running other applications 3-4

recording audio tracks 6-3
recording wave files 6-4
reducing. See also magnifying, resizing 10-4
refreshing the screen 1-11, 3-5
removing a CD 2-2
removing songs from CD layout 6-7
removing viruses

deleting infected files
Windows 95 14-11

renaming songs in CD layout 6-8
Repair action button

Windows 95 14-10
Repair Wizard

Windows 95 14-9
repairing infected files

compressed
Windows 95 14-12

Repair action button
Windows 95 14-10

unsuccessful
Windows 95 14-11–14-13

Windows NT 14-18
Rescue Disks

creating
Windows 95 14-7

resizing
text 10-14

retrieving
options 9-7
protected files 9-6

returning a CD-Writer drive 21
reverting 10-12
rewritable CDs 2-2, 2-3, 3-5, A-3
ruler option 7-4

S

Sample Photos gallery 10-6
saving a photo 10-7–10-8
saving CD layout 6-8
scanning

drives
Windows 95 14-6

individual items
Windows 95 14-6

scanning documents 13-9
scans

scheduling
Windows 95 14-6–14-7
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scheduling
LiveUpdates

Windows 95 14-15
protection session 9-4
scans

Windows 95 14-6–14-7
setup tab in HP Simple Trax 9-13

searching in HP Simple Trax 9-9
selection tab in HP Simple Trax 9-12
Send button 10-8–10-9
sending a photo 10-8
serial number B-3
service solutions B-17–B-20
sharing parallel port 1-4–1-5, 3-3
Simple Trax. See HP Simple Trax
size 10-10
snapping objects to grid 7-4
software

disabling virus protection when install-
ing

Windows 95 14-4
installing 1-8–1-12
uninstalling 1-12–1-13

software compression 3-6
Software Installation CD

driver files 3-8
songs

removing from CD layout 6-7
renaming 6-8

sound board 1-7, 3-3, B-4
sound system 1-7
sound-muting feature 3-3
speakers 3-3
special effects.  see Effects in online Help
speed

reading from CD A-2, A-4
writing to CD 3-5, A-2, A-4

Start menu, accessing Norton AntiVirus
Windows 95 14-4

starting
Norton AntiVirus

Windows 95 14-4
starting PhotoDeluxe 10-1
status bar 10-3
step-by-step tabs 10-3

Sticky Note annotations 13-4
Stop action button

Windows 95 14-10
Support Genie B-17
support solutions B-17–B-20
switch box 1-10, 1-13, 3-2
Symantec World Wide Web site B-17–B-18
system files

unable to repair
Windows 95 14-13

system requirements A-1

T

technical documents 10-2
technical support B-17
temp directory

changing location 8-4
temperature specifications A-5
test options

CD Copier 8-3
text 10-14
text attributes

changing 7-6
defining 7-5

TIFF file format 10-8, 10-9
Touch Up tab 10-11
touching up a photo 10-11
tour movie 10-2
track column lists 7-7
track titles

arranging 7-6
track-at-once mode 8-1
tracks

combining with wave files 6-2
transfer rate A-1, A-2, A-4
Trash Can button 10-4
tray, opening and closing 2-1
troubleshooting 10-2

audio distortion 3-3–3-4
cable connections 1-8, 1-9–1-10, 3-1–3-2
compatibility problems 3-7
copying from CD to CD 3-3
Customer Support B-2
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hardware connections 1-8, 1-9–1-10, 3-1–
3-2

inserting CDs 2-2
IRQ conflict A-3
not recognizing CD-Writer drive 1-12
parallel port configuration 1-10–1-11, 1-

11, 1-12, A-3
power supply 1-12
printing 1-11, 3-8
reading error 3-5
returning your CD-Writer drive 21
video distortion 3-4
Windows NT 14-17
writing to CD 3-4

tutorial 13-11
Type Text tool 13-4
type. See text
types of CDs that can be copied 8-1
typing text 13-4

U

uncompressing files for repair
Windows 95 14-12

Undo button 10-4, 10-12
uninstalling 1-12–1-13
updating

virus protection
Windows 95 14-2–14-3

without LiveUpdate 14-16
using the photo organizer 10-6

V

vibration specifications A-5
video card 3-4
video distortion 3-4
viewing documents 13-3
viewing jewel case inserts 7-2
viewing protected versions 9-8
virus alerts

Windows 95 14-9
Windows NT 14-9

virus definitions
installing latest 14-16

virus definitions update disk B-17
virus protection

disabling
Windows 95 14-4, 14-12

enabling
Windows 95 14-12, 14-17

keeping current
Windows 95 14-14

Norton AntiVirus features
Windows 95 14-2

updating
without LiveUpdate 14-16

user responsibilities
Windows 95 14-2–14-3

viruses
constant release of new 14-2–14-3

volume control 3-3

W

wave files 3-4, 6-2
combining with audio tracks 6-2
pre-recording from audio tracks 6-5
recording 6-4
specifications 6-4

web site, Symantec B-17–B-18
Windows 95

irreparable system files 14-13
windows explorer 6-3
wizard 5-2

DirectCD 5-2
making music CDs 6-2

World Wide Web
Adobe Systems Web site 10-2

Worldwide Service and Support B-19–B-20
write-once CDs 2-3, 3-4, 3-5, A-3
writing to CD 3-3, 3-4

power loss 3-6
speed 3-5, A-2, A-4



Index-11

Z

Zoom In button 10-4
Zoom menu 10-4
Zoom Out button 10-4
Zoom tool 10-4
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